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CERTIFICATION

Hewlett-Packard Company certifies that this product met its published specifications at the time of
shipment [from the factory. Hewletti-Packard further certifies that its calibration measurements are
traceable to the United States Bureair of Standards, to the extent allowed by the Bureau's calibration
facility, and to the calibration facilities of the other International Standard’s Organization members.

WARRANTY

This Hewlett-Packard system product is warranted against defects in material and workmanship for
a period of 90 days from the date of installation. During the warranty period, HP will, at its
option, either repair or replace products which prove to be defective.

Warranty services of this product will be performed at Buyer’s facility at no charge within HP
service travel areas. QOutside HP service travel areas, HP service will be performed at Buyer’s
facility only upon HP’s prior agreement and Buyer shall pay HP’s round trip travel expenses. In all
other cases, products must be returned to a service facility designated by HP.

For products returned to HP for warranty service, Buyer shall prepay shipping charges to HP and
HP shall pay shipping charges to return the product to buyer. Buyer shall pay all shipping charges,
duties, and taxes for products returned to HP from another country.

HP warrants that its software and firmware designated by HP for use with an instrument will
execute its programming instructions when properly installed on that instrument. HP does not
warrant that the operation of the instrument, or software, or firmware will be uninterrupted and
error free.

LIMITATION OF WARRANTY

The foregoing warranty shall not apply to defects resulting from improper or inadequate
maintenance by Buyer, Buyer supplied software or interfacing, unauthorized modifications or
misuse, operation outside of the environmental specifications for the products, or improper site
preparation or maintenance.

NO OTHER WARRANTY IS EXPRESSED OR IMPLIED. HP SPECIFICALLY DISCLAIMS THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE.

EXCLUSIVE REMEDIES
THE REMEDIES PROVIDED HEREIN ARE BUYERS SOLE AND EXCLUSIVE REMEDIES, HP
SHALL NOT BE LIABLE FOR ANY DIRECT, INDIRECT, SPECIAL, INCIDENTAL, OR

CONSEQUENTIAL DAMAGES, WHETHER BASED ON CONTRACT, TORT, OR ANY OTHER
LEGAL THEORY.

ASSISTANCE

Product maintenance agreements and other customer assistance agreements are  available  for
Hewleti-Packard products.

IFor any assistance, contact your nearest Hewlett-Packard Sales and Service Office, addresses are
provided at the back of this manual.
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PREFACE
PURPOSE OF THIS MANUAL
The purpose of this manual is to provide the necessary information to troubleshoot and repair faults on

the HP 8180A/B Data Generator, HP 8181 A/B Data Generator Extender and HP 8182A/B Data
Analyzer, which are part of the HP 81810S IC Design Verification System.

AUDIENCE

This manual is aimed at Service Personnel involved in the repair of the above mentioned instruments.

HOW TO USE THIS MANUAL

This manual should be used as a guide when troubleshooting the individual instruments. Section 1 gives
information on how to begin the fault-finding process.

RELATED PUBLICATIONS

This section contains a list of all publications related to installation, operation and maintenance of the
HP 81810S IC Design Verification System. The publications can be ordered by quoting the relevant part
number.

Title Part Number

HP 8180 Data Generator
HP 8181 Data Generator Extender
HP 8182 Data Analyzer

Operating and Programming Manual 08180-90066
HP 15466A 256 Pin Testhead

Operating and Programming Manual 15466-90001
HP 81804A CAE Link Software

Users Manual 81804-90001
HP 81810A System Software Users Manual 81810-90001
System Configuration Manual 81810-90010
System Service Information 81810-90012

HP 8180 Data Generator

HP 8181 Data Generator Extender

HP 8182 Data Analyzer

Service Information (this manual) 08180-90067

iii
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Introduction

Chapter 1
General Information

1-1 Introduction

This chapter contains information on safe working practices, recommended test equipment and using the
test procedures described in the following chapters.

1-2 Safe Working Practices

The Models 8180A/B, 8181A/B and 8182A/B are Safety Class 1 instruments (instruments with an
exposed metal chassis that is directly connected to earth via the power supply cable).

Before operation, the instruments and manual, including the red safety page, should be reviewed for
safety markings and instructions. These must then be followed to ensure safe operation and to maintain
the instruments in a safe condition.

The HP 8180A/B, HP 8181A/B and HP 8182A/B contain
assemblies and components that are sensitive to electrostatic
discharge. Ensure that your working area conforms to Corporate
Standard 741.080.

Carefully observe precautions and recommended procedures
outlined below to avoid compromising the instrument’s reliability
because of component damage from static electricity.

° Treat all assemblies, components and connections as static sensitive.

® When unpacking new boards, keep them in their conductive plastic bags until you are ready
to install them.

@ Before removing the top cover from the instrument, select a work area where potential static
sources are minimized. If possible, use a controlled-static workstation (HP 9300-0933 or
equivalent) that includes personnel grounding provisions.

Y Avoid touching any metal parts on the boards. When you are ready to install an upgrade
board, remove it from its protective bag and lay it on top of the bag while keeping your free
hand in contact with the bag.

1-3 Recommended Equipment
Test Equipment

The test equipment required for the adjustment and performance verification procedures is listed below.
Critical specifications of substituted test instrument must meet or exceed the standards given with the
equipment list.

Revision 1.0, Dec. 1987 1-1



Instrument

Introduction

Critical Specification

Oscilloscope HP54100D Resolution 100ps/DIV
Time base acc. <=100 ps
Probe HP54001A Bandwidth >=700MHz
Transition time <450 ps
Probe HP54002A 50 Ohm
Transition time <=350 ps
Counter HP5370B Frequency range >50 MHz
DVM HP3456A Range 10V
Resolution 100 uv
Signature Analyzer HP5005A f max >20 MHz

Pulse Generator:

A pulse generator capable of meeting all requirements is not available.
The critical specifications are given in each test/adjustment procedure.
You need to select a pulse generator from the HP range that fits the

particular application.

Power Supply: HP6002A Voltage range >20V
Resolution I mV
Data Generator: HP80I18A Vector depth 1kBit
Bit rate >50 MHz
Accessories
Cables
Strobe/Clock 15422A
DATA Cable 15423A
Clock Probe 15406A
DATA Cable 15407A
Interface Cable 08181-61604
Interface Cable 08181-61603
Adapters
Grabbers 15408A
BNC Adaptor 15409A
Miniprobe Adaptor 15415A
Solder in receptacles 15426 A
Connectors
50 OHM Feedthrough 10100C
BNC Attenuator 20dB/20W Texscan HFP 50/20
BNC TEE Connector 1250-0781
BNC female/female 1250-0080
Scope Probe Adapter 1250-1454
BNC/Dual Banana 1251-2277

1-2
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Using the Test Procedures

Delay Lines

90.5 ns (A-version) 08180-61636
90.5 ns (B-version) 08180-61696
34 ns 08182-61622
3 ns 08182-61621

Extender Boards

BD AY Extender 08180-66557
BD AY Extender 08180-66556
BD AY Extender 08180-66555
BD AY Extender 08180-66554 /
BD AY Extender 08180-66553
BD AY Extender 08180-66552
BD AY Extender 08180-66551
BD AY Extender 08180-66550
Adjustment Cover 08180-04103

1-4 Using the Test Procedures

General

1.

Before adjusting an 8180A/B, 8181A/B or 8182A/B allow the instrument to warm up for 30
minutes.

Power supply adjustments must be done with all boards inserted.

The adjustment procedures can be used for the A- as well as the B-version. Any differences in the
adjustment procedures for the two versions are notified in text.

Timing adjustments must be performed with the adjustment cover in place. For the A-version all
adjustment holes in the adjustment cover must be blocked with adhesive tape. During adjustment,
the tape should only be removed for a few seconds. Each adjustment hole should be closed
immediately after the adjustment has been performed.

If a B instrument needs to be adjusted, the adjustment cover should be prepared as follows: block
the circular hole with adhesive tape, block the two holes which are located above the A8 board
with adhesive tape.

If only a sub procedure is to be performed, always carry out the whole adjustment procedure
starting with step 1.

Trigger delay of the channel used as reference, as well as interchannel delay of the 54100D scope
must be calibrated before timing measurements can be performed.

Revision 1.0, Dec. 1987 1-3
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Chapter 2

Exploded Diagrams, Parts Lists

2-1 Introduction

This chapter gives the exploded diagrams and associated parts lists, and exchange boards lists for the HP
8180B generator, the HP 8181B extender and the HP 8182B analyzer.

Parts Lists

documented in the service part of the existing Operating and Service Manual.

2-2 Parts Lists for the HP 8180B

Module Parts List

Reference HP Part

Designator Number

FRAME
A6l 08180-66561
AG2 08180-66562
A63 08180-66563
A64 08180-66564
A65 08180-66565
AG6 08180-66560
A68 08180-66568
A72 08180-66572
A76 08180-66576
AG661 08180-62661
A672 08180-62672
A663 08180-62663
Bl 3160-0510
B2 3160-0510
FIA 2110-0051
FIE 2110-0010
FLI ) 9135-0192
MPO 1250-0083
MPI 08180-00262
MP4 08180-01205
MP5 08180-00204
MP6 08180-04111
MP7 08180-04102
MP8 08180-01202
MP9 01830-23201
MPI0 0403-0374
MPI11 5040-1148
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Description

BD AY U-PRCP

BD AY INTERF

BD AY ADDRESS
BD AY SYNC

BD AY TIMING

BD AY MODULE
BD AY ADDR. CTRL. II
BD AY MOTHER
BD AY TEMP CTRL
MDL AY PWR SPLY
MDL AY DISP

PNL AY REAR

DC MOTOR FAN
DC MOTOR FAN

FUSE 10A 15V
FUSE 5A 250V

FILTER LINE

CONN BNC BLKHD
PANEL REAR
BRACKET FAN
PANEL REAR PS
COVER TOP PS
PANEL SIDE PS
BRACKET PERF.

COUPLER SW 10-24
BUMPER FOOT
SHAFT SHORT/GRAY

[}
'

The A-versions are fully



Reference
Designator

MP12
MP13

MP14
MP15
MP16
MPL7
MP18
MP19

MP20
MP21
MP22

MP23
MP25
MP26
MP28

MP30
MP31
MP32
MP33
MP34
MP134
MP35

MP36
MP37
MP338
MP39
MP40

MP41
MP42
MP43
MP44
MP45
MP47
- MP48

MP50
MP52
MP53
MP54
MP135
MP136

Vi

HP Part
Number

5040-1149
08180-04101

08180-01200
08180-04110
08180-64701
08180-01203
5021-0508

08180-00201

4040-2097
1400-0678
08180-04115

08180-04155
5041-6820
5060-9804
5041-6819

5021-0519
1460-1345
5040-7201
5061-9447
08160-04101
5060-9884
5001-8233

08180-05001
08180-02301
08180-00102
5021-5837
5021-5806

5040-7221
5040-9319
5040-9320
08160-0438
0363-0125
5040-7202
5001-0440

9140-0726
08180-03101
2140-0352
08180-47401
1251-0218
08180-01282

2090-0706

Parts Lists

Description

SHAFT LONG/GRAY
PANEL SIDE PS

BRKT PS

COVER TOP CRT MOD
MODULE CRT

CLAMP CRT

PANEL FRONT
PANEL KEYBD

FACEPLATE SAFETY
CLAMP
PLATE SAFETY

COVER TOP

CAP, HANDLE REAR
STRAP HDL I8IN

CAP, HANDLE FRONT

FRM FRNT 7SPCL
TILT STAND

FOOT

COVER BOTTOM
COVER SIDE PERF.
COVER SIDE

SIDE GUSSET

CATCH

HOLDER DISTANCE
CAGE CARD
CORNER STRUT
FRAME REAR 7IN

FOOT REAR

SHAFT PWR SWITCH
STOP PWR SWITCH
RFI STRIP FINGER
CONTACT FINGER
TRIM STRIP TOP
TRIM STRIP SIDE

WIRE AY YOKE
GUIDE POWER SHAFT
LAMP INDC TI 18V
KEY CUP

POST CON

STRAP TOP

CRT
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Reference
Designator

W7
w38/9
W10
W1l
Wi2
W16
W17
W18
W20
W21
W30

Revision 1.0, Dec. 1987

HP Part
Number

08180-61681
08180-61609
08180-61670
08180-61616
08180-61688
08180-61661
08180-61662
5180-2418

08180-61607
08180-61639
5180-2413

Parts Lists

Description

CBL AY SHLD STROBE
CBL AY PAIR

CBL AY MASTER
CBL AY REAR #2
CBL AY SHLD SET
CBL AY RBN TW 8P
CBL AY RBN TW 7P
CBL AY RBW 230 MM
CBL AY VIDEO

CBL AY CRT

CBL RBN 230 MM



MP3¢4
(1x.)

2-4

Parts Lists

Figure 2-1. 8180B Chassis Parts
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Power Supply Parts List 8180B

Reference
Designator

A661

A24
A26
A28
A8l
A82
A83
A85
A87

F101

J1
J2
J3
J5
(¢
J7
J8
S1
Tl

F201
F202
F203
F204
F205
F206
F207
F208
F209
F210
F211
F212
F213
F214
F215

MPI
MP2
MP1
MP1
MPI
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HP Part
Number

08180-62661

08180-66524
08180-66526
08180-66528
08180-66581
08180-66582
08180-606583
08180-66585
08180-66587

2112-0002

1251-0472
1251-2035
1251-2035
1251-2034
1251-2034
1251-2034
1251-2034

3101-2624
08180-61105

2110-0456
2110-0456
2110-0653
2110-0653
2110-0653
2110-0653
2110-0456
2110-0456
2110-0456
2110-0456
2110-0456
2110-0456
2110-0456
2110-0456
2110-0456

4040-0750
4040-0748
4040-0751
4040-0753
4040-0755

Parts Lists

Description

MDL PWR SUPPLY

BD AY FILTER

BD AY REG +15, -7V
BD AY CAPACITOR
BD AY MOTHER
BD AY RECTIFIER
BD AY SWITCHING
BD AY +5V -5V

BD AY +23V

FUSE 2A 250V NT

CONN PC
CONN PC
CONN PC
CONN PC
CONN PC
CONN PC
CONN PC

SWITCH PWR
XFMR AY

FUSE 10A 125V
FUSE 10A 125V
FUSE MINI [5A
FUSE MINI 15A
FUSE MINI I5A
FUSE MINI 15A
FUSE 10A
FUSE 10A
FUSE 10A
FUSE 10A
FUSE 10A
FUSE 10A
FUSE 10A
FUSE 10A
FUSE 10A

BD EXTR RED
BD EXTR POLY
BD EXTR ORN
BD EXTR GRN
BD EXTR VIO

BD NO.

A8l
A8l
A8l
A8l
A8l
A8l
A8l

"A81

A8l

A82
A82
A82
A82
A82
A82
A82
A82
A82
A82
A82
A82
A82
A82
A82

A82
AS82
A83
A85
A87

2-5



Parts Lists

Figure 2-2. A661 Power Supply Module
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Reference
Designator

AlS5
A30
A32
AA34

MPI15
MP16
MP17
MP18
MP19
MP20
MP21
MP30
MP47
MP48

MP50
MP53

V1

W21

HP Part
Number

08180-66515
08180-66530
08180-66532
08180-66534

08180-04110
08180-64701
08180-01203
5021-0508
08180-00201
4040-2097
1400-0678
5021-0519
5040-7202
5001-0440

9140-0726
2140-0352

2090-0706
08180-61639

Keyboard Assembly Parts List

Al5

MP70
MP71
MP72
MP73
MP74
MP75
MP76
MP77
MP78
MP79
MP80
MP81
MP82
MP83
MP84
MP85

Revision 1.0, Dec. 1987

08180-66515

5041-0846
5041-0847
5041-0848
5041-0849
5041-0850
5041-0851
5041-0852
5041-0853
5041-0854
5041-0855
5041-2756
5041-2757
5041-2758
5041-2759
5041-2760

" 5041-2761

Parts Lists
Display Module Assembly Parts List 8180B

Description

BD AY KEY

BD AY CNTL

BD AY DFL VRT
BD AY DFL HORZ

COVER TOP CRT
MODULE CRT
CLAMP CRT
PANEL FRONT
PANEL KEYBD
FACEPLATE SAFET
CLAMP

FRM FRNT

TRIM STRIP TOP
TRIM STRIP SIDE

DEFLECTION YOKE
LAMP INCD TH8VY

CRT

CBL AY CRT

BD AY KEY

KNOB NOM 0
KNOB NOM 1
KNOB NOM 2
KNOB NOM 3
KNOB NOM 4
KNOB NOM 5
KNOB NOM 6
KNOB NOM 7
KNOB NOM 38
KNOB NOM 9
KNOB A
KNOB B
KNOB C
KNOB D
KNOB E
KNOB F

BD NO.



MP86
MP87
MP88
MP89
MP90
MPI1
MP92
MP93
S1/34
w2l

© 5041-2763

5041-0841
5041-0409
5041-2765
5041-2755
5041-2766
5041-2767
5041-2764
5000-9436
5180-2421

Parts Lists

KNOB +/-

KEY CUP

KNOB NOM BLK
KNOB RUN
KNOB STOP
KNOB BREAK
KNOB BACK
KNOB FWD

SW P-BTN SINGLE
CBL RBN

Revision 1.0, Dec. 1987
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Parts Lists

.Figure 2-3. A672 Display Module
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Rear Panel Assembly Parts List 8180B

2-10

Reference
Designator

A663
A40

Bl

MPO
MP1
MP4

Wil
W20
Ww8/9

HP Part
Number

08180-620663
08180-606540

3160-0510

1250-0083
08180-00262
08180-01205

08180-61616
08180-61607
08180-61609

Parts Lists

Description BD NO.

PNL AY REAR
BD AY HP-IB

FAN - DC

CONN BNC BLKHD
PANEL REAR
BRACKET FAN

CBL AY REAR #2
CBL AY VIDEO
CBL AY PAIR

Revision 1.0, Dec. 1987
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Parts Lists

Figure 2-4. Rear Panel Assembly




2-12

Parts Lists

This is a replaceable parts list on a sub-assembly level.

Reference
Designator

A6l

BT100
MP1
MP2

A62
BT1
J3
J3A
MP3
MP2
A63

DL110
DLI111

J3/4

MPI
MP2

A64

DL101
DL103
DL104
DL201

J4/38

MP1
MP2

A65

DL107
DL207
DL307
DL407
MPI1
MP2

!

HP Part
Number

08182-66561

1420-0251
4040-0749
4040-0748

08182-66562
1420-0251
1251-4267
1250-1737
4040-0750
4040-0748
08182-66563

1810-0616
1810-0616

1250-1737

4040-0751
4040-0748

08182-66564

1810-0616
1810-0616
1810-0616
1810-0616

1250-1737

4040-0752
4040-0748

08182-66505

1810-0616
1810-0616
1810-0616
1810-0616
4040-0754
4040-0748

08180-61601

Description

BD AY U PRCR

BATTERY NICAD
PC EXTR BD BRN
PC EXTR BD POLY

BD AY INTERFC
BATTERY NICAD
CONNECTOR POST
CC AXIAL TEST P
PC EXTR BD RED
PC EXTR BD POLY
BD AY ADDRESS

DEL LINE 14 P
DEL LINE 14 P

CC AXIAL TEST P

PC EXTR BD ORN
PC EXTR BD POLY

BD AY CNTL

DELAY LINE 14 P
DELAY LINE 14 P
DELAY LINE 14 P
DELAY LINE 14 P

CC AXIAL TEST P

PC EXTR BD YEL
PC EXTR BD POLY

BD AY DATA

DELAY LINE 14 P
DELAY LINE 14 P
DELAY LINE 14 P
DELAY LINE 14 P
PC EXTR BD BL
PC EXTR BD POLY

CBL AY MDL

BD NO.

A6l
X
A6l

A62

A62
AG2
A62
A62

A63
A63

A63

AG63
AG3

A64
A64
A64
Ab4

A64

Ao64
A64

A65
A65
A65
A65
A66
A66

A66

Revision 1.0, Dec. 1987



Parts Lists

This is a replaceable parts list on a sub-assembly level.

Reference
Designator

A68

DL1/DL7
DL3

J3/35
J6
J8/J11

MPI1
MP2

AT72

J1
J2
J3
J4
J5
Jo
J7
J8
J9
J10
J11
J12
J13
J14
J15
J16
J17
J18
J19
J20
- J21
J22
J23
J24
J25

Revision 1.0, Dec. 1987

HP Part
Number

08180-66568

1810-0616
1810-0893

1250-1737
1200-0588
1200-0548

4040-0747
4040-0748

08180-66572

1251-2026
1251-1365
1251-2026
1251-2026
1251-2026
1251-2026
1251-2026
1251-2026
1251-2026
1251-2026
1251-2026
1251-1365
1251-1365
1251-2026
1251-2026
1251-2026
1251-1365
1251-1365
1251-1365
1251-1365
1251-1365
1251-2026
1200-0607
1251-3004
1251-0541

Description

BD AY ADR CTL 2

DELAY LINE 14 P
DELAY LINE 10 NS

CC AXIAL TEST P
SOCKET IC 16 CON
SOCKET IC 14 CON

PC EXTR BD GRA
PC EXTR BD POLY

BD AY MOTHER

CONN PC 36 CONT
CONN PC 44 CONT
CONN PC 36 CONT
CONN PC 36 CONT
CONN PC 36 CONT
CONN PC 36 CONT
CONN PC 36 CONT
CONN PC 36 CONT
CONN PC 36 CONT
CONN PC 36 CONT
CONN PC 36 CONT
CONN PC 44 CONT
CONN PC 44 CONT
CONN PC 36 CONT
CONN PC 36 CONT
CONN PC 36 CONT
CONN PC 44 CONT
CONN PC 44 CONT
CONN PC 44 CONT
CONN PC 44 CONT
CONN PC 44 CONT
CONN PC 36 CONT
SKT IC 16 CONT
CONN POST
CONN 34 PIN

BD NO.

A68
A68

A68
A68
A68

A68
A68

AT72
AT72
A72
AT2
A72
A2
AT2
AT72
A72
A72
AT2
A72
AT72
AT2
A72
AT72
AT72

- AT2

AT72
AT72
AT72
AT72
A72
AT72
AT72



Parts Lists
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2-3 Parts Lists for the HP 8181B

Reference
Designator

Frame

A0l
AG2
AG6
AG8
AT72
AT6
A661
A663

Bl
B2

FIA
FI1E

FL1

MPI
MP4
MP5
MP6
MP7
MP8

MP9

MPI10
MPI11
MP12
MP13
MP14

MPI18
MP23
MP25
MP26
MP28

MP30
MP32
MP33
MP34
MP134
MP35

Revision 1.0, Dec. 1987

HP Part
Number

08181-66561
08180-66562
08180-66566
08181-66568
08181-66572
08180-66576
08180-62661
08181-62663

3160-0510
3160-0510

2110-0051
2110-0010

9135-0192

08181-00264
08180-01205
08180-00204
08180-04111
08180-04102
08180-01202

01830-23201
0403-0374
5040-1148
5040-1149
08180-04101
08180-01206

08181-00262
08181-04155
5041-6820
5060-9804
5041-6819

5021-0519
5040-7201
5061-9447
08160-04101
5060-9884
5001-8233

Parts Lists

Description

BD AY MULTIPLEX
BD AY GEN MDL
BD AY MODULE
BD AY ADR CNTL2
BD AY MOTHER
BD BD AY Fan Filter
MDL AY PWR SPLY
PNL AY REAR

DC MOTOR FAN
DC MOTOR FAN

FUSE 10A 115V
FUSE 5A 250V

FILTER LINE

PANEL REAR
BRACKET FAN
PANEL REAR PS
COVER TOP PS
PANEL SIDE PS
BRACKET PERF.

COUPLER SW 10-24
BUMPER FOOT
SHAFT SHORT/GRAY
SHAFT LONG/GRAY
PANEL SIDE PS
BRKT PS

PANEL FRONT
COVER TOP

CAP, HANDLE REAR
STRAP HDL 18IN
CAP, HANDLE FRONT

FRM FRNT 7SPCL
FOOT

COVER BOTTOM
COVER SIDE PERF.
COVER SIDE

SIDE GUSSET

BD NO.



2-16

Reference
Designator

MP36
MP37
MP38
MP39
MP40

MP41
MP42
MP43
MP44
MP45
MP46

MP52
MP53
MP54
MP135
MP136

W7
w3

HP Part
Number

08180-05001
08180-02301
08181-00102
5021-5837
5021-5800

5040-7221
5040-9319
5040-9320
08160-0438
0363-0125
8160-0428

08180-03101
2140-0352
08180-47401
1251-0218
08181-1282

08180-61609
08181-61601

Parts Lists

Description BD NO.

CATCH

HOLDER DISTANCE
CAGE CARD
CORNER STRUT
FRAME REAR 7IN

FOOT REAR

SHAFT PWR SWITCH
STOP PWR SWITCH
RFI STRIP FINGER
CONTACT FINGER
RFI ROUND STRIP

GUIDE POWER SHAFT
LAMP INDC TI 18V
KEY CUP

POST CON

STRAP TOP

CBL AY PAIR
CBL AY BUS
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Revision 1.0, Dec. 1987

Parts Lists

Figure 2-6. 8181B Chassis Parts
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Power Supply Module Parts List 8181B

2-18

Reference
Designator

A661

A24
A26
A28
A8l
A82
A83
A85
A87

F101

J1
J2
J3
J5
Jo
J7
J8

S1
T1

F201
F202
F203
F204
F205
F206
F207
F208
F209
F210
F211
F212
F213
F214
F215

MP1
MP2
MPI
MP1
MP1

HP Part
Number

08180-62661

08180-60524
08180-60526
08180-66528
08180-66581
08180-66582
08180-66583
08180-66585
08180-66587

2112-0002

1251-0472
1251-2035
1251-2035
1251-2034
1251-2034
1251-2034
1251-2034

3101-2624
08180-61105

2110-0456
2110-0456
2110-0653
2110-0653
2110-0653
2110-0653
2110-0456
2110-0456
2110-0456
2110-0456
2110-0456
2110-0456
2110-0456
2110-0456
2110-0456

4040-0750
4040-0748
4040-0751
4040-0753
4040-0755

Parts Lists

Description

MDL PWR SUPPLY

BD AY FILTER

BD AY REG +15, -7V
BD AY CAPACITOR
BD AY MOTHER
BD AY RECTIFIER
BD AY SWITCHING
BD AY +5V -5V

BD AY +23V

FUSE 2A 250V NT

CONN PC
CONN PC
CONN PC
CONN PC
CONN PC
CONN PC
CONN PC

SWITCH PWR
XFMR AY

FUSE 10A 125V
FUSE 10A 125V
FUSE MINI 15A
FUSE MINI 15A
FUSE MINI 15A
FUSE MINI 15A
FUSE 10A
FUSE 10A
FUSE I0A
FUSE 186A
FUSE 10A
FUSE 10A
FUSE 10A
FUSE 10A
FUSE 10A

BD EXTR RED

BD EXTR POLY
BD EXTR ORN

BD EXTR GRN

BD EXTR VIO

BD NO.

A8l
A8l
A8l
A8l
A8l
A8l
A8l

A8l
A8l

A82
A82
A82
A82
A82
AS82
A82
A82
A82
A82
A82
A82
A82
A82
A82

A82
A82
A83
A85
A87

Revision 1.0, Dec. 1987



Parts Lists

e \\\\
\ \ o
P
/ @\./\
©

e
IS\ //

07

VA X

R
%

Figure 2-7. A661 Power Supply Module
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Parts Lists

Rear Panel Assembly Parts List for the 8181B

2-20

Reference
Designator

A663

Bl

MP1
MP4

w7
w38

HP Part
Number

08181-62663
3160-0510

08181-00264
08180-01205

08180-61609
08181-61601

Description

PNL AY REAR

FAN - DC

PANEL REAR
BRACKET FAN

CBL AY PAIR
CBL AY BUS

BD NO.

Revision 1.0, Dec. 1987



Parts Lists

Figure 2-8. A663 Rear Panel Assembly
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Parts Lists

This is a replaceable parts list on a sub-assembly level

Reference
Designator

A6l
13

MPI
MP2

A62
BT1

MPI
MP2

A66

MP1
MP2

Wil

A68

DL1
DL3

AT2
J1
J2
J3
Ja
J5
Jo
J7
J8
J9
J10
J11
J12
J13
J14
J15
J16
J17
J18
AT6

HP Part
Number

08181-66561

1251-3782

4040-0749
4040-0748

08180-66562

1420-0251

4040-0750
4040-0748

08180-66566

4040-0754
4040-0748

08180-61601

08181-66568

08181-61665
1810-0893

08181-66572
1251-2026
1251-1365
1251-2026
1251-2026
1251-2026
1251-2026
1251-2026
1251-2026
1251-2026
1251-1365
1251-1365
[251-1365
1251-1365
1251-1365
1251-1365
1251-1365
1251-1365
1251-1365
08180-66576

Description

BD AY MULTIPLEXER

" CONN

PC EXTR BD BRN
PC EXTR BD POLY

BD AY GEN MDL

BATTERY NICAD

PC EXTR BD RED
PC EXTR BD POLY

BD AY MODULE

PC EXTR BD BL
PC EXTR BD POLY

CBL AY MDL

BD AY ADR CTL 3

CBL AY DELAY LINE

DELAY LINE 10 NS

BD AY MOTHER
CONN PC 36 CONT
CONN PC 44 CONT
CONN PC 36 CONT
CONN PC 36 CONT
CONN PC 36 CONT
CONN PC 36 CONT
CONN PC 36 CONT
CONN PC 36 CONT
CONN PC 36 CONT
CONN PC 44 CONT
CONN PC 44 CONT
CONN PC 44 CONT
CONN PC 44 CONT
CONN PC 44 CONT
CONN PC 44 CONT
CONN PC 44 CONT
CONN PC 44 CONT
CONN PC 44 CONT
BD AY TEMP CTRL

BD NO.

A6l

Aol
A6l

A62

A62
A62

A66
A66

A66

A68
A68

A72
AT72
AT72
AT72
A72
AT2
AT72
AT72
AT72
A72
AT2
A72
AT72
AT72
A72
AT2
AT2
AT72
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2-4 Parts Lists for the HP 8182B

Module Parts List

2-24

Reference
Designator

FRAME

A6l
A62
A63
A64
AG6S5
Ab
A8
A67
A661
A672
A663

Bl
B2

F1A
FI1E

FL1

MP1
MP4
MP5
MP6
MP7
MP$8

MP9

MP10
MP11
MP12
MP13

MP14
MP15
MPI16
MP17
MP18
MP19

MP20

MP21
MP22

HP Part
Number

08182-66561
08182-66562
08182-66563
08182-66564
08182-66565
08182-66506
08182-66508
08182-66567
08182-62661
08182-62672
08182-62663

3160-0510
3160-0510

2110-0249
2110-0056

9135-0192

08182-00265
08180-01205
08182-00204
08180-04111
08180-04102
08180-01202

01830-23201
0403-0374
5040-1148
5040-1149
08180-04101

08182-01206
08180-04110
08180-64701
08180-01203
5021-0508

08182-00201

4040-2097
1400-0678
08180-04115

Parts Lists

Description

BD AY U-PRCP
BD AY INTERF
BD AY ADDRESS
BD AY CNTL

BD AY DATA
BD AY CLOCK
BD AY HP-IB

BD AY MOTHER
MDL AY PWR SPLY
MDL AY DISP
PNL AY REAR

DC MOTOR FAN
DC MOTOR FAN

FUSE 12A 115V
FUSE 6A 250V

FILTER LINE

PANEL REAR
BRACKET FAN
PANEL REAR PS
COVER TOP PS
PANEL SIDE PS
BRACKET PERF.

COUPLER SW 10-24
BUMPER FOOT
SHAFT SHORT/GRAY
SHAFT LONG/GRAY
PANEL SIDE PS

BRKT PS
COVER TOP CRT MOD
MODULE CRT
CLAMP CRT
PANEL FRONT
PANEL KEYBD

FACEPLATE SAFETY
CLAMP
PLATE SAFETY
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Reference
Designator

MP23
MP25
MP26
MP28

MP30
MP3]
MP32
MP33
MP34
MP134
MP35

MP36
MP37
MP38
MP39
MP40
MP41
MP42
MP43
MP44
MP45
MP46
MP47
MP48
MP50
MP52
MP53
MP54
MP136

Vi

Wi
w2
W3
w4
W5
W6
W7
w38
\\&
W10
Wil
W12
wi4
w19
W21

Revision 1.0, Dec. 1987

HP Part
Number

08182-04155
5041-6820
5060-9804
5041-6819

5021-0519
1460-1345
5040-7201
5061-9447
08160-04101
5060-9884
5001-8233

08180-05001
08182-02301
08182-00101
5021-5837
5021-5806
5040-7221
5040-9319
5040-9320
08160-0438
0363-0125
8160-0428
5040-7202
5001-0440
9140-0726
08180-03101
2140-0352
08180-47401
08182-01282

2090-0706

08182-61610
08182-61671
08182-61672
08182-61673
08182-61614
08182-61675
08182-61676
08182-61677
08182-61678
08182-61619
08182-61605
08182-61601
08182-61606
5180-2421

08180-61639

Parts Lists

Description

COVER TOP

CAP, HANDLE REAR
STRAP HDL 18IN

CAP, HANDLE FRONT

FRM FRNT 7SPCL
TILT STAND

FOOT

COVER BOTTOM
COVER SIDE PERF.
COVER SIDE

SIDE GUSSET

CATCH

HOLDER DISTANCE
CAGE CARD
CORNER STRUT
FRAME REAR 7IN
FOOT REAR

SHAFT PWR SWITCH
STOP PWR SWITCH
RFI STRIP FINGER
CONTACT FINGER
RFI ROUND STRIP
TRIM STRIP TOP
TRIM STRIP SIDE
WIRE AY YOKE
GUIDE POWER SHAFT
LAMP INDC TI 18V
KEY CUP

STRAP TOP

CRT

CBL AY CLOCK QUAL
CBL AY TRG ARM
CBL AY TRG QUAL
CBL AY STOP

CBL AY CLOCK OUT
CBL AY ACTIVE OUT
CBL AY TRG OUT

BD NO.

CBL AY PULSED ERROR
CBL AY LATCHED ERROR

CBL AY SHLD VID
CBL AY CLOCK
CBL AY TWIN
CBL AY DATA
CBL AY HP-IB
CBL AY CRT
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Parts Lists

MP34 (1x )

Figure 2-10 8182 Chassis Parts
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Reference
Designator

A6061

A24
A25
A26
A28
A8l
A82
A83

F101

I
J2
J6
J7

S1
Tl

F201
F202
F203
F204
F205
F206
F207
F208
F209
F210
F211
F212
F213
F214

MPI
MP2

MPI

Revision 1.0, Dec. 1987

HP Part
Number

08182-62661

08182-66524
08182-66526
08182-66526
08180-66528
08182-66581
08182-66582
08182-66583

2112-0002

1251-0472
1251-5160
1251-2034
1251-2034

3101-2624
08182-61105

2110-0446
2110-0446
2110-0446
2110-0446
2110-0446
2110-0446
2110-0653
2110-0653
2110-0653
2110-0653
2110-0653
2110-0653
2110-0446
2110-0446

4040-0750
4040-0748

4040-0751

Parts Lists
Power Supply Module Parts List of the 8182B

Description

MDL PWR SUPPLY

BD AY POST REG
BD AY INDUCTOR
BD AY REG +15, -10V
BD AY CAPACITOR
BD AY MOTHER

BD AY RECTIFIER
BD AY SWITCHING

FUSE 2A 250V NT

CONN PC
CONN PC
CONN PC
CONN PC

SWITCH PWR
XFMR AY

FUSE 10A 125V

. FUSE 10A 125V

FUSE 10A 125V
FUSE 10A 125V
FUSE 10A 125V
FUSE 10A 125V
FUSE MINI 15A
FUSE MINI 15A
FUSE MINI I5A
FUSE MINI 15A
FUSE MINI 15A
FUSE MINI 15A
FUSE 10A 125V
FUSE 10A 125V

BD EXTR RED
BD EXTR POLY

BD EXTR ORN

BD NO.

A8l
A8l
A8l
A8l

A8l
A8l

A82
A82
A82
A82
A82
A§2
A82
A82
A82
A82
A82
A82
A82
A82

A82
A82

A83
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Figure 2-11. A661 Power Supply
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Reference
Designator

A672

Al7
A30
A32
A34

MPI15
MPl6
MP17
MP18
MP19
MP20
MP21
MP30
MP47
MP438

MP50
MP53
MP54

Vi

w21
W30
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HP Part
Number

08182-62672

08180-66517
08180-66530
08180-66532
08180-66534

08180-04110
08180-64701
08180-01203
5021-0508
08182-00201
4040-2097
1400-0678
5021-0519
5040-7202
5001-0440

9140-0726
2140-0352
08180-47401

2090-0706

08180-61639
5180-2413

Parts Lists
Display Module Assembly Parts List of the HP8182B

Description

MDL AY DISPLY

BD AY KEY

BD AY CNTL

BD AY DFL VRT
BD AY DFL HORZ

COVER TOP CRT
MODULE CRT
CLAMP CRT
PANEL FRONT
PANEL KEYBD
FACEPLATE SAFET
CLAMP

FRM FRNT

TRIM STRIP TOP
TRIM STRIP SIDE

DEFLECTION YOKE
LAMP INCD TI18V
KEY CUP

CRT

CBL AY CRT
CBL RBN 230 MM

BD NO.



Parts Lists

Keyboard Assembly Parts List of the HP8182B

Reference HP Part Description BD NO.
Designator Number
Al7 08180-66517 BD AY KEY
MP70 5041-0846 KNOB NOM 0
MP71 5041-0847 KNOB NOM 1
MP72 5041-0848 KNOB NOM 2
MP73 5041-0849 KNOB NOM 3
MP74 5041-0850 KNOB NOM 4
MP75 5041-0851 KNOB NOM 5
MP76 5041-0852 KNOB NOM 6
MP77 5041-0853 KNOB NOM 7
MP78 5041-0854 KNOB NOM 8
MP79 5041-0855 KNOB NOM 9
MP80 5041-2756 KNOB A
MP81 5041-2757 KNOB B
MP8§2 5041-2758 KNOB C
MP83 5041-2759 KNOB D
MP84 5041-2760 KNOB E
MP85 5041-2761 KNOBF
MP86 5041-2763 - KNOB +/-
MP87 5041-0841 KEY CUP
MP88 5041-0409 KNOB NOM BLK
MP89 5041-2765 KNOB RUN
MP90 5041-2755 KNOB STOP
MP91 5041-2762 KNOB X
MP92 5041-2768 KNOB SAMPLE
S1/33 5060-9436 SW P-BTN SINGLE
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Figure 2-12. A672 Display Module
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Rear Panel Assembly Parts List of the HP8182B

2-32

Reference
Designator

A663
A8

Bl

MPI
MP4
MP135

W10
Wll
WiI2
W14

HP Part
Number

08182-62663
08182-66508
3160-0510

08182-00265
08180-01205
1251-0218

08182-61619
08182-61605
08182-61601
08182-61600

Parts Lists

Description BD NO.

PNL AY REAR
BD AY HP-IB

FAN - DC

PANEL REAR
BRACKET FAN
CONN DS POST

CBL AY SHLD VID
CBL AY CLOCK
CBL AY TWIN
CBL AY DATA
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Parts Lists

Figure 2-13. Rear Panel Assy
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Parts Lists

This is a replaceable parts list on a sub-assembly level

Reference
Designator

A6l
BT100

MPI
MP2

A62

J3
J3A

MP3
MP2

A63

DL110
DL111

J3/4

MP1
MP2

A64

DL101
DL103
DL104
DL201

J3/J8

MP1
MP2

A65

DL107
DL207
DL307
DL407

HP Part
Number

08182-66501

1420-0251

4040-0749
4040-0748

08182-66562

1251-4267
1250-1737

4040-0750
4040-0748

08182-66563

1810-0616
1810-0616

1250-1737

4040-0751
4040-0748

08182-66504

1810-0616
1810-0616
1810-0616
1810-0616

1250-1737

4040-0752
4040-0748

08182-66565

1810-0616
1810-0616
1810-0616
1810-0616

Description

BD AY U PRCR
BATTERY NICAD

PC EXTR BD BRN
PC EXTR BD POLY

BD AY INTFC

CONNECTOR POST
CC AXIAL TEST P

PC EXTR BD RED
PC EXTR BD POLY

BD AY ADDRESS

DEL LINE 14 PI
DEL LINE 14 PI

CC AXIAL TEST P

PC EXTR BD ORN
PC EXTR BD POLY

BD AY CNTL

DELAY LINE 14 PI
DELAY LINE 14 PI
DELAY LINE 14 PI
DELAY LINE 14 PI

CC AXIAL TEST P

PC EXTR BD YEL
PC EXTR BD POLY

BD AY DATA

DELAY LINE 14 PI
DELAY LINE 14 P1
DELAY LINE 14 P1
DELAY LINE 14 PI

BD NO.

A6l

A6l
A6

A62
A62

A62
A62

A63
A63

A63

A63
A63

A64
A64
A64
A64

A64

A64
A64

A65
A65
A65
A65
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Parts Lists

This is a replaceable parts list on a sub-assembly level

Reference
Designator

MP]
MP2

A6
J301
J601
MP1
MP2
A67
J1/326
J27

J29
J30/J43

Revision 1.0, Dec. 1987

HP Part
Number

4040-0753
4040-0748

08182-66506

1251-4267

1251-4267

4040-0754

4040-0748

08132-66567

1251-1365

1251-8828

1251-8980
1251-7871

Description

PC EXTR BD GRN
PC EXTR BD POLY

BD AY CLOCK
CONNECTOR POST
CONNECTOR POST
PC EXTR BD BLA
PC EXTR BD POLY
BD AY MOTHER
CONN PC 44 CONT
CONN POST 40CON

CONN POST TP HD
CONN ICONT R AN

BD NO.

A65
A65

A6
A6

A6
A6

A67
A67
A67
A67
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COMPONENT LAYOUT ©8182-66567

Figure 2-14. A67 Motherboard
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Parts Lists
2-5 Exchange Boards Parts Lists

Exchange Boards for the HP 8180B

EXCHANGE PARENT DESCRIPTION CAN ALSO
PART NO. PART NO. BE USED
IN THE 8180A
08180-69561 08180-66561 BD AY U PROC NO
08180-69562 08180-66562 BD AY GEN MDL NO
08180-69563 08180-66563 BD AY ADDRESS NO
08180-69564 08180-66564 BD AY SYNC YES
08180-69565 08180-66565 BD AY TIMING YES
08180-69566 08180-66566 BD AY MODULE NO
08180-69568 08180-66568 BD AY ADR CTL 1l NO
08180-66515 BD AY KEY YES
08180-66524 BD AY FILTER YES
08180-66526 BD AY REG YES
08180-66528 BD AY CAPACITOR YES
08180-66530 BD AY CNTL YES
08180-66532 BD AY DEFL VERT YES
08180-66534 BD AY DEFL HORZ YES
08180-66540 BD AY HP-IB YES
08180-66572 BD AY MOTHER NO
08180-006576 BD AY TEMP CTRL YES
08180-66581 BD AY MOTHER PS YES
08180-69582 08180-66582 BD AY RECT YES
08180-69583 08180-66583 BD AY SWITCH YES
08180-66585 BD AY REG YES
08180-66587 BD AY REG YES
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Exchange Boards for the HP 8181B

2-38

EXCHANGE
PART NO.

08180-69562
08180-69566
08181-69568

08180-69582
08180-69583

PARENT
PART NO.

08181-66501
08180-66502
08180-66566
08181-66568

08180-66524
08180-66526
08180-66528
08181-66572
08180-66576
08180-66581
08180-66582
08180-66583
08180-66585
08180-66587

Parts Lists

DESCRIPTION

BD AY MULTIPL.
BD AY GEN MDL
BD AY MODULE

BD AY ADR CTL3

BD AY FILTER

BD AY REG

BD AY CAPACITOR
BD AY MOTHER
BD AY TEMP CTRL
BD AY MOTHER PS
BD AY RECT

BD AY SWITCH

BD AY REG

BD AY REG

CAN ALSO
BE USED
IN THE 8181A

NO
NO
NO
NO

YES
YES
YES
NO

YES
YES
YES
YES
YES
YES
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Exchange Boards for the HP 8182B

EXCHANGE PARENT DESCRIPTION CAN ALSO
PART NO. PART NO. BE USED
IN THE 8182A
08182-69561 08182-66561 BD AY U PROC NO
08182-69562 08182-66562 BD AY INTFC NO
08182-69563 08182-66563 BD AY ADDRESS NO
08182-69564 08182-66564 BD AY CNTL NO
08182-69565 08182-66565 BD AY DATA NO
08182-69506 08182-66506 BD AY CLOCK YES
08182-66508 BD AY HP-IB YES
08182-66517 BD AY KEY YES
08180-66524 BD AY FILTER YES
08182-66524 BD AY REG YES
08182-66525 BD AY INDUCT. YES
08182-66526 BD AY REG YES
08180-66528 BD AY CAPACITOR YES
08180-66530 BD AY CNTL TES
08180-66532 BD AY DEFL VERT YES
08180-66534 BD AY DEFL HORZ YES
08182-66567 BD AY MOTHER NO
08182-66581 BD AY MOTHER PS YES
08182-69582 08182-66582 BD AY RECT YES
08182-69583 08182-66583 BD AY SWITCH YES
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Power Supply Adjustment

Chapter 3
8180A/B Adjustment Procedures

3-1 Introduction
This chapter covers the adjustments procedures necessary for the HP §180A and 8180B generators.

When performing a major adjustment of the instrument, it is recommended that the adjustments are
carried out in the order given.

3-2 Power Supply Adjustment 8180B
Equipment:

Digital Voltmeter, testleads HP3456A

[WARNING l

High voltage is present when performing this adjustment.

NOTE

These adjustments must be done with all PC-Boards inserted.
When retrofitting options, first install all new boards, adjust the
power supply and then continue with the other adjustments.

1. Remove cover from power supply.

2. Allow instrument to warm up for 10 minutes.

3. Connect DVM to TP4 on the A85 board and adjust A83 R323 to -6.1V reading.
Output voltage adjustment of the -5.2V post regulator

NOTE

If two timing boards are installed, remove right hand cover,
connect DVM to the upper lead of A65 C520.
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5.

Power Supply Adjustment

Adjust A85 R520 to -5.2V reading.

3-2

Base current and storage time adjustment of switching transistor
Q304 are optimized in the factory. Therefore, never try to adjust
A83 R360 and A83 R32.

e ! P

COMPONENT SIDE
28180-66585

Figure 3-1. A85 Post Regulator Board
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Power Supply Adjustment

COMPONENT SIDE 08188-66583

7

Figure 3-2 A83 Switching Board
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Power Supply Adjustment

COMPONENT SIDE

98 180-66586

Figure 3-3. A86 Postregulator Board
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Power Supply Adjustment

COMPONENT SIDE

028188-66587

Figure 3-4. A87 Postregulator Board
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Display Control Board 08180-66530

3-3 Display Control Board 08180-66530
Display Adjustment

If the display has to be completely adjusted (after a CRT change), set A34R3 clockwise and all other
potentiometers to mid range. Position the deflection yoke nearest to the screen and fasten it lightly.

1.  Set AISI to the position as shown in the following figure.

Figure 3-5. Switch | Microprocessor Board Al
2.  Remove A32J4 (Vertical Deflection Board) and turn the instrument on.

3. If necessary slightly increase the intensity with A32R37.

NOTE

If a bright dot is not visible, set AISI to the position as shown in
the following figure.

Figure 3-5 continued

4. Using the two ring magnets on the deflection yoke, position the dot approximately 3 mm (1/8 in)
above the center of the screen.

NOTE

After ring magnet adjustment set A1SI to the position as shown in
the first figure on this page.

5. Turn the instrument off and reconnect A32J4, press A251 and select the test pattern by pressing the
left upper softkey (Adjst Display).

6.  Adjust A32R21 (Freq.) for a stable display.

7.  Center the test pattern with A34R1 (Hor. Pos.) and adjust A34L2 (Hor. Lin.) for maximum
horizontal deflection.
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10.

1.

Display Control Board 08180-66530
Adjust A34R3 (Hor. Sync) so that no intensified lines appear.

Adjust A34L4 (Hor. Amp.) for approx. 12.5 cm (4 1/2 in) horizontal deflection.
Re-adjust A34L2 for best horizontal linearity.

Re-centre the test pattern with A34R1 and repeat steps 8 to 10.

Adjust A32R27 (Vert. Amp.) for approx. 9 cm (3 1/2 in) vertical deflection.
Adjust A32R22 (Vert. Lin.) for best vertical linearity.

Re-adjust and fasten the deflection yoke, and repeat steps 2 to 13 if necessary.

Correct any ’pin cushion’ distortion by adding small correction magnets to the deflection yoke.

Intensity and Focus Adjustment

16.

17.

18.

19.

Press AISI and select Brightness on the Miscellaneous page: (Pages > Miscellaneous > Brightness >

Increase [until maximum brightness is obtained]).
Adjust A32R37 (Intens.) until the line flyback is no longer visible,
Adjust A32R36 for the best possible focusing.

Secure the ring magnets, deflection yoke and correction magnets using silicon compound.
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Display Control Board 08180-66530

Q | HrAr
T2
L4
0O | HOR.LIN.
L2
]
1
HOR. SYNCH.
(Y
2
LI
3 TPS
= )
TF2 TP4 Ra
HOR. POS.

COMPONENT SIDE ©8180-66534

Figure 3-6. High Voltage Board
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Display Control Board 08180-66530
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COMPONENT SIDE 88180-66561

Figure 3-7. A61 Microprocessor Board
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GEM Interface Board 08180-66502 (8180A)

3-4 GEM Interface Board 08180-66502 (8180A); 08180-66562 (8180B)

Restart Circuit Adjustment 08180-66502

Equipment:

Oscilloscope with Probe HP54100D
Digital Voltmeter, testleads HP3456A
5V Power Supply HP6624A

1. Remove the A2 Interface Board from the §180A.

2. Set the power supply output voltage to +4.80V and connect the supply to the +5V and GND TP on
the A2 board.

3. Connect the oscilloscope probe to the RES TP and GND TP and adjust A2 R4 so that the RES
signal just switches from high to low.

4, Insert A2 and fit board distance holder.

D-A Converter Adjustment 08180-66502
Equipment:
Digital YVoltmeter HP3456A

1. Program 8180A : Standard Set.
(Pages > Store/Recall > Rcl Std Set > Execute).

2. Label B; Low Level -2V; High Level -1.5V: (Pages > Output > Level > Next Label [B] > Low <>
High [Low] > -2 > Volt > Low <-> High [High] > -1.5 > Volt)

3.  Connect DVM to A2 TP5 and the nearest GND TP and adjust A2 R129 for -0.75 Volt £2mV
reading.

4,  Set Label B; High Level to +5.5V (5.5 > Volt) and adjust A2 R127 for +2.75 Volt +/- ImV reading.
5.  Set Label B; High Level to 0V (0 > Volt) and readjust A2 R129 to 0.000V +/- 0.5mV reading.

6. Repeat steps 2 to 5 if necessary.

7.  Program Label B; High Level +1.00V; Low Level 0.00V: (I > Volt > Low <-> High [Low] > 0 > Volt).

8. Connect DVM to A2 TP6 and adjust A2 R130 for 0.000V £0.5mV reading.

DA-Converter Adjustment 08180-66562
Equipment:
Digital Voltmeter HP3456A

I.  Program 8180B : Standard Set.
(Pages > Store/Recall > Rcl Std Set > Execute).

2.  Label B; Low Level -2V: High Level -1.5V: (Pages > Output > Level > Next Label [B] > Low <>
High [Low] > -2 > Volt > Low <-> High [High] > -1.5 > Volt)
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GEM Interface Board 08180-66502 (8180A)

3.  Connect DVM to A62 TP5 and the nearest GND TP and adjust A62 R129 for -0.75 Volt +2mV
reading.

4.  Set Label B; High Level to +5.5V (5.5 > Volt) and adjust A62 R127 for +2.75 Volt +/- ImV reading.
5.  Set Label B; High Level to 0V (0 > Volt) and readjust A62 R129 to 0.000V +/- 0.5mV reading.

6. Repeat steps 2 to 5 if necessary.

7.  Program Label B; High Level +1.00V; Low Level 0.00V: (I > Volt > Low <-> High [Low] > 0 > Volt).

8. Connect DVM to A62 TP 6 and adjust A62 R130 for 0.000V 10.5mV reading.
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GEM Interface Board 08180-66502 (8180A)

COMPONENT SIDE ©8188-66562

Figure 3-8. A62 Interface Board
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Address Control 1 Board 08180-66503 (8180A); 08180-66563 (8180B)

3-5 Address Control 1 Board 08180-66503 (8180A); 08180-66563 (8180B)

Equipment:

Universal Counter 5370B
Adjustment Cover 08180-04103
Strobe/Clock Cable Set 15422A
BNC Adapter 15409A

NOTE

Final adjustment must be done with the adjustment cover in place.
Close adjustment holes with tape and remove tape only when
adjusting. Allow instrument to warm up for 30 minutes. Refer to
Section 1-4, paragraphs 4 and 5.

Measurement setup:

8180R/B

COUNTER

A B
Z=56 oM O O

15422R 154@3A
FROM STROBE OUT (-D

Figure 3-9. Clock Generator Adjustment

Internal Clock Generator Adjustment

L.

2.

Program 8180A/B Standard Set: (Pages > Store/Recall > Rcl Std Set > Execute)
Strobe Output Clock: (Pages > Control > Strobe Output > Clock)

Outputs On: (Pages > Output > Outp on/of f > On)

Frequency 10 MHz: (Pages > Timing > Frequency > 10 > Megahertz)

Connect equipment as shown in measurement set up and press RUN.

Adjust A3 (A63)R67 for 9.90 MHz.

Set 8I80A/B to 50 MHz (50 > Megahertz), and adjust A3 (A63) R75 for 50.50 MHz

Set 8180A/B to | MHz (1 > Megahertz), and adjust A3 (A63) R66 for 0.990 MHz.

Set 8180A/B to 9.99 MHz: (9.99 > Megahertz), and adjust A3 (A63) R74 for 9.8390 MHz.

Revision 1.0, Dec. 1987
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Address Control 1.Board 08180-66503 (8180A); 08180-66563 (8180B)
Zero Delay of Clock 1 and Clock 2 Adjustment

Equipment:

Scope 54100D
Active Pods 54001A
Extender Board 08180-66551
Extender Board 08180-66557

NOTE

This adjustment is to be done only for the 8180B. Before
installing the A3 (A63) and A8 (A68) boards on extenders fit
distance holder.

Measurement setup:

PROBE 1 TO R1Q-UI7B PIN 10

A3 AND A8 ON
EXTENDER PROBE 2 TO R3-U18C PIN 13
8180A/B |/ 54108D

12

Figure 3-10. Zero Delay - Clk1/Clk2
1.  Program 8180B Standard Set: (Pages > Store/Recall > Rcl Std Set > Execute).
2. Frequency 10 MHz (Pages > Timing > Frequency > 10 > Megahertz).
3. Connect equipment as shown in measurement set up and press RUN.
4,  Before performing the adjustment cancel out the channel to channel skew of the scope.

5. Set scope to: (Autoscale > Display > Split Screen to Off > Timebase > Sec/Div > Ins sTrigger >
Trigger Source to Chan I > Slope to POS).

6.  Adjust A63DL3 for Ons difference between the displayed transitions.
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Address Control 1 Board 08180-66503 (8180A); 08180-66563 (8180B)

//
M—g“"""’hw F:l’:.«.-w
Ch. i = 200.C mveits/div Offset = -1.444 voitc
th. e = 200.C mvolts/div Of fset = ~-1.436 voits
Timehase = 1.00 ns/div Delay =  0.00000 =

Figure 3-11. Zero Delay
External Inputs, D-A Converter Adjustment
Equipment:

Digital Voltmeter, testleads 3456A

I.  Program 8180A/B Input Threshold -10V: (Pages > Control > Inputs > Threshold > -10 > Voit).

2. Connect the DVM to TPl and GND TP on the A3 (A63) board.

3. Adjust A3 (A63) R51 for 333V DVM reading.

4.  Set 8180A/B input threshold to +10V(10 > Volt) and adjust A3 (A63) R50 for -3.33V.
5.  Set threshold to OV and check for 0V +/- 3mV.

6. Repeat step | to 5 and readjust if necessary.

Revision 1.0, Dec. 1987
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Address Control 1 Board 08180-66503 (8180A); 08180-66563 (8180B)

External Clock Amplifier Adjustment

Equipment:

Pulse Generator

Digital Voltmeter, testleads HP 3456A
Extender Board 08180-66551
Scope HP 54100D
Active Pods HP 54001 A

BNC to BNC cable

NOTE

Before putting the A3 (A63) board on an extender, fit a board
distance holder.

Measurement setup:

A3 ON EXTENDER | TO A3 TP2 AND GND

8180A/B | 54100D

12

Figure 3-12. External Clock Amp Adjustment

1.  Program 8180A/B Input Threshold 0V; Impedance 50 Ohm: External Clock positive transition
(Pages > Control > Inputs > Threshold > 0 > Volt > Exit > Impedance > 500hm > Ex Clock Source
> External[positive slope])

2. Connect DVM to A3 (A63) TP2 and GND TP and adjust A3 (A63) R18 for -15mv £2mV.

3. Set pulse generator to 10 microsec squarewave and 2 Volt amplitude into 50 Ohm symmetrical
about 0 Volt. Transition <5ns.

4,  Connect pulse generator to the 8180A/B EXT.CLOCK INPUT

5.  Connect scope probe to A3 (A63) TP2 and GND TP and adjust A3 (A63) C12 for best pulse
response.

Frequency Error Adjustment
6.  Set pulse generator to 51.0 MHz squarewave with 2V amplitude symmetrical about 0 Volt.

7. Adjust A3 (A63) R63 so that the word Clock is flashing in the upper left corner of the 8180A/B
display.
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Address Control 1 Board 08180-66503 (8180A); 08180-66563 (8180B)

g
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COMPONENT SIDE 28188-66563

Figure 3-13. A63 ADC! Board
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‘Address Control 2 Board 08180-66508 (8180A); 08180-66568 (8180B)
3-6 Address Control 2 Board 08180-66508 (8180A); 08180-66568 (8180B)

External Break and Stop Amplifier Adjustment
Equipment:

Pulse Generator
BNC to BNC Cable

Oscilloscope HP 54100D
Scope Probe HP 54001 A
Digital Yoltmeter, Testleads HP 3456

1.  Program 8§180A/B: Input Threshold 0V; Impedance 50 Ohm; Break Input ON
(PAGES > Control > Inputs > Threshold > 0 > Volt > Exit > Impedance > 50 Ohm > Exit > Break
Input > ON b > Exit > Stop Input > ON b)

2. Set pulse generator to 10 Us (100 kHz) squarewave and 2 V amplitude (into 50 Ohm) symmetrical
about 0 V. Transition time < 5 ns.

External Break Amplifier Adjustment
3. Connect DVM to A8 (A68) TP1 and GND TP and adjust A8 (A68) R131 for -15 mV +2mV.
4.  Connect pulse generator to the 8180A/B External Break Input.

5. Connect Oscilloscope probe to A8 (A68) TP1 and GND TP and adjust A8 (A68) C31 for best pulse
response.

External Stop Amplifier Adjustment
6. Connect DVM to A8 (A68) TP2 and GND TP and adjust A8 (A68) R112 for -15 mV 12 mV.
7.  Connect pulse generator to the 8180A/B Stop Input.

8. Connect oscilloscope probe to A8 (A68) TP2 and GND TP and adjust A8 (A68) C23 for best pulse
response.
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Address Control 2 Board 08180-66508 (8180A); 08180-66568 (8180B)

Strobe Reference Delay Adjustment

Equipment:

Adjustment cover: 08180-04103 (8180A/B)
Reference delay line A 08180-61636
Reference delay line B 08180-61696
Cable set 15423A
BNC adapter 15409A
BNC adapter female/female 1250-0080
BNC male probe adapter 1250-1454
50 Ohm feedthrough 10100C
Scope 54100D
Active pods 54001 A

Measurement setup:

08180-6 16396

54100D
8180R-H A3J4
INPUTS
12
[old T
15423A ~ 1250-1454 /> S54001R
NRZ 18102C <
| N
|
1250-2280
1258-1454
19192C |
N
15409R

Figure 3-14. Equipment Setup - Strobe Ref Delay
I.  Adjust interchannel skew of 54100D to zero.

Connect scope inputs 1 and 2 to one signal source output via T-connector (20MHz square wave).
Press scope front-panel keys in the following sequence:

Autoscale > More > Cal+Test > Cal Menu > Trigger delay > Trigger delay > press Expand
waveform until timebase = 500ps. Turn Knob until second transition crosses the horizontal
graticule line at the same place where the first trace crosses the horizontal graticule line.

2. Connect the reference delay line through the hole in the adjustment cover of the §180A/B to A3
(A63) J4 (Reference clock connector).

3.  Adjustment must be done with the adjustment cover in place. Allow the generator to warm up for
30 minutes.

4. Program 8180A/B Standard set: (Pages > Store/Recall > Rcl Std Set > Execute)

5.  Set Label A to TTL level, Strobe to TTL level: (Pages > Output > Level > Next Label(A) > TTL
levels > Execute > Exit Strobe Level > TTL)
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10.

11

12.

13.

14.

15.

Address Control 2 Board 08180-66508 (8180A); 08180-66568 (8180B)

Set Strobe Output to Clock; set Last Address to 00001: (Pages > Control > Strobe Output > Clock >
Exit > Last Address > 1 > Enter N)

Address 0 all bits high; Address 1 all bits low: (Pages > DATA > 1..1> Cﬁrsor(Address 1)>0..0)
QOutputs on: (Pages > Output > Outp On/Off > On)
Connect equipment as shown in the measurement set up.

Press Run.

New Scope settings: (Autoscale > More > Trigger > Trigger Mode > Trigger Mode [to Mode
"Time-Dly"])

Set Trigger conditions to:
After [Neg] Edge > On [Chan 2] > Del [40 ns] Then > Trig On [Pos] Edge > On [Chan 1]

SLCC LTV seo C.oooce e 100,000 n=e.

Lho i = 20C.C mvoits/div Offset = ~722.0 mvoite
LML e = 1.000  voits/ldLv Cffset = 1.s6C vouce
rimebazse = 20.0 nzecl/div Deiay = 0.0CCCl wewn

Figure 3-15. Strobe Ref Delay - 1

Center reference clock to vertical graticule line (Display > Split Screen > off > Graticule to (Grid) >
Timebase to (500ps) > Channel 2 > Channel 2 Display to (Off) > Timebase > Delay) Adjust with
Knob the 50% point of the reference clock transition to center graticule line.

Switch channel 1 display off, channel 2 display on
(Channel 1 > Channel | Display > off
Channel 2 > Channel 2 Display > on)

Set Timebase to 500ps (Timebase > Sec/Div > 500ps)
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Address Control 2 Board 08180-66508 (8180A); 08180-66568 (8180B)

16. Store displayed transition to Memory | (More > Wfmsave > Clear Memory 1 > Memory 1 > on >
Store to Memory 1.

17. Connect in turn all NRZ channels to Input 2 of 54100D. Store each displayed transition into

Memory 1.
~2.%00 nsec C.00000 sec 2.500 nsec
,ﬂwm\wh:'-»
MM
,
ol
Ch. 2 = 500.C mvolts/div Of fset = 1.360 voits
Timebase = 500 psec/div Delay = 0.00000 sec

Figure 3-16. Strobe Ref Delay 2
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Address Control 2 Board 08180-66508 (8180A); 08180-66568 (8180B)

Case 1: Data transitions appear after strobe reference clock.
18. Set Markers (More > Delta t > T Markers > on) Set with Knob the Start Marker to the first
transition and the Stop Marker to the last transition of the displaved group.
th., & = 500.C mvoits/div Offaet = 1.360 voits
Timebaze = 850¢ opsec/div Delay = Q.00 Ce sec
Deita T =3 250 psec
Start = 45¢C pRew Scoo = [Fiee cses
Figure 3-17. Strobe Ref Delay 3
3-22
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Address Control 2 Board 08180-66508 (8180A); 08180-66568 (8180B)

19. Read Delta t.

20. Set Stop Marker to (Delta t)/2 exactly in the middle of the displayed group of transitions. Set Start
Marker to center graticule line and read Delta t.

ce BCC nse . CLOCOlT =eo Bl nsen.

S R T T

th. 2 = 50C.C mvoits/div Of fset = 1.260 voits
Timebase = 500 psec/div Delay = ¢.o0000  sec
deuta 1 = 570 pseu

Start - ¢GLeoeet sec Stap = a70 D3en

Figure 3-18 Strobe Ref Delay 4
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Address Control 2 Board 08180-66508 (8180A); 08180-66568 (8180B)

21.  Switch Memory 1 off: (More > Wfmsave > Memory | > Off)

22.  Set Stop Marker to currently displayed transition; Set Start Marker to Delta t. (More > Delta t >

Stop Marker > Knob > Start Marker > Knob until Delta t is displaved.)

3-24

Figure 3-19. Strobe Ref Delay 5

2L EQOC nse. ool sel PRSI 1€
; 1
| '
1 H
) '
! . ‘
!
l , /
1
| 1 /
!
| 1]
] /
1
b :
I |
!
/l ?
N 1
Ly T
1
| 1
\ 1
) 1
! 1
! :
Ch. ¢ = 500.0 mvoits/div Offset = 1.360 volts
Timebase = 500 psec/div Delay = 0.C0CC0  sec
Deits T = 570 psecl
Start - 260 Lreu Stop - 830 psen
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Address Control 2 Board 08180-66508 (8180A); 08180-66568 (8180B)

23. Adjust A8 (A68) R64 so that the 50% point of the displaved DATA channel transition meets the
Start Marker.

~2.500 nsec 0.00000 sec 2.500 nsec

___-._-___--_-___.-___XX__-___ .

Pl

/ '

/ I

t

I

}

|

1
Ch. 2 = 500.0 mvolts/div Offset = 1.360 volts
Timebase = 500 psec/div Delay - 0.00000 sec

Delta T = 570 psec

Start - 260 psec Stop - 830 psec

Figure 3-20. Strobe Ref Delay 6
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Address Control 2 Board 08180-66508 (8180A); 08180-66568 (8180B)

Case 2: Data transitions appear before strobe reference clock.

24. Set Markers (More > Delta t > T Markers > on) Set with Knob the Start Marker to the first
transition and the Stop Marker to the last transition of the displayed group.

=2, 500 nsev CLOleet sel =.50¢C nse.
T
1
| '
'
! ]
| '
L]
| ] b K ede
\ n . P,
1 SN
1
| 1 f
1 ’l“"
! Y s
| -"’,“’
i
1
1
i
T '
!
| 1
o 1
t 7
1
| '
1 ¥
K \
| 1
! :
Ch. < = 500.C mvoits/div Offset = 1.26C veoits
Timebase = 50C psec/div Deiay = Q.UCCCC  =ewu
Deita T = a0 pse.
Sturt = -610 nee. SLlo = =29 pre.

Figure 3-21. Strobe Ref Delay 7
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Address Control 2 Board 08180-66508 (8180A); 08180-66568 (8180B)

25. Read Delta t.

26.  Set Start Marker to (Delta T)/2 exactly in the middle of the displayed group of transitions. Set Stop
Marker to center graticule line and read Delta t.

- T nIe. ¢L{C Te . TCC naag

T R

|

|

|

] s L0 S PO %

1 LY

[
| _,\/.'"’ﬂ
| ._'.‘.""
o
-»""'”d
/‘?‘4—"
-
el !

T

|

1

|

|

|

1
th. « = 500.C mvolts/div Offsec = 1.260 volts
Timebuse = 500 pseu/div Delay = o.cco0e sec
Deita T = 450 pse.
Stunt = -450 peed. [top = C.oL0ee =el

Figure 3-22, Strobe Ref Delay 8
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Address Control 2 Board 08180-66508 (8180A); 08180-66568 (8180B)

27. Switch Memory 1 Off: (More > Wfmsave > Memory | > Off)

28. Set Start Marker to the 50% point of the currently displayed transition; Set Stop Marker to Delta t:
(More > Delta t > Start Marker > Knob > Stop Marker > Knob)

3-28

e -'\_‘. 'l [ ~ o \'\ e [ ~ '\: x,
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1
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| ] 1
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1
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sansmane Al
|
; 1
1
I 1
! )
Lh., & = 500.0 mvolts/div Offaet 1.56C  volts
iilebase = 50C opseu/div Delay Q.0000C sew
Deica T = 450 psec
Bihant = =21 pes frtop 14¢ DeE..

Figure 3-23. Strobe Ref Delay 9
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Address Control 2 Board 08180-66508 (8180A); 08180-66568 (8180B)

29. Adjust A8 (A68) R64 so that the 50% point of the currently displayed DATA channel transition

meets the Stop Marker.

2. 50 e Yels [S A e e.5C07 LI
! '
1 1
| '
\
| ' e
‘ ' —
' —
! ' e
T 7
| ! ///
1
! [
! e
A}
| / '
i s
T
.r/' !
~ ! 1
/ N ]
I '
N t
’ '
! t
' .
Lh., & = S0C.¢ mvolits/div Offset 1.26C voits
Fimeba=e = 50C pse./div Deiay = Q.00 seo
Deita T = 45¢ paes
‘fzane = ic Do T op = i1 e
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Figure 3-24. Strobe Ref Delay 10
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Address Control 2 Board 08180-66508 (8180A); 08180-66568 (8180B)

30. Check all NRZ channels. The group of transitions should be symmetrical about the reference

clock.
-2 800 nsec CL0eece sac . <500 nagy
T
1
|
1
!
|
|
|
!
ch. 2 = S50C.0 mvoits/div Offset - i.56C voits
Timebase = 50C psec/div Deiav = Q.C0CC0  sec
Delta 7T = 450 psec
Srart -2 =& 10 pRes Srun = 140 Dsey

Figure 3-25. Strobe Ref Delay 11
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Address Control 2 Board 08180-66508 (8180A); 08180-66568 (8180B)

31. Connect the Strobe output to scope channel 2 and adjust A8 (A68) R204 so that the 50% point of

the positive going edge of the Strobe signal overlays with the 50% point of the strobe reference
transition.

NOTE

The adjustment range of A8 (A68) R204 is approximately Ins. If
it is not possible to adjust for zero delay between Strobe and
Strobe reference clock, set A8 (A68) R204 to the middle of the
adjustment range and perform a pre-adjustment with A8 (A68)

DL8. After the pre-adjustment, center the Strobe transition with
A8 (A68) R204 .

Revision 1.0, Dec. 1987
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Figure 3-26. A68 Address Control 11
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Address Control 2 Board 08180-66508 (8180A); 08180-66568 (8180B)
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Module Board 08180-66506 (8180A); 08180-66566 (8180B)
3-7 Module Board 08180-66506 (8180A); 08180-66566 (8180B)

Output Amplifier High/Low Level Adjustment

Equipment:

Digital Voltmeter HP 3456A
BNC adapter 15409A
BNC (f) dual banana plug 1251-2277
DATA cable set 15423A

High Level Adjustment
1.  Program 8180A/B Standard Set: (Pages > Store/Recall > Rcl Std Set > Execute)
2.  Memory Set: (Pages > Data > Edit > Clear & Set > Set Data > Execute)

3. Label A High Level 0V; Low Level -2V: (Pages > Output > Level > Next Label[to Label A] > Low<-
> High[to High] > 0 > Volt > Low<- > High[to Low] > -2 > Volt)

4.  Outputs On: (Pages > Output > Outp on/off > On)

5. Connect Data channel to be adjusted to DVM. Press RUN. Adjust A6 (A66) A60 R2 for OV
+/-0.5mV DVM reading.

Low Level Adjustment
6. Memory Clear: (Pages > Data > Edit > Clear&Set > Clear Data > Execute)

7. Label A High Level +2V; Low Level 0V: (Pages > Output > Level > Low<- > High[to High] > 2 >
Volt > Low<- > High{to L > 0 > Volt)

8. Press RUN and adjust A6 (A66) A60 RI for Ov 0.5mV reading.

Data Flatness and Overshoot Adjustment

Equipment:

Scope 54100D
Active pods 54001A
BNC scope probe adapter 1250-1454
BNC adapter female/female 1250-0080
BNC adapter 15409A
Data cable set 15423A
Strobe/Clock cable set 15422A
50 Ohm feedthrough 10100C

1.  Program 8180A/B Standard Set: (Pages > Store/Recall > Rcl Std Set > Execute)

2. Label A: High Level to +3V, Low Level to -2V: (Pages > Output > Level > Next Label[to Label A] >
Low<- > High[to High] > 3 > Volt > Low<- > Highfto Low] > -2 > Volt)

3.  Frequency 250 Hertz (Pages > Timing > Frequencyv > 250 > Hertz)

4.  First Address 0; Last Address 1; Strobe Output Clock: (Pages > Control > Last Address > | > Enter
Number > Exit > Strobe Output > Clock)
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10.

Module\ Board 08180-66506 (8180A); 08180-66566 (8180B) |

FAD Data High; LAD Data Low: (Pages > Data > | . ... I [until FAD Data is high] 0 ....0 [until

LAD Data is Low])
Outputs On: (Pages > Output > Outp on/off > On)
Press RUN.

Connect DATA channel to be measured to scope channel no. |

Set 54100D to Autoscale and Timebase to | ms: (Autoscale > Timebase > Sec/Div > | > millisec)

Adjust A6 (A66) A60 R4 and A6 (A66) A60 R6 for best flatness.

BRSNS

SELOCUUTT e N re,
e
[ATI = E.OCC suats/alny LEEaay = F[ MAELC Y
iiiebane = P00 meel/aly De v = CouiloC =meu

Figure 3-27. Data Flatness Ad]j
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Module Board 08180-66506 (8180A); 08180-66566 (8180B)

I1. Connect 50 Ohm feedthrough to Data channel and adjust A6 (A66) A60 R5 for best flatness.
Overshoot Adjustment Module Board Output Amplifier 8180A

12, Set 8180A Frequency to 10MHz (Pages > Timing > Frequency > 10 > Megahertz)

13. Label A ECL Levels: (Pages > Output > Level > ECL Levels > Execute)

14. Connect channel to be adjusted to scope input no. | and set scope to: (Autoscale > Delta V >
Vmarkers- > on > Auto Top-Base > Timebase > 1 > nanosec)

15. Read Delta V and adjust A6 A60 R3 for < 9% of Delta V.

-5.0e0 nseu e.coeec sew o0 neeL

.
U SIS JRRDI RPN MDD SR R RPN DR e S RPN

/

I ,,J____.__,,.../_._._____-... ______ L e e e o e ] - e - -
ch. 1 = 20C.C mvolts/aiv Of faet = -1.280 voits
Fimebase = 1.0C nsec/div Deiay = C.CCCCC sec
Deita V = gi2.¢ wmveits
Vianhe~i = -1.736 vsoitn Ymarkerd = -Bz4.0 mvoats

Figure 3-28. Overshoot Adj
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Module Board 08180-66506 (8180A); 08180-66566 (8180B)

16.  Check rise and fall time for typ. [.5ns measured from the 20% to 80% of amplitude.

5.0 nae CLoecy 2 5.000 nse.
| 1
'
| .
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| ' //,/f’**- ~~~~~~
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i '
'
I '
_____ T S T L T T R T e JTC U R
1 '
N 1
T T
| e il +
| '
1
]
| N
! K

th., 1 = 200.C mvoits/div Offsec = ~1.<8C volits
iimebiuse = 1.¢0 nsec/ulv Deiay = 0.C00eC  seu
Delta T = 1.240 nse.
Startc = -620 psec ) Ston = 620 pse
Deita V = S547.2 mvolts
ymarker~ri = ~-1.853 voits Vaariers = ~1,00b6  vOolitbs

Figure 3-29. Rise Time
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Module Board 08180-66506 (8180A); 08180-66566 (8180B)
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Figure 3-30 Fall Time
Overshoot Adjustment Module Board Output Amplifier 8180B
17.  Set 8180B Frequency to 10MHz: (Pages > Timing > Frequency > 10 > Megahertz)
18. Label A ECL Levels: (Pages > Output > Level > ECL Level > Execute)
19. Connect 50 Ohm feedthrough to the data cable to be adjusted.
20. Connect data channel to scope input no. | and adjust A66 A60 R3 for <5% overshoot.

Transition Time Adjustment

21. Adjust rise and fall time for typ. 1.5ns with A66 A60 C27 (measured between the 20% and 80%
point of transition).
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Module Board 08180-66506 (8180A); 08180-66566 (8180B)
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Figure 3-31 A66 Module Board

COMPONENT SIDE ©8180-656566
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Timing Board 08180-66505 (8180A); 08180-66565 (8180B)

3-8 Timing Board 08180-66505 (8180A); 08180-66565 (8180B)

Timing Channels Pre-adjustment

Equipment:

Scope 54100D
Active pods 54001 A

50 Ohm Feedthrough 10100C
BNC adapter female/female 1250-0080
BNC scope probe adapter 1250-1454
Adjustment cover 08180-04103
Data cable set 15423A
Strobe/Clock cable set 15422A

NOTE

Strobe Reference Delay must have already been adjusted in

Section 3-7.

Measurement setup:

541000
8180A./B
STROBE 12
lolo] |
_~— 15422R
I\
15423A —~_ 1250-0080 N 54001A
18198C | 1250-1454 | |~
[Ijl |
15409R  o5p-poso
DATA 18108C J 1250-1454
| [IJI
15409A

Figure 3-32 Equipment Setup - Timing Channel Pre-adjustment

I.  Program 8180A/B Standard Set: (Pages > Store/Recall > Rcl Std Set > Execute)

2. Frequency 600 KHz, All Channel Format RZ=50%: (Pages > Timing > Frequency > 600 > Kilohertz

> Exit > Chnl Timing > All Ch Format > RZ=50%)

3. Strobe Level TTL; Label A Level TTL: (Pages > Output > Strobe Level > TTL > Exit > Level > Next

Label[to Label A] > TTL Levels > Execute)

4. Outputs On: (Pages > Output > Outp on/off > On)

5.  All Data set: (high) (Pages > Data > Edit > Clear&Set > Set Data > Execute)

6. Strobe Output Clock: (Pages > Control > Strobe Output > Clock)
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10.

11.
12.

13.

14.

Timing Board 08180-66505 (8180A); 08180-66565 (8180B)

Connect equipment as shown in the measurement set up and press RUN,
Program All Channel Delay 990ns: (Pages > Timing > Chnl Timing > All Ch Delay > 990 > Nanosec)

Program scope to: (Autoscale > Chan 1 > Chan 1 Display to off > Display > Split Screen to off >
Timebase > Sec/Div > Ins > Delay > 990ns)

Connect in turn all Timing Channels to scope input no. 2 and adjust each positive going transition
to 990ns with these pots:

A5 (A65) R105 (Channel 0-0 or 1-0)
AS (A65) R305 (Channel 0-1 or [-1)
A5 (A65) R505 (Channel 0-2 or 1-2)
A5 (A65) R705 (Channel 0-3 or 1-3)

Set §180A/B All Channel Delay to 90ns: (90 > Nanosec)
Set scope Delay to 90ns: (Timebase > Delay > 90ns)

Connect in turn all Timing Channels to scope input no. 2 and store each positive going transition
into Memory | of the scope: (More > Wfmsave > Memory | to on > Store to Memory 1)

Change the tap connection on the A8 (A68) DL6 Delay Line on the Address Control 2 Board A8
(A638), so that the deviation of most of the timing channels is closest to 90ns.
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Timing Board 08180-66505 (8180A); 08180-66565 (8180B)

EHEHBLHEHEHEH B all&g m L m m
SHEHRELH L EL R [~] | B S m 3z sii8 88 ZHBIHBNZ
== o | O
14 r=—">

COMPONENT SIDE 8818@;86585

Figure 3-33. A65 Timing Board
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Timing Board 08180-66505 (8180A); 08180-66565 (8180B)
Delay and Width Adjustment

Equipment:

Scope HP 54100D
Active pods HP 54001 A
50 Ohm Feedthrough HP 10100C
BNC adapter female/female 1250-0080
BNC scope probe adapter 1250-1454
Adjustment cover 08180-04103
Data cable set HP 15423A
Strobe/Clock cable set HP 15422A

NOTE

Final adjustment must be done with an adjustment cover in place.
Close adjustment holes with tape and remove tape only when
adjusting. Allow instrument to warm up for 30 minutes. Refer to
notes 4 and 5 in Chapter 1.

Measurement setup:

5410@0
 8180A/B
STROBE 12
Gl T
- 15422R
15423A ~_ 1250~0080 N 54001A
18100C l 1250-1454 | I~
[I]l
15985R  5sp-amsa
LATA 18102C l 1250-1454
[Ijl
15429A

Figure 3-34. Timing Channel - Delay and Width Adj
Delay Adjustment
1.  Program 8180A/B Standard Set: (Pages > Store/Recall > Rcl Std Set > Execute)

2. Frequency 600 Kilohertz; All Channel Format RZ=50%: (Pages > Timing > Frequency > 600 >
Kilohertz > Exit > Chnl Timing > All Ch Format > RZ=50%)

3.  Strobe Level TTL; Label A Level TTL: (Pages > Output > Strobe Level > TTL > Exit > Level > Next
Label[to Label A]> TTL Levels > Execute)

4.  Outputs On: (Pages > Output > Outp on/off > On)
5. All Data Set (to high): (Pages > Data > Edit > Clear&Set > Set Data > Execute)

6.  Strobe Output Clock: (Pages > Control > Strobe Qutput > Clock)
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10.

L1
12.

13.

14.

Timing Board 08180-66505 (8180A); 08180-66565 (8180B)
All Channel Delay 0 ns: (Pages > Timing > Chnl Timing > All Ch Delay > 0 > Nanosec)

Connect equipment as shown in the measurement set up and press RUN.

Set scope to: (Autoscale > Chan 1 > Chan | Display to off > Display > Split Screen to off >
Timebase > Sec/Div > 500ps)

Connect in turn all Timing Channels to scope input no. 2 and adjust to 0 ns delay between Strobe
and Data with the following pots:

A5 (A65) R104 (Channel 0-0 or 1-0)
A5 (A65) R304 (Channel 0-1 or 1-1)
A5 (A65) R504 (Channel 0-2 or 1-2)
A5 (A65) R704 (Channel 0-3 or 1-3)

Recheck zero delay adjustment for all channels and readjust if necessary.
Set scope Timebase Delay to 89.0ns: (Timebase > Delay > 89.0ns)

Set 8180A/B All Channel Delay to 899ns. Connect in turn all Timing Channels to scope input no. 2
and adjust the positive going transition to 89.0ns with the following pots:

A5 (A65) R101 (Channel 0-0 or 1-0)
A5 (A65) R301 (Channel 0-1 or 1-1)
A5 (A65) R501 (Channel 0-2 or 1-2)
A5 (A65) R701 (Channel 0-3 or 1-3)

Set 8180A/B All Channel Delay to 90.0ns. Connect in turn all Timing Channels to scope input no. 2
and adjust the positive going transition to 89.1ns with the following pots:

A5 (A65) R105 (Channel 0-0 or 1-0)
A5 (A65) R305 (Channel 0-1 or 1-1)
A5 (A65) R505 (Channel 0-2 or 1-2)
A5 (A65) R705 (Channel 0-3 or 1-3)

Revision 1.0, Dec. 1987
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Timing Board 08180-66505 (8180A); 08180-66565 (8180B)

Set 8180A/B All Channel Delay to 989ns. Connect in turn all Timing Channels to scope lnput no.
and adjust the positive going transition to 979.Ins with the following pots:

A5 (A65) R103 (Channel 0-0 or 1-0)
A5 (A65) R303 (Channel 0-1 or 1-1)
A5 (A65) R503 (Channel 0-2 or 1-2)
A5 (A65) R703 (Channel 0-3 or 1-3).

DAL Lo e, DAL e ) R OGN TP
!
|
|
s i
-s.“.""\"- 4
SN e = [OOLC mvoits/aly Of¢fsex = 1.a7¢ Jaakn
Timebase = 1.0 nseu/div Delayv = 79,100 nme.
Derca T = D79 400 e
BT = ULl i3 A v = 9790000 v
Figure 3-35. Delay Setting
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Timing Board 08180-66505 (8180A); 08180-66565 (8180B)

Width Adjustment

16.

17.

18.

Set 8§180A/B to All Channel Format RZ, All Channel Delay O ns, All Channel Width 10ns: (Pages >
Timing > Chnl Timing > All Ch Format > RZ > Exit > All Ch Delay > 0.0 > Nanosec > All Ch
Width 10 > Nanosec)

Recheck zero delay between Strobe channel and Timing channel.

Set scope to: (Timebase > Sec/Div > 500ps > Delay > Ons )

~-& . B0 nae:. C.OCe0e =eu . Be0 nsec

e

1

— ]

-—_“:‘...,—T‘:._____.-'-—-’

Lth., 1 = S0C.0 mvoits/aliv QFfset = 1.240 volts
Lth. < = S0C.C mvolits/div Offzgg = 1.%10  voits
fimebase = 50¢ orec/aiv Deiay = C.C0Ce sec
Deita 7T = Q79.1CC n=en
Teanig = GLICREE e SENTe = Q79,100 n=mew

Figure 3-36 Zero Delay - Strobe/Timing Channel
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Timing Board 08180-66505 (8180A); 08180-66565 (8180B)

19.  Set scope Timebase Delay to 10ns (Timebase > Delay > 10ns)

20. Connect in turn all Timing Channels to scope input no. 2 and adjust the negative going transition

(50% point) to 10.0ns with the following pots:

AS (A65) R204 (Channel 0-0 or 1-0)
A5 (A65) R404 (Channel 0-1 or 1-1)
A5 (A65) R604 (Channel 0-2 or 1-2)
A5 (A65) R804 (Channel 0-3 or 1-3)

VARSI e PO VU0 mioe IS Ve
.
i A
e
—
\\\
\\
™
.,
'\\\-
e,
—
E—

95 TS = SO0 mvosta/aly (AL = 1.%490 ot
Timehuavre = P00 pseuv/div Devay = 1000 nre.
Deicy T = 79,100 nneu
Nranit = [ A LI TLle = Q79 il L

Figure 3-37. Width Adj 1
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Timing Board 08180-66505 (8180A); 08180-66565 (8180B)

21. Set 8180A/B All Channel Width to 99.9ns: (99.9 > Nanosec)
22. Set scope Timebase Delay to 98.9ns: (Timebase > Delay > 98.9ns)

23. Connect in turn all Timing Channels to scope input no. 2 and adjust the negative going transition to
98.9ns with the following pots:

A5 (A65) R201 (Channel 0-0 or 1-0)
A5 (A65) R401 (Channel 0-1 or 1-1)
A5 (A65) R601 (Channel 0-2 or 1-2)
A5 (A65) R801 (Channel 0-3 or 1-3)

Qe . A0 nmen 9t At nse. Lol AUl ey

S B
|

Lth. « = SCGC.C mvoats/alv Offsec = 1i.74¢  voite

Mineliase = 00 pnew/dlv BDeliay = 98, a¢( noec

Deity T = 979, 100 n=e

Teane s CLOOUTT e oot = A79. 1l sl

Figure 3-38 Width Adj 2
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Timing Board 08180-66505 (8180A); 08180-66565 (8180B)

Set 8180A/B All Channel Width to 100ns and adjust the negative going transition to 99.0ns with the
following pots:

A5 (A65) R205 (Channel 0-0 or 1-0)
A5 (A65) R405 (Channel 0-1 or I-1)
A5 (A65) R605 (Channel 0-2 or 1-2)
A5 (A65) R805 (Channel 0-3 or 1-3)

SToISIVAN 15 3900 @ 101.5¢ gl
- - 1
{ N i
l '
- i
— L kS ~ V
- !
. 1
- + t
—_ ; S o
} i
i !
. 1
- - 1
! i
T )
- 1
- S H
i i

r
i
|
i
|
i

(SRR JE S S

|
1
i
i
i
i
i
!
i
|
i i
i i
H i
i !
H i
: |
P
: i
i i
| |
i

ch. < = S50C. ¢ mvolts/div gffset = 1.260 voits
Timebuse = 500 pueu/div Delay = % 00 nuew
Deata | 36

Hoanrn = R Rl = Q79100 e

Figure 3-39. Width Adj 3
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Timing Board 08180-66505 (8180A); 08180-66565 (8180B)

25. Set 8180A/B All Channel Width to 999ns.

26. Set scope Timebase Delay to 989ns: (Timebase > Delay > 989ns)

27. Adjust the negative going transition to 989 ns with the following pots:

A5 (A65) R203 (Channel 0-0 or 1-0)
A5 (A65) R403 (Channel 0-1 or 1-1)
A5 (A65) R603 (Channel 0-2 or 1-2)
A5 (A65) R803 (Channel 0-3 or 1-3)

879.000 nsec

989. 000 nsec

989.000 nsec

kN

|
1
1
!
1
! S SNSRI SIS .
§ T e —————— U "
1
1
1
!
1
1
1
1
1
1
1
I
1
1
1
T
1
i
1
1
1
!
1

Ch. & = S500.0 mvolts/div
Timebase = 2.00 nsec/div
Delta T = 979. 100 nsec
Start = 0.CC000 sec

Offset
Delay

Stop

Figure 3-40 Width Adj 4
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Timing Board 08180-66505 (8180A); 08180-66565 (81808B)

o o 1

"3y A+ i

oy RN TACE OO TERRE .

COMPONENT SIDE ©£8188-66565

Figure 3-41. Timing Board
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Sync Board 08180-66504 (8180A); 08180-66564 (8180B)

3-9 Sync Board 08180-66504 (8180A); 08180-66564 (8180B)

External Run Amplifier Adjustment

Equipment:

Pulse Generator
BNC to BNC cable

Scope 54100D
Active Pods 54001A
DVM 3456A

L.

Program 8180A/B Input Threshold 0V ; Impedance 50 Ohm RUN input On: (Pages > Control >
Inputs > Threshold > 0.Volt > Exit > Impedance > 50 Ohm »> Exit > Break Input > On[pos. slope] >
Exit > RUN Input > On[pos slope]

Set pulse generator to 10 s squarewave and 2 Volt amplitude into 50 Ohm symmetrical about 0
Volt. Transition Time < 5 ns

Connect DVM to A4 (A64) TP1 and GND TP and adjust A4 (A64) R15 for -15mV +/-2mV
Connect pulse generator to the §180A/B EXTERNAL RUN, GATED INPUT.

Connect scope probe to A4 (A64) TPl and GND TP and adjust A4 (A64) C3 for best pulse
response. :

Clock Output Amplifier High/Low Level Adjustment

Equipment:

Digital Voltmeter HP 3456A
BNC adapter 15409A
BNC (f) dual banana plug 1251-2277
Clock/Strobe cable set 15422A

High Level Adjustment

1.
2.

4.

5.

Program 8180A Standard Set: (Pages > Store/Recall > Rcl Std Set > Execute)

Clock 1 Complement; Clock 2 Complement: (Pages > Output > Clock Output > Clock 1 Polar >
Complement > Exit > Clock 2 Polar > Complement)

Label A High Level OV; Low Level -2V: (Pages > Output > Level > Next Label [to Label A] > Low
<- > High [to High Level] > 0 > Volt > Low <- > High [to Low Level] > -2 > Volt)

Outputs On (Status Stop): (Pages > Output > Output On/Off > On)

Connect clock channel to be adjusted Adjust A4 (A64) A60 R2 for 0V £0.5mV DVM reading.

Low Level Adjustment

6.

Clock 1 Normal; Clock 2 Normal: (Pages > Output > Clock Output > Clock I Polar > Normal > Exit
> Clock 2 Polar > Normal)

Label A High Level +2V; Low Level 0V: (Pages > Output > Level > Low <-> High [to High] > 2 > V
> Low <-> High [to Low] > 0 > Volt)
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8.

Sync Board 08180-66504 (8180A); 08180-66564 (8180B) o

Adjust A4 (A64) A60 RI for OV +/-0.5mV DVM reading.

1

RN
INPUT
@.ﬂ
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COMPONENT SIDE ©8180-66564

Figure 3-42. A64 Sync Board
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Sync Board 08180-66504 (8180A); 08180-66564 (8180B)

Flatness and Overshoot Adjustment

Equipment:

Scope HP 54100D
Active pods HP 54001 A
BNC adapter HP 15409A
Strobe/Clock cable set HP 15422A

[
2.

Program 8180A/B Standard Set: (Pages > Store/Recall > Rcl Std Set > Execute)

Label A TTL Levels; Strobe Level to TTL: (Pages > Output > Level > Next Label [to Label A] >
TTL Levels > Execute > Exit > Strobe Level > TTL)

Frequency 250 Hertz: (Pages > Timing > Frequency > 250 > Hertz)
Strobe Output Clock: (Pages > Control > Strobe Output > Clock)

Clock 1 Format RZ=50%; Clock 2 Format RZ=50%: (Pages > Timing > Clock Timing > Clock 1
Format > RZ=50% > Exit > Clock 2 Format > RZ=50%)

Outputs On: (Pages > Output > Output on/off > on)
Connect Strobe Output to scope input no. 1 and clock channel to be measured to scope channel 2.

Set 54100D to Autoscale and Timebase to 500 Us: (Autoscale > Timebase > Sec/Div > 500 >
microsec)

Adjust A4 (A64) A60 R4 and A4 (A64) A60 R6 for best flatness.
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Sync Board 08180-66504 (8180A); 08180-66564 (8180B)

10.  Connect 50 Ohm feedthrough to currently connected clock output and adjust A4 (A64) A60 R5 for

best flatness.

-2 S0 ww (SISO SL ISR 2.ECC0C e
Lh. o2 = 500.¢ mvoitalaly Of faer = 4LJi0 vuite
Timebase = 900 us/ulv Deiay = QL0000 =

Figure 3-43. Sync Board O/p Amp Flatness Adj
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Sync Board 08180-66504 (8180A); 08180-66564 (8180B)

Overshoot Adjustment Sync Board Output Amplifier 8180A
I1.  Set 8180A Frequency to 10MHz (Pages > Timing > Frequency > 10 > Megahertz)
]’?

2. Label A ECL Levels (Pages > Output > Level > ECL Level > Execute)

13. Connect clock channel to be adjusted to the scope input no. 2 (trigger to the 8180A strobe output-
> scope channel no. 1) and adjust A4 A60 R3 for <9% overshoot.

“cL il s -1.£16 no $.790 n=

................... B A T

P

peamags g

e e -

== = S = e RS SSURUPIUNS -~ [PV O ANV OUUCSS SR ORI SU U U SV I - .

WL = 2000wzt /ULy QFf Fapt = =i L84 voies
Tinebare 2 1L 00 nafuLy Deiay = -1..210 s
LA IaL - Aa i = ~1.7%6  Yu.b YuanNers = B2, awvoite Deity ¢ = Q04,0 o iEs

Figure 3-44 Sync Board O/P Amp Overshoot
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Sync Board 08180-66504 (8180A); 08180-66564 (8180B)

14, Check rise and fall time for typical 1.5ns measured from the 20% to 80% of amplitude.

. i “4. el 1 /90
1 .
t
! )
y
| '
? B
! v — B S RPN MU SO —
! X
e B i S B e E R e e D S
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'
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JEOSE EN AU I _/_._ [ 5 U
1
A ! s
ST ]
| )
l i
! '
1
! 1
[P0 I = 200.0 mvcits/alv OFf fagt = -1.£84 vait=
rimebuse = 1.C0 ns/div Deiay = -1.10 s
Seart = ~-1.80C ns Stop = =600 pe Deita T = 1.20C n3
Yoarkeri = -1.955 voits Voarkers = ~-1.012 voits Deita Vv = 542.4 mvoits

Figure 3-45 Sync Board O/P Amp Rise Time
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Sync Board 08180-66504 (8180A); 08180-66564 (8180B)

44 .68( ns 49 . 8C ns 54.08C ns

PO VUG U B USSR

Lh. & =  23C.¢ nwvwoits/uiv OFffagt = ~-1.264 volts
rimebase = 1.00 ns/dgiv Delay = 49.030¢ ns
Srart =  48.96C ns Stop = 50.220 ns Deita T = 1.s60 ns
Vmarkeri = -1.%855% voits Vvmarker2 = -1.012 voits Oeity Vv = 542.4 mvolts

Figure 3-46 Sync Board O/P Amp Fall Time

Overshoot Adjustment Sync Board Output Amplifier 81808

15. Set 8180B Frequency to 10MHz (Pages > Timing > Frequency > 10 > Megahertz)
16. Label A ECL Levels: (Pages > Output > Level > ECL Level > Execute)

17. Connect a 50 Ohm feedthrough to the connected clock cable.

18. Connect the clock channel to be adjusted to the scope input no. 2 (Trigger to the 8180B strobe
output- > scope input no. 1), and adjust A64 A60 R3 for <5% overshoot.

Transition Time Adjustment

19. Adjust rise time to 1.5ns with A64 A60 C27 (measured between the 20% and 80% point of
transition).
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* Address Control 2 Board 08180-66508 (8180A); 08180-66568 (8180B)

3-10 Address Control 2 Board 08180-66508 (8180A); 08180-66568 (8180B)

Clock Channels Pre-adjustment

Equipment:
Scope 54100D
Active Pods 54001 A
Adjustment Cover 08180-04103
Strobe/Clock cable set 15422A
BNC Adapter 15409A
50 Ohm Feedthrough 10100C
BNC Adapter female/female 1250-0781
BNC Scope probe Adapter 1250-1454
Measurement setup:
8180A/B 54 100D
15422A 12
[ofol
1250-8781
STROBE ‘CD m
| L\
15463A 1250-1454
18108C
0 ]
CLK1 OR |
CLK2 15409A l 1250-1454
1258-8781

Fig 3-47. Clock Channels - Pre-ad justment

1. Cancel out the scope trigger delay of scope channel 1 and the interchannel delay between scope
channel 1 and scope channel 2.

Program 8180A/B Standard Set: (Pages > Store/Recall > Rcl Std Set > Execute)

3-58

Frequency 600 kHz, Clock 1 Format RZ = 50%; Clock 2 Format RZ = 50%: (Pages > Timing >
Frequency > 600 > Kilohertz > Exit > Clock Timing > Clock Format > RZ=50% > Exit > Clock 2
Format > RZ = 50%)

Strobe Level TTL; Label A Level TTL: (Pages > Output > Strobe Level > TTL > Exit > Level > Next
Label [to label > TTL Levels > Execute)

Outputs On: (Pages > Output > Output on/off > On)
Strobe Output to Clock and press RUN: (Pages > Control > Strobe Output > Clock > RUN)
Connect Strobe channel to scope input no. 1 and Clock 1 channel to scope input no. 2.

Program Clock 1 Delay and Clock 2 Delay to 990ns: (Pages > Timing > Clock Timing > Clock 1
Delay > 990 > Nanosec > Exit > Clock 2 Delay > 990 > Nanosec)
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10.

11,

12.
13.

14.

15.

16.

Revision 1.0, Dec. 1987

Address Control 2 Board 08180-66508 (8180A); 08180-66568 (8180B)

Set scope to: (Autoscale > Display > Split Screen to Off > Channel | > Channel 1 to Off > Delta t >
T Markers to On > Start Marker to 0 ns > Stop Marker to 990ns > Timebase > Sec/Div > 5 n Delay
> 990 ns)

Adjust A4 (A64) R101 so that the 50% point of the positive going transition of Clock | meets the
center graticule line.

Adjust A4 (A64) R105 so that the 50% point of the positive going transition of Clock 2 meets the
center graticule line.

Set 8180A/B Clock 1 and Clock 2 Delay to 90 ns (Exit > Clock 1 Delay > 90 > Nanosec > Exit >
Clock 2 Delay > 90 > Nanosec)

Set scope to (Timebase > Delay > 90ns > Delta t > Stop Marker > 90ns)
Measure and note the time deviation (+/-) of clock 1 to 90ns.

Adjustment for the 8180A: Change the tap of delay line A8 DL4 so that the deviation of the 50%
point of the positive going transition is a minimum.

Adjustment for the 8180B: Adjust A8 (A68) DL4 so that the 50% point of the positive going
transition of clock 1 meets the center graticule line.

Measure and note the time deviation (+/-) of clock 2 to 90ns.

Adjustment for the 8180A: Change the tap of delay line A8 DL5 so that the deviation of the 50%
point of the positive going transition is a minimum.

Adjustment for the 8180B: Adjust A8 (A68) DL5 so that the 50% point of the positive going
transition of clock 2 meets the center graticule line.
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Sync Board 08180-66504 (8180A); 08180-66564 (8180B)

3-11 Sync Board 08180-66504 (8180A); 08180-66564 (8180B)

Delay and Width Adjustment

Equipment:

Adjustment cover:

Strobe/Clock cable set 15422 A
BNC adapter 15409A
50 Ohm feedthrough 10100C
BNC adapter female/female 1250-0080
BNC scope probe adapter 1250-1454

NOTE

08180-04103 (8180A/B)

On the 8180A, final adjustment must be done with the adjustment
cover in place. Block adjustment holes with tape and remove tape
only when adjusting. Allow instrument to warm up for 30

minutes.

On the 8180B, final adjustment must be done with the adjustment
cover in place. Block the circular hole during adjustment. Allow
instrument to warm up for 30 minutes.

Before starting the measurements, cancel out the following delays:

® The trigger delay of scope channel I:

(More > Cal&Test > Cal Menu > Trigger Delay channel 1 > Knob)
e The interchannel delay between scope channel | and channel 2:
(Trigger Delay Chan 1 > Chan to Chan Skew > Knob)

8180A/B

STROBE

15422R

Figure 3-48. Measurement Setup - Clk Delay and Width

L=<

15403A

1

CLK1 OR CLK2
SR S

15409A

541080

12

1250-00809
18186C

| 1250-1454

N
\

a10eC

1250-0080

i 1250-1454

1.  Program 8180A/B Standard Set: (Pages > Store/Recall > Rcl Std Set > Execute)

Frequency 600kHz: (Pages > Timing > Frequency > 600 > Kilohertz)

3. Strobe Level TTL; Label A TTL: (Pages > Output > Strobe Level > TTL > Exit > Level > Next

Label[to Label > TTL Levels > Execute)
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10.

1L

12.

13.

Sync Board 08180-66504 (8180A); 08180-66564 (8180B)
Outputs On: (Pages > Output > Qutput on/off > on)

Clock 1 Format RZ 50%; Clock 2 Format RZ 50%: (Pages > Timing > Clock Timing > Clock 1
Format > RZ=50% > Exit > Clock 2 Format > RZ=50%)

Strobe output Clock: (Pages > Control > Strobe output > Clock)

Clock 1 Delay Ons; Clock 2 Delay Ons: (Pages > Timing > Clock Timing > Clock 1 Delay > 0 >
Nanosec. > Exit > Clock 2 Delay > 0 > Nanosec)

Connect equipment as shown in the measurement set up and press RUN,

Connect Strobe to scope input no.l and Clock 1 to scope input No. 2.
Set the 54100D to: (Autoscale).

Switch Chan 2 off; Split Screen off; Timebase to 500ps; Trigger on positive slope: (Chan 2 > Chan 2
Display > off > Timebase > Sec/Div > 500 > psec > Trigger > Slope > positive)

Check if the 50% point of the displayed Strobe transition is centered on the center graticule line.
Set Start marker to 50% point of transition: (Delta T > T markers > On > Start marker > Knob)

Switch Channel 1 Off and Channel 2 On: (Chan 1 > Chan | Display > Off > Chan 2 > Chan 2
Display > On)
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Zero Delay Adjustment

14.
center graticule line.

Adjust A4 (A64) R100 (Clock 1) so that the 50% point of the displayed Clock | transition meets the

Adjust A4 (A64) R104 (Clock 2) so that the 50% point of the displayed Clock 2 transition meets the

center graticule line.

<. B0l ns CLUUC =.50(C
‘//-‘
/r
,/”//
—

Lh. < = B500.C wvoltc/alv Offsec =
Timebase = 500 bp</div Beiav =
Start = 0.0C0C00 3 Stp =  C.C0000 s Deits 1 =

Figure 3-49. Zero Delav
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[5. Connect Clock 1 to scope.

16.  Set scope Delay to 89ns: (Timebase > Delay > 8§9ns)

17. Set Clock 1 Delay to 89.9 nsec and adjust A4 (A64) R93 to 89.0 nsec.
18. Set Clock 1 Delay to 90.0 nsec and adjust A4 (A64) R101 to 89.1 nsec.
19. Set Clock 1 Delay to 989 nsec.

20. Set scope Timebase Delay to 979.1 nsec: (Timebase > Delay > 979.Insec)

21. Adjust A4 (A64) R92 so that the 50% point of the displayed Clock 1 transition meets the center
graticule line,

976.000C ns 973.10C ns Q1,600 n=

=

Lh, < = B5CC.C mvolits/div Offset = 1,220 voit
rinebace = 500 pn/ulv Deiay = QA79.i0C ns
Trart = 0.000CC = <top = C.00000 - Deita T = 0.C00CC =

Figure 3-50 Clk Delay
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22. Connect Clock 2 to scope channel 2 and program Clock 2 Delay: (Exit > Clock 2 Delay)

23. Set Clock 2 Delay to 899 nsec and adjust A4 (A64) R97 to 89 nsec. Set Clock 2 Delay to 90.0 nsec
and adjust A4 (A64) R105 to 89.1 nsec. Set Clock 2 Delay to 989 nsec and adjust A4 (A64) R96 to
979.1 nsec.

Width Adjustment Clock 1
24. Connect Strobe to scope channel no.l and connect Clock 1 to scope channel 2.

25. Set 8180A/B Clock | Format to RZ and Clock 2 Format to RZ: (Pages > Timing > Clock Timing >
Clock 1 Format > RZ > Exit > Clock 2 Format > RZ)

26. Set Clock | Delay and Clock 2 Delay to 0.00 ns: (Clock I Delay > 0 > Nanosec > Exit > Clock 2
Delay > 0 > Nanosec)

27. Set Clock 1 Width and Clock 2 Width to 10ns: (Exit > Clock | Width > 10 > Nanosec > Exit >
Clock 2 Width > 10 > Nanosec)

28. Set 54100D Timebase to 500ps/DIV and Timebase Delay to 10ns: (Timebase > SEC/DIV > 500ps >
Delay > 10ns)

29. Adjust A4 (A64) R102 so that the 50% point of the negative going transition of Clock 1 meets the
center graticule line.

30. Set Clock 1 Width to 999ns and set scope Timebase Delay to 989ns. Adjust A4 (A64) R94 so that
the 50% point of the displayed transition meets the center graticule line.

31. Set Clock | Width to 100ns and set Stop marker to 99.0ns. Adjust A4 (A64) R103 so that the 50%
point of the displayed transition meets the Stop marker.

32. Set Clock 1 Width to 999ns and set scope Timebase Delay to 989ns. Adjust A4 (A64) R95 so that
the 50% point of the displayed transition meets the center graticule line.

Width Adjustment Clock 2
33. Connect Clock 2 to scope channel 2.

34. Set 54100D Timebase to 500ps/DIV and Timebase Delay to 10ns: (Timebase > SEC/DIV > 500ps >
Delay > 10ns)

35. Adjust A4 (A64) R106 so that the 50% point of the negative going transition of Clock 2 meets the
center graticule line.

36. Set Clock 2 Width to 999ns and set scope Timebase Delay to 989ns. Adjust A4 (A64) R98 so that
the 50% point of the displayed transition meets the center graticule line.

37. Set Clock 2 Width to 100ns and set Stop marker to 99.0ns. Adjust A4 (A64) R107 so that the 50%
point of the displayed transition meets the Stop marker.

38. Set Clock 2 Width to 999ns and set scope Timebase Delay to 989ns. Adjust A4 (A64) R99 so that
the 50% point of the displayed transition meets the center graticule line.
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Figure 3-51. Sync Board
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3-12 Adjustments to be made after Board Replacement

The following table gives the adjustments that need to be carried out whenever any of the §180A/B
boards listed are replaced.

3-66

Table 3-1. Board Replacement - Adjustments Required

Board Exchange Check and Adj. Cover
(Version) Part no. Adjustment required
A1 (M) 08180-69501 None No
A61 (B) 08180- 69561 None No
A2 (M) 08180-69502 Restart Circuit function No

Output Amplifier High/Low Levels (A6) No
D-A Converter No
A62 (B) 08180-69562 Output Amplifier High/Low Levels (A6) No
D-A Converter No
A3 (A) 08180-69503 Internal Clock Generator Yes
D-A Converter No
Ext. Clock Amp. Thres. & Pulse Resp. No
Frequency Error Notification Yes
Strobe Reference Delay Yes
A63 (B) 08180-69563 Internal Clock Generator Yes
D-A Converter No
Ext. Clock Amp. Thres. & Pulse Resp. No
Frequency Error Notification Yes
Strobe Reference Delay Yes
Zero Pelay Clock 1, Clock 2 No
A4 (A) 08180- 69504 Ext. RUN Amp. Thres. & Pulse Response No
Clock 1 & 2 Output Amplifier No
Clock 1 & 2 Delay and Width Yes
Clock Channels Pre-adjustment No
Overshoot Clock 1 & 2 Output No
A6L (B) 08180-69564 Ext. RUN Amp. Thres. & Pulse Response No
Clock 1 & 2 Output Amplifier No
Clock 1 & 2 Delay and Width Yes
Clock Channels Pre-adjustment No
Overshoot Clock 1 & 2 Output No
Transition Time No
A5 (A) 08180-69505 Output Amplifier Timing Delay & Width Yes
Timing Channels Pre-adjustment No
A65 (B) 08180-69565 Output Amplifier Timing Delay & Width Yes
Timing Channels Pre-adjustment No
A6 (A 08180-69506 | Output Amplifier DC Levels Yes
Output Amplifier Overshoot No
A66 (B) 08180- 69566 Output Amplifier DC Levels Yes
Output Amplifier Overshoot No
Output Amplifier Transition Time No
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3-13 Locating Components in the 8180A Data Generator

The following diagrams should be used when locating components/test-points in the HP 8180A Data
Generator.
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Adjustment Procedure 8181A/B

Chapter 4
8181A/B Adjustment Procedures

4-1 Introduction

This chapter deals with the adjustment procedures that need to be performed on the HP 8181 A and HP
8181B generator extenders.

When doing a major adjustment of the instrument, it is recommended that the adjustments are carried
out in the order given.

NOTE

When performing power supply adjustment please refer to
Chapter 3, section 3-2.
When performing Output Amplifier Adjustment please refer to
Chapter 3, section 3-8.

NOTE

When adjusting the 8181A, section 4-3 PHI 2 Adjustment must be
carried out before performing section 4-2 Extender Delay
Adjustment,

4-2 Extender Delay Adjustment

Equipment:

Scope

54100D Active pods HP 54001 A

Data Cable Set HP 15423A
Strobe/Clock Cable Set HP 15422A

BNC adapter HP 15409A

BNC scope probe adapter 1250-1454

BNC adapter female/female 1250-0080

50 Ohm feedthrough HP 10100C

Adjustment cover 08180-04103
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- Adjustment Procedure 8181A/B

NOTE

Before making any adjustments on the 8181 A/B make sure that-
adjustments on the 8180A/B have completed. Allow instruments
to warm up for 30 minutes.

Measurement setup:

8181A/B
54100D
8180A.H 1
12
STROBE
15422R
1250-0080
19100C i 1250-1454
e { 1%:
154098 1 55p-gose
DATA 15423A ) 19100C | 1250-1454
h l C
154@3A

Figure 4-1. Equipment Setup - Delay Adjustment
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Adjustment Procedure 8181A/B
Program 8180A/B Standard Set: (Pages > Store/Recall > Rcl Std Set > Execute)

2. Label A TTL Levels: (Pages > Output > Level > Next Label[to Label A]> TTL Level > Execute)

3. Strobe Level TTL: (Pages > Outout > Strobe Level > TTL)

4, Frequency 600 KHz: (Pages > Timing > Frequency > 600 > Kilohertz)

5. First Address 0; Last Address 1: (Pages > Control > Last Address > | > Enter Number)

6.  Strobe Output to Data: (Pages > Control > Strobe Output > Data)

7.  FAD Data and Strobe High; LAD Data and Strobe Low: (Pages > Data > 1 > F . .. [until all extender
Data is set] > Cursor [to Strobe Addr. 1]> 0. .. [for Strobe and Data channels])

8. Connect equipment as shown in the measurement set up and press RUN.

Preadjustment

9.  Program extender delay to 990ns: (Pages > Timing > Extender 1[2] > 990 > Nanosec)

10. Set scope to: (Autoscale > Chan 1 > Chan 1 Display to Off > Display > Split Screen to Off >
Timebase > Sec/Div > 500ps > Delay > 990ns)

I11l. Adjust the positive going transition to 990ns with A8 R41.

12.  Program extender delay to 90ns: (90 > Nanosec)

13. Set scope Timebase Delay to 90ns: (Timebase > Delay > 90ns)

14. Measure the time difference between the 50% point of the positive going transition and the center

graticule line. Carry out the following steps:
a) move tap on A8 DL3 (in | ns steps) so that the delay deviation is closest to 90ns (only
for 8181A)
b) adjust A8 DL3 to 90 ns (only for 8§181B).

Final Adjustment

15.

4-4

Set Extender Set scope Adjust Set positive
Delay to Timebase Delay to transition to
0.0 ns 0 ns A8 R42 , 0.0 ns
899 ns : 89.0 ns A8 R43 89.0 ns
90.0 ns 89.1 ns A8 R4l 89.1 ns
989 ns 980 ns A8 R44 980 ns
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Transition adjusted for 980 ns.

. e

i AN — . pt g,
b s

volts

S S X
977.50@ nsec 980.000 nsec 982 .508 nsec
Ch. 2 = 503.0 mvolts/div Offset = 1.330
Timebase = 500 psec/div Delay = 980.0200 nsec

Revision 1.0, Dec. 1987

Figure 4-3. Extender Delay Adjustment
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4-3 Multiplexer Board 08181-66501 (8181A)

PHI 2 Adjustment

Equipment:

Scope 54100D

Active pods 54001 A

1.  Connect channel A probe to Al U4 pin 18 and channel B probe to testpoint PHI 2.

2. Set scope to: (Autoscale > Timebase > Sec/DIV > 50ns > Trigger > Trigger Mode to State Trigger On
Negative Edge; On Chan 2; When Pattern H - X X)

3. Set Start Marker to Ons; Stop Marker to 40ns: (Delta t > T Markers to On > Start Marker > Ons >
Stop Marker > 40ns >

4. Adjust with Al R4 so that the trailing edge of the PHI 2 signal is 40ns ahead of the trailing edge of

the tristate ramp as shown below.

NOTE

There is no PHI 2 adjustment on the §181B Multiplexer Board.

i i
SV S [TRG
T “-‘W—'—-“_—,‘-{af.b\d.'_.‘ e
e i i S
1 - .“/,';'
]
.............. I
b \
I
1
[}
]
1
|
-\\«.:_'_.' "\ T Jﬁﬁ"ﬂ_. B ]
,
TP 00 reee 060600 sac 583000 nsec
Ch. 1 = 2.000 wvolts/div Offset = 1.680 wvolts
Ch. 2 = 2.000 volts/div Offset = 1.680 wvolts
Timebase = 5.0 nsec/div Delay = 0.200000 sec
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Adjustment Procedure 8181A/B
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8181A Board Layouts

4-4 Locating Components in the 8181A Extender

The following diagrams are component/testpoint locators for the §181 A Data Extender.

4-8 Revision 1.0, Dec. 1987



8181A Board Layouts

'
30ls  LIABID
3015 LN3INOJWO)

' ' ' ' .
Z ) XM ANL S5 dNWINXHIIZIAIE Y
Q22 OCBL gL ALG SLMEL a6 8 LIS TEL L

an
.
L]
DO
€
Tanasas

0 . '
3015 L10OU1D AN I S ¥4 dNHINTH
3QIS LN3NOJWOD BLLL SN EBA WO 6 8

: B
QI IR < g S <k z@“
ol el B 0ol B

® o e

1
M N9 195 U oM ze A5+ ONO
- J—I—J._r ° e o o o [ e o

0

Al MULTIPLEXER - BOARD  08181-66501

Figure 4-6. A1 Multiplexer Board

Revision 1.0, Dec. 1987



8181A Board Layouts

m
h3
[ 4

L |
b @‘Dﬁ :
- r::::::ﬂ g i o

R R G einE|

'|1'

.....

MJ

il vl il

S > S

: L :
D . o ]
PR [e) D |~ o«
H i x &
Wematn oun 5
: V J : > =
; : > =
PR : =1 "
: ; o
H : - v 2
s < Y 1 R
H 2 ] - v “ W

H i T 2 oo

: :
:@ : "1
! 1 | - 2
: 1
W omn S5
Z : - ~
° ' 1
ag ! L)
10 H QD CD » | O\
le > : A TN -l o
* : -— < -
— &
S o u
@ [e) K G
- E] 1

g

v o8

R @@Q@\ -
R aaam@aa!

A2 INTERFACE BOARD 08180 — 66502

Figure 4-7. A2 Interface Board

Revision 1.0, Dec. 1987



8181A Board Layouts

o
-
o
z
4
Fj
o

A6 MODULE B0ARD 08180-66506

Figure 4-8. A6 Module Board

Revision 1.0, Dec. 1987

-

© >

Ao
@

UIIIIIIIIIIIIIIIlII




s 8181A Board Layouts
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Display Control Board 08182-66530 (8182A/B)

Chapter 5
8182A/B Adjustment Procedures

5-1 Introduction
This chapter covers the adjustment procedures necessary for the HP 8182A and HP 8182B analyzers.

When performing a major adjustment of the instrument, it is recommended that the adjustments are
carried out in the order given,

5-2 Display Control Board 08182-66530 (8182A/B)
Display Adjustment

If the display has to be completely adjusted (after a CRT change), set A34R3 (on Motherboard)
clockwise and all other potentiometers to mid range. Position the deflection yoke nearest to the screen
and fasten it lightly.

1.  Remove A32J4 (Vertical Deflection Board) and turn the instrument on.
2. If necessary, slightly increase intensity with A32R37.

3.  Using the two ring magnets on the deflection yoke, position the dot approximately 3 mm (1/8 in)
above the centre of the screen.

4. Turn the instrument off, reconnect A32 J4, turn it back on and press Al (A61) S2.

5. Select the test pattern: (Pages > Miscellaneous > Right upper blank softkey > enter 8182 from the
Data keys > Disp Adjust).

6. Adjust A32R21 (Freq.) for a stable display.

7. Center the test pattern with A34R! (Hor. Pos) and adjust A34L2 (Hor. Lin) for maximum
horizontal deflection.

8.  Adjust A34R3 (Hor. Sync) so that no intensified lines appear.

9.  Adjust A34L4 (Hor. Amp.) for approximately 12.5 cm (5 in) horizontal deflection.

10. Re-adjust A34L2 for best horizontal linearity.

11. Re-center the test pattern with A34R1 and repeat steps 8 to 10.

12.  Adjust A32R27 (Vert. Amp.) for approximately 9 cm (3 1/2 in) vertical deflection.

13. Adjust A32R22 (Vert. Lin.) for best vertical linearity.

14, Re-adjust and fasten the deflection yoke and repeat steps 2 to 13, if necessary.

15. Correct any ’pin cushion’ distortion by adding small correction magnets to the deflection yoke.
Intensity and Focus Adjustment

16. Press Al (A61) S2 and select Brightness on the Miscellaneous Page: (Pages > Miscellaneous >
Brightness > Increase [until maximum brightness is obtained]).
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Display Con‘tfol Board 08182-66530 (8182A/B)
17. Adjust A32R37 (Intens.) until the line flyback is no longer visible.

18. Adjust A32R36 tor the best possible focusing.

19. Secure the ring magnets, deflection yoke and correction magnets with silicon compound,
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Display Control Board 08182-66530 (8182A/B)
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Display Control Board 08182-66530 (8182A/B)

L4

O | HR.LIN.

A34 HIGH VOLTAGE BOARD COMPONENT SIDE ©8188-66534

Figure 5-2 A34 High Voltage Board

Revision 1.0, Dec. 1987



Display Control Board 08182-66530 (8182A/B)

ZAXMAGLS Y INWIXLHIIAIEY 1305 LUSAID AN LSY¥Y¥JINUEITXNIHIIAOEY $3CIS 1IMONID
2212250912130 »0 302011208 3 £ 35 v 220 XI5 LIS LR 181 8 21 trat s 3 2235 v 2 20 PFIS LNRCSCO

STOOOODO0ONO0TNONIn. STOO000NO00000N0In,

gy 2iLd
[esessessa Fessessisg 3 o.m ) :a
-

3660060060

3003000 onoooonoooa_onoouuonno _cuoooooo_ Q00003040
250 n“ Svn a asn b 1 ey d erey a0 ¢ §5695655] [F9ss9559] aooo:ooo o X5}
! = : n o = 1, [Fe3 lo 0D
l0000000) (33 (00008000000 0000000aas)isiascccsas] (90aaasss]lossssaas st Groyj S G Siar
2000c000jleliooscoccaan]
566660500 SGecaess] [e66aseq] oooooo:onu
Py . - 0000000000]|000GA0000 0000000000
STETeTeTeEEEETEEEEEE ¢n en g s € s: ¢ o [ %, [ w
| lesscoaoe 00000000 0000000 0000000000 f 2 i ° °
- 22000000a0){0000000000](000000004a0 2L
[Tal c X0} X
5 e : /
los00000] |09000000000sa000000s! (5] J
e o
ol
o
3
»2n o_

_eooooonam

3800065 009]

d o= 204 EfdL

§

X2
Leresrsossssn £y
&

¥oa | 8 s nw s .
" lococoaos ° ] £y o
99 Eescesesso (cessssss o
x R I
o o [o o 06600600060306006000663] [0
o o o ol CRE) o e [ o [ 9 X X
o n_ o o o o o ol o o o o
o S al lo o o o o o_ o o o o 0d00 in
ol.~ o S o o o o ol o _ o o of N o o] e ol 6 o
fo "ol o T o o C of o C o oCol joCao (s o o o o o o
BTy k8 sSy [Sy [gd pss & O O B
Ze i a c c o c

o .o lo Al o~ o lorol JoUal fo o o € o o € of s S

o o o o o o_ ~o of s o o W o o © o o & of

o~ o o o o o o o o o o o o o o ol
6 o o - o o . o o _ of o . o o o@_; of o o
o L el
oo [0 o o{Tate 3w
oSel o o [Feeesss oo:ooﬂ_o::o._ o o [ 9 [o
o 2o fo_ ol o0L=) ] G o o o [0 o |o
oa._ _omo & omulr e I 4_ s 4 ER B I I R I a9
e o o3 o o~z 2900a00fleasoccoso]lescccse o o ol logal o °
o~ of o o & o = o p3 ol oMol o

o o Lo 2 o S lo ™ol o~ o lo 4E
241fea) o of AS* OND ©000000000%000000000 lo o o fo o o
5 = ° o . s oo lo oo lso9 [o

=

-
w
w -
&o

e

Figure 5-3. A61 Microprocessor Board
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Microprocesor Board 08182-66501 (8182A)
5-3 Microprocessor Board 08182-66501 (8182A)

Restart Circuit Adjustment

Equipment:
Oscilloscope with probes HP 54100D
Digital Voltmeter, testleads HP 3456A

1. Connect the DVM to VPower Down TP and GND TP.

2. Connect the oscilloscope probe to RES TP and GND TP.

3. A'djust Al R133 for a 48V reading on the DVM. This simulates a decreasing supply voltage.
4. Adjust Al R117 slowly until the RES signal toggles from high to low.

5.  Recheck 4.8V and readjust -Al R133 and Al R117 if necessary.

6. Turn Al R133 fully clockwise and then slowly counter-clockwise until the RES signal toggles.
7.  If the signal does not toggle at 4.8V 1£0.002V repeat steps 3 to 6.

8. Turn Al R133 back clockwise to get the normal supply voltage (< 5V) at the VPower Down TP.
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GEM Interface Board 08182-66502 (81 82A) 08182-66562 (81 823)
5-4 GEM Interface Board 08182-66502 (8182A) 08182-66562 (8182B)

Digital-Analog Converter Adjustment

Equipment:

Digital Voltmeter, testleads HP3456A

1. Program 8182A/B Standard Set: (Pages > Miscellaneous > Recall > Standard Set > Execute)

2. Label A +10V: (Pages > Input > Threshold > 10 > Volt)

3.  Connect DVM to A5 (A65) TP22 and the nearest GND TP on one of the A5 (A65) Data Boards.
4.  Adjust A2 (A62) R115 for -5.000V.

5.  Program Label A -10V: (-10 > Volt).

6. Adjust A2 (A62) RI111 for +5.000V.

7.  Recheck the voltage at A5 (A65) TP22 with threshold Label A programmed to +10V, OV and -10V
in turn. The voltages should be -5V £3mV, 0V £3mV, and +5V 1£3mV respectively. Repeat steps 2
to 6 if necessary.

Internal Clock Generator Adjustment

Equipment:

Oscilloscope HP54100A

1.  Program Clock Source Internal: (Pages > Control > Clock > Clock Source > Internal)

2. Connect the scope probe to A2 (A62) TP14 and GND TP and adjust A2 (A62) Ci24 for the
cleanest waveform.
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GEM Interface Board 08182-66502 (8182A) 08182-66562 (8182B)
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Figure 5-5. A62 Interface Board
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~ Address Board 08182-66503 (8182A) 08182-66563 (8182B)

5-5 Address Board 08182-66503 (8182A) 08182-66563 (8182B)

External Trigger Arm Amplifier Adjustment

Equipment:

Scope 54100D

Active Pods ’ 54001A

Pulse Generator (Risetime <2.5 ns)
50 Ohm Feedthrough 10100C

BNC Cable

BNC Tee Connector 1250-0781

BNC scope probe Adapter 1250-1454
Extender Board 08180-66552

Measurement setup:

TO TP1 AND GND
A3 ON
EXTENDER 18180aC PULSE GENER —
8182A/B OUTPUT .
Iolof 1

S
1454
BNC CABLE ,——I l— 1290-143

TO EXT.ARM '—I—
INPUT - 25p-a781

Figure 5- 6. External Trigger Arm Amp Adjustment

Frequency Response Adjustment

L.
2.

6.

Program 8182A/B Standard Set: (Pages > Miscellaneous > Recall > Standard Set > Execute)

Set Pulse Generator to 50 KHz (20microsec) squarewave and 2.5V amplitude (2.5V into 50 Ohm,
min rise and fall time, offset off).

Connect equipment as shown in measurement set up.

Connect scope to TP1 and ground TP without using a ground lead (remove insulating sleeve from
the probe).

Set scope to: (Autoscale > Chan 1 > Chan 1 Display to Off > Display > Split screen t Off > Chan 2
> Volt/DIV > 100 mV)

Adjust A3 (A63) Cl1 for best pulse response.

Trigger Arm Amplifier Offset Adjustment

7.
8.

5-10

Disconnect equipment from the §182A/B and terminate Trigger Arm Input with 50 Ohm.

Program 8182A/B Trigger Arm Pos Slope; Threshold 0.0V: (Pages > Control > Trigger > Trg Arm >
Slope > Pos Slope > Exit > Threshold > 0 > Volt)

Connect scope probe to TP3 and adjust A3 (A63) RI until the signal toggles.

Revision 1.0, Dec. 1987



Address Board 08182-66503 (8182A) 08182-66563 (8182B)
5-6 Address Board 08182-66503 (8182A) 08182-66563 (8182B)

External Stop Amplifier Adjustment

Equipment:

Scope 54100D

Active Pods 54001A

Pulse Generator (Risetime <2.5 ns)
50 Ohm Feedthrough 10100C

BNC Cable

BNC Tee Connector 1250-0781

BNC scope probe Adapter 1250-1454
Extender Board 08180-66552

Measurement setup:

TO TP2 AND GND
A3 ON
EXTENDER e 241000
STEsE s 12100C ULSE GENER.

OUTPUT 12

Sl
BNC CABLE r—J-—

L
TO EXT.STOP
INPUT

_1258-1454

1250-0781

Figure 5-7. External Stop Amp Adjustment

Frequency Response Adjustment

1.
2.

5.

Program 8182A/B Standard Set: (Pages > Miscellaneous > Recall > Standard Set > Execute)

Set Pulse Generator to 50 kHz (20 s) squarewave and 2.5V amplitude (2.5 V into 500, min. rise and
fall time, offset to off).

Connect equipment as shown in the measurement setup.

Set scope to: (Autoscale > Chan 1| > Chan | Display to Off > Display > Split screen to Off > Chan 2
> 2 Volt/DIV > 100 mV)

Adjust A3 (A63) C2 for best pulse response.

External Stop Amplifier Offset Adjustment

A

8.

Revision 1.0, Dec. 1987

Disconnect equipment from the 8182A/B and terminate Stop Input with 50 ().

Program 8182A/B Stop Pos. Slope; Threshold 0.0V: (PAGES > Control > Stop > Stop Slope > Pos.
Slope > Exit > Stop Thres. > 0 > Volt )

Connect scope probe to TP4 and adjust A3 (A63) R2 until the signal toggles.
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Address Board 08182-66503 (8182A) 08182-66563 (8182B)
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Figure 5-8. A63 Address Board
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Control Board 08182-66504 (8182A) 08182-66564 (8182B)
5-7 Control Board 08182-66504 (8182A) 08182-66564 (8182B)

Trigger Qualifier Adjustment

Equipment:

Scope 54100D

Active Pods . 54001A

Pulse Generator (Risetime €2.5 ns)
50 Ohm Feedthrough 10100C

BNC Cable

BNC Tee Connector 1250-0781

BNC scope probe Adapter 1250-1454

Measurement setup:

A4 TP1D
ML 1@108C PULSE GENER —_—
~ “ - . NP ]
8162A B S INPUTS
IOIOI I
BNC CABLE l_ 1454
TO TRIGGER-— 12987145

QUAL IN L———-I

1250-0781

Figure 5-9. Trigger Qualifier Adjustment
Frequency Response Adjustment
1. Program 8182A/B Standard Set: (Pages > Miscellaneous > Recall > Standard Set > Execute)

2. Set Pulse Generator to 50 KHz (20microsec) squarewave and 2.5V amplitude (2.5V into 50 Ohm,
min rise and falltime, offset off).

3. Connect equipment as shown in the measurement set up.

4.  Connect scope to TP10 and ground TP without using a ground lead (remove insulating sleeve from
the probe).

5.  Set scope to: (Autoscale > Chan 1 > Chan 1 Display to Off > Display > Split screen t Off > Chan 2
> Volt/DIV > 100 mYV)

6. Adjust A4 (A64) C203 for best pulse response.
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Control Board 08182-66504 (8182A) 08182-66564 (8182B) -

-25.0000 us 0.000C0 s 25.0000 us

Ch. 1 100.0 mvolts/div Offset -380.0 mvolts

Won

Bon

Timebase 5.00 us/div : Delay 0.00000 s

Figure 5-10. Trigger Qualifier - Scope Diplay
Trigger Qualifier Offset Adjustment
7. Disconnect equipment from the 8182A/B and terminate trigger qualifier input with 50 Ohm.

8. Program 8182A/B Trigger Qualifier High Level; Threshold 0.0V: (Pages > Control > Trigger > Trg
Qualifier > Level > High Level > Exit > Threshold > 0 > Volt)

9.  Connect scope probe to TP11 and adjust A4 (A64) R215 until the signal toggles.

Control Output Adjustment

Equipment:

Digital Voltmeter, testleads HP 3456A

1. Program 8182A/B Standard Set: (Pages > Miscellémeous > Recall > Standard Set > Execute)

2. Connect DVM to A4 (A64) TP14 and next ground TP and adjust A4 (A64) R316 for 0V £0.05V.
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Control Board 08182-66504 (8182A) 08182-66564 (8182B)
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Clock Board 08182-66506 (8182A/B)
5-8 Clock Board 08182-66506 (8182A) 08182-66566 (8182B)

Clock Output Amplifier Offset Adjustment

Equipment:

Digital Voltmeter, testleads HP3456A
BNC cable

BNC(f) dual banana plug 1251-2277 -

1. Program 8182A/B Standard Set: (Pages > Miscellaneous > Recall > Standard Set > Execute)

2. Connect DVM to the Clock Qut connector (rear panel) and adjust A6 R616 for 0V +0.05V.
(Clock input remains open.)

Timing IC Supply Voltage Adjustment

Equipment:

Digital Voltmeter, testleads HP3456A

1. Connect DVM to TP5 and TP6 (GND) and adjust A6 R474 to -5.2V +0.05V.

Clock Amplifier Adjustment

Equipment:

Pulse Generator (fmin=10Hz, fmax=10Mhz, tr<3ns)
Scope HP 54100D

Active Pods HP 54001

Extender Board (8182A) 08180-66552

Extender Board (8182B)

BNC Adapter HP 15409A

50 Ohm Feedthrough HP 10100C

Clock Probe HP 15406A

Measurement setup:

AS _ON PROBE TO TP2,TP3

EXTENDER | €———

8182A/B 54 108D

PULSE GENERATOR
o ouTPUT
12190C
I L I
154@6A 15409A

Figure 5-12. Clock Amplifier Adjustment
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Clock Board 08182-66506 (8182A/B)

Low Frequency Response Adjustment

L.

2.

5.
6.

Program 8182A/B Standard Set: (Pages > Miscellaneous > Recall > Standard Set > Execute)
Set Pulse Generator to: 10Hz, Squarewave, LOL=0V, HIL=2,5V, 2,5V into 50 Ohm.
Connect equipment as shown in the measurement set up.

Connect scope probe to TP2 and TP3 (GND). Do not use a ground lead. Remove insulating sleeve
from probe.

 Set scope to: (Autoscale).

Adjust A6 R341 for best pulse response (square).

High Frequency Response Adjustment

7.
8.

10.

Set Pulse Generator to: 10MHz, Squarewave, LOL=0V, HIL=2,5V, 2,5V into 50 Ohm, transition <3ns.

Connect scope probe to TP2 and TP3 (GND). Do not use a ground lead. Remove insulating sleeve
from the probe. ‘

Set scope to: (Autoscale > Timebase > Sec Div > 2ns)

Adjust A6 C360 for best pulse response.
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Clock Board 08182-66506 (8182A/B)

Clock Amplifier Offset Adjustment

Equipment:

Pulse Generator

Scope HP 54100D
Active Pods HP 54001A
BNC Tee connector 1250-0781
BNC Adapter(female/female) 1250-0080
BNC scope probe Adapter 1250-1454
50 Ohm Feedthrough HP 10100C
BNC Cable

BNC Adapter HP 15409A
Clock Cable HP 15406A

Measurement setup:

1250-1454
8182A/B | 541000

PULSE GENERARTOR
TRIG OUT OUTPUT
o °

1234
jololo]

CLOCK oUT BNC CARBLE
1250-1454
~N

1258-0781

BNC CABLE

™~
18108C

1250-0080

T 1
15406A 154@3A
Figure 5-13. Clock Amplifier Offset Adjustment

1.  Set Pulse Generator to:

Period Ims

Pulse Width 0.5ms

Amplitude 200mYV symmetrically to 0V
Transition Time SUs to 250 Us

2. Adjust leading edge and trailing edge for a triangular waveform. Using the offset vernier, set the
signal to be symmetrical about the center graticule line.

3.  Program 8182A/B to Standard Set: (Pages > Miscellaneous > Recall > Standard Set > Execute Pages
> Control > Operatg Mode > Trg Start Comp > Execute)

4.  Set Sampling Clock Slope to Both Slopes; Clock Threshold 0.00V: (Pages > Control > Clock > Clock
Slope > Both Slps > Exit > Clock Thresh 0V > Exit > Clock Width > 50 Microsec)

5. Connect equipment as shown in measurement set up.
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Clock Board 08182-66506 (8182A/B)

0.  Set scope to: (Autoscale > Chan 2 > Chan 2 Display Off > Display > Split Screen Off > Trigger >
Trigger Src > to Trig 3)

7. Check if generator signal is symmetrical about the center graticule line. Set the Start Marker to the
crossover point / positive going transition and the Stop Marker to the crossover point / negative
going transition and perform Delta t measurement: (Delta t > Tmarkers on > Start Marker > Knob >
Stop Marker > Knob)

~-1.00000 ms 0.00000 s 1.00000 ms

I
1
;
|
'
|
]
!
!
:
0.
0.

Ch. 2 = 4100.0 mvolts/div Of fset = 000 volts
Timebase = 200 us/div Delay = 00000 s
Start = 232.000 us Stop = 740.000 us Delta T = 308.000 us
Vmarker1 = -104.0 mvolts Vmarker2 = 106.0 mvolts Delta V = 210.0 mvoits

Figure 5-14. Clock Amp Offset Adjustment - Scope Display |

8. Switch channel | off and channel 2 on: (Chan | > Chan | Display to oft > Chan 2 > Chan 2
Display to on)

9. Adjust A6 R353 until measured time difference between the positive going edges of the displayed
pulses shows the value measured in point 7.
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Clock Board 08182-66506 (8182A/B)

~-1.00000 ms 0.00000 s 1.00000 ms

! '

! '

I v

r F" ‘F |

;

i

t

;

\

1

!

_ [

! !

3 1

T [

! !

! H
Ch. 2 = 4.000 volts/div Offset = 2.400 volts
Timebase = 200 us/div Delay = 0.00000 s
Start =  264.C00 us Stop = 772.000 us Delta T = 508.000 us

Figure 5-15. Clock Amp Offset Adjustment - Scope Display 2
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Clock Board 08182-66506 (8182A/B)

Clock Qualifier Adjustment

Equipment:

Pulse Generator (Risetime <2.5 ns)
Scope HP54100D
Active Pods HP54001 A

50 Ohm Feedthrough HP10100C

BNC cable

Measurement setup:

A6 TP1
+TP4
8182A/B 54 1@aD
PULSE GENERATOR
OUTPUT 12
18188C O Gl
BNC CABLE

TO CLOCK QUALIFIER INPUT

Figure 5-16. Clock Qualifier Adjustment
Frequency Response Adjustment
1.  Program 8182A/B Standard Set: (Pages > Miscellaneous > Recall > Standard Set > Execute)

2. Set Pulse Generator to 50 kHz, (20 microsec.) squarewave and 2.5V amplitude. (2.5 V into 50 Ohm,
min. rise and fall time, offset to Off)

3. Connect equipment as shown in the measurement set up.

4.  Connect scope probe to TP1 and TP4 (GND). Do not use a ground lead. Remove insulating sleeve
from probe.

5. Adjust A6 C304 for best pulse response (square wave).

Revision 1.0, Dec. 1987 5-21



N\

Clock Boatd 08182-66506 (8182A/B)

~25.0000 us ' 0.00000 s 25.0000 us

ch. 1
Timebase

100.0 mvolts/div Offset
5.00 us/div Delay

~376.0 mvolts
0.00000 s

aou

iou

Figure 5-17. Frequency Response Adjustment - Scope Display
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Clock Board 08182-66506 (8182A/B)
Clock Qualifier Offset Adjustment

Equipment:

Pulse Generator

Scope HP 54100D
Active Pods HP 54001 A
BNC Tee connector 1250-0781
BNC scope probe adapter 1250-1454
50 Ohm Feedthrough HP 10100C
BNC cable

Clock cable HP 15406A
Grabber HP 15408A

Measurement setup:

15406A
/154@89
A6 TP9
+TP4 (GND) CLOCK 541820
8182A./B QUALIFIER PULSE GENERATOR
OUTPUT 12
[l
18100C] | 5
CLOCK 1258-1454 -
cLo 18180C
BNC CABLE
/
1250-0781 1250-1454

Figure 5-18. Clock Qualifier Offset Adjustment

1. Set Pulse Generator to:

Period Ims
Pulse Width 0.5ms
Amplitude 200mV
Offset On

Transition Time SUs to 250Us

2. Adjust Leading Edge and Trailing Edge for a triangular waveform. Using the Offset Vernier set
the triangular signal to be symmetrical about 0 Volts.

3. Program 8182A/B Standard Set: (Pages > Miscellaneous > Recall > Standard Set > Execute)

4.  Set the Operating Mode to Trigger Start Compare; Clock Source to External: Both Clock Slopes to
Active; Clock Threshold to -1.2V: (Pages > Control > Operatg Mode > Trg Strt Comp > Execute >
Exit > Clock > Clock Source External > Exit > Clock Slope > Both Slps > Exit > Clock Thres >
-1.2V)

5. Set Clock Qualifier to Don’t Care; Threshold 0V: (Clock Qual > Level > Don’t Care > Exit >
Threshold > 0.00V)
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10.

1.

Clock Board 08182-66506 (8182A/B)
Set Clock Width to 100 microsec (Exit > Exit > Clock Width > 100 > Microsec)

Connect equipment as shown in measurement set up.

Set scope to: (Autoscale > Trigger > Trig Src to Chan 2 > Chan 2 > Chan 2 Disp to Off > Display >
Split Screen to Off > Chan | > Offset > 0.00V)

-1.00000 ms 0.0C000 s 1.00000 ms

\ s s

ch. 1 = 200.0 mvolts/div Offset = -4.000 mvolts
Ch. 2 = 41.000 volts/div Offset = 1.230 volts
Timebase = 200 us/div Delay = 0.00000 s

Figure 5-19. Clock Qualifier Offset Adjustment - Scope Display 1

Set Timebase to 100 ns and display mode to average: (Timebase > Sec/Div > 100 ns > Display Mode
to Averaged > Number of Averages to 2 > Knob)

Set scope into magnify mode: (Chan 1 > Chan | Mode to Magnify > Magnify On > Volts/DIV to 20
mV using the Knob)

Adjust A6 R319 so that the dotted band on the screen is symmetrical about the center graticule
line.
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Clock Board 08182-66506 (8182A/B)

-500.000 ns 0.00000 s 500.000 ns

Yl .l, A 'N.“'JJ:.A‘ nr“..l. /| "h"m‘d Nl 'M,‘l'u“-l] U ’h_h i Tlvvh,:nl ik ‘hpl‘ W "HJI! (i, h'
Ch. 1 = 20.00 mvolts/div Offset = 0.000 volts
Timebase = 100 ns/div Delay = 0.00000 s

Revision 1.0, Dec.

Figure 5-20. Clock Qualifier Adjustment - Scope Display 2
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" Clock Board 08182-66506 (8182A/B)
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Figure 5-21. A66 Clock Board
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Clock Board 08182-66506 (8182A/B)
Fixed Delay Adjustment

Equipment:

Scope HP 54100D
Active Pods HP 54001A
Pulse Generator

Extender Board 08180-66552
BNC Tee connector 1250-0781
BNC Adapter HP 15409A
BNC scope probe Adapter 1250-1454
Delay Line 34ns 08182-61622

Measurement setup:

A6 ON EXTENDER

A6 TP13
+GND -
54 100D
8182R/B PULSE GENERATOR
OUTPUT 12
0 [olo]
1@H@ec
—1) 1
| T
15409A ?8182-61622
15406A 1250-1454

Figure 5-22. Fixed Delay Adjustment
1.  Cancel out interchannel delay and trigger delay of scope.

2. Set Pulse Generator to:

Period 1 microsec

Pulse Width 0.5 microsec
Leading Edge < 3ns

HIL 200V

LOL 0.00 V into 50 Ohm

3. Program 8182A/B Standard Set: (Pages > Miscellaneous > Recall > Standard Set > Execute)
4.  Clock Threshold 1.00V: (Pages > Control > Clock > Clock Thres > 1 > Volt)
5. Connect equipment as shown in measurement set up.

6.  Set scope to:

Channel | 200mV/DIV

Channel 2 500mV/DIV ; Offset 1V
Trigger on Channel 2; Trigger level 1V
Split Screen Off

(Autoscale > Chan 1 > Volt/DIV > 200mV > Chan 2 > Volt/DIV > 500mV > Offset > 1V > Trigger
> Trg Src to Chan 2 > Trigger Level > 1V > Display > Split Screen to Off)
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Clock Board 08182-66506 (8182A/B)

7.  Adjust Channel 1 Offset so that the base line of channel 1 meets the base line of channel 2: (Chan |
> Offset > Knob)

-10.460 ns ~460 ps 9.240 ns

N

A
SNV =a R

WM |

Ch. 1 = 200.0 mvolts/div Of fset = -1.312 volts
Ch. 2 = 500.0 mvolts/div Offcet = 970.0 mvolts
Timebase = 2.00 ns/div Delay = —460 ps

Figure 5-23. Fixed Delay Adjustment - Scope Display 1
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Clock Board 08182-66506 (8182A/B)

8. Set Timebase to 500ps: (Timebase > 500ps)

9. Adjust A6 R215 for zero delay of both signals measured at the center graticule line.
-2.960 ns -460 ps 2.040 ns
//M\\
<
/ N
k \\’/
] /
SIS cnnthiubil 1 Jf‘/
S —
th. 1 = 200.0 mvolts/div Offset = -1.292 volts
Ch. 2 = 500.0 mvolts/div Of fset = 1.000 volts
Timebase = 500 ps/div Delay = -460 ps

Figure 5-24. Fixed Delay Adjustment - Scope Display 2
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Clock Board 08182-66506 (8182A/B)
Clock Delay Adjustment

Equipment:

Scope HP 54100D
Active Pods HP 54001 A
Pulse Generator

BNC Tee Adapter 1250-078 1
50 Ohm Feedthrough HP 10100C
BNC scope probe Adapter 1250-1454
BNC Adapter HP 15409A
Clock Probe HP 15406A

Measurement setup:

8182A/B 54 100D
PULSE GENERATOR
OUTPUT 12
0 [olol ]
10100C —
-181008C
P
1250-1454
15406  15409A I Y250-1454
TO CLOCK OUTPUT 1258-0781

Figure 5-25. Clock Delay Adjustment

1. Set Pulse Generator to:

Period 100 microsec
Pulse Width 1.5 microsec
Transition Time 2 ns

HIL 25V

LOL 0.00V into 50 Ohm

2. Program 8182A/B Standard Set: (Pages > Miscellaneous > Recall > Standard Set > Execute)

3. Clock Threshold 1.2 V Clock Delay 0.00ns: (Pages > Control > Clock > Clock Thres > 1.2 > Volt >
Exit > Clock Delay > 0 > Nanosec)

4.  Connect equipment as shown in measurement set up.

5. Set scope to: (Autoscale > Trigger > Trg Sr¢c To Chan 1 > Chan 1 > Chan | Display to Off>Display>
Split Screen to Off > Chan 2 > Volt/DIV > 500mV > Offset > 1.25V Timebase > Sec/DIV > 20 ns)

6.  Set 50% point of positive going transition to center graticule line: (Delta V > V markers to Chan 2 >
Auto Top Base > 50-50% > Chan 2 > Offset> Knob)

7.  Move the pulse so that the 50% point of the positve going transition crosses the center horizontal
and vertical graticules: (Timebase > Sec/DIV > Ins > Delay > 38ns > Knob)
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Clock Board 08182-66506 (8182A/B)

8.  Set the Start Marker to 50% point of positive going transition: (Delta t > T Markers to On > Start
Marker > Knob)

32.640 ns 27.640 ns 42.640 ns

S

|

Ch. 2 = 500.0 mvolts/div Offset = 1.280 volts
Timebase = 1.00 ns/div Delay = 37.640 ns
Start = 37.640 ns Stop = 441.140 ns Deita T = 3.500 ns
vYmarkeri = 1.280 volts Vmarker2 = 1.280 volts Deits V = 0.000 volts

Figure 5-26. Clock Delay Adjustment - Scope Display 1
NOTE

The position of the start marker is used as the reference for the
delay adjustment and should therefore not be moved during the
following adjustments.

9.  Program 8182A/B Clock Delay 59 ns: (Pages > Control > > Clock > Clock Delay > 59 > Nanosec)

10. Add to the programmed delay the zero delay (position of the Start marker) and program the Stop
Marker to this value.
Example: Start marker position = 40ns, then Stop Marker = 459ns. Adjust Timebase Delay until the
Stop Marker crosses the vertical center line.

Il. Adjust A6 R213 (DI) so that the 50% point of the positive going transition crosses the center
graticules (X & Y).
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Clock Board 08182-66506 (8182A/B)

12. Repeat step 9 through to 11 with the following values:

Programmed Adjust
Clock Delay

6 ns A6 R228 (D2)
219 ns A6 R227 (D3)
22 ns A6 R266 (D4)
117 ns A6 R276 (D5)
10 ps A6 R268 (D6)

Increase Pulse Generator Period to 150 ys.

999 s A6 R277 (D7)
118 ns A6 R290 (D8)
38.540 ns 43.540 ns 48.540 ns

/

S

ch. 2 = 500.0 mvolts/div Offset = 1.280 volts
Timebase = 1.00 ns/div Delay = 43.540 ns
Start = 37.640 ns Stop = 43,540 ns Delta T = 5.900 ns
Vmarkeri = 1.280 voilts Vmarker2 = 1.280 volts Delta V = 0.000 volts

Figure 5-27. Clock Delay Adjustment - Scope Display 2

Clock Width Adjustment

Equipment:

Scope HP 54100D
Active Pods HP 54001A
Pulse Generator

Clock Probe HP 15406A
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Clock Board 08182-66506 (8182A/B)

BNC Adapter HP 15409A
50 Ohm Feedthrough HP 10100C
Scope probe Adapter 1250-1454 4

Measurement setup:

8182A/B 54 100D
PULSE GENERATOR
ouTPUT 1
Q [T}
| [—1e100C
TO CLOCK -10108C¢
OUTPUT

~N
1250-1454 —T—C1—
154068  15429A

Figure 5-28. Clock Width Adjustment

1.  Set Pulse Generator to:

Period 100 ps

Pulse Width 1.5 Us

Transition Time 2 ns

HIL 25V

LOL 0.0 V into 50 Ohm

2. Program 8182A/B Standard Set: (Pages > Miscellaneous > Recall > Standard Set > Execute)

3.  Trigger Event Start Compare: (Pages > Control > Operating Mode > Trg Strt Comp > Execute)
4.  Clock Width 10 ns: (Pages > Control > Clock > Clock Width > 10 > Nanosec)

5.  Connect equipment as shown in measurement set up.

6.  Cancel out trigger delay on scope channel 1.

7.  Set scope to: (Autoscale > Delta V > V Markers to Chan 1 > Auto Top Base > 50-50%)
Adjust displayed 50% level with Knob so that it crosses the center graticule: (Chan | > Offset >
Knob)

8. Set Start Marker to 0.00 ns and check that 50% of the positive going transition crosses the center
graticules (X & Y).
If not, check trigger delay offset: (Timebase > Sec/DIV > 1 ns > Delata t > T markers to On > Start
Marker > 0)
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Clock Board 08182-66506 (8182A/B)

NOTE

The position of the start marker is used as reference for the width
adjustment and should therefore not be moved during the
following adjustment.

~5.000Q ns 0.00000 s 5.000 ns

/

Ch. 1

= 500.0 mvolts/div Dffset = 1.250 volts
Timebase = 1.00 ns/div Delay = 0.00000 s
Start = 0.00000 s Stop = 0.00000 s Delta T = 0.00000 s
Vmarkeri = 1.255 volts Vmarker2 = 1.255 volts Delta V = 0.000 voits

Figure 5-29. Clock Width Adjustment - Scope Display 1

9.  Set Timebase Delay to 10 ns: (Timebase > Delay > 10ns)
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Clock Board 08182-66506 (8182A/B)

10. Adjust A6:R244 so that the 50% point of the negative going transition crosses the center graticules.

5.000 ns 10.000 ns i5.0¢00 ns’

N

\\ /

Ch. 1 = 500.0 mvolts/oiv Offset = 1.250 volts
Timebase = 1.00 ns/div Delay _ = 410.000 ns
Start = 0.00000 s Stop = 0.00000 s Deita i = 0.00000 S
Vmarkerit = 1.255 volts vmarkere2 = 1.<85 wvolts Deita V = 0.000 volts

Figure 5-30. Clock Width Adjustment - Scope Display 2

11. Repeat step 9 and 10 for the listed Clock Width values and perform the corresponding adjustment.

8182A/B Adjust

Clock Width
169 ns A6 R242 (W1)
17.0 ns A6 R254 (W2)
319 ns A6 R253 (W3)
320 ns A6 R272 (W4)
127 ns A6 R278 (W5)
10.0 us A6 R273 (W6)

Increase Pulse Generator Period to 150 microsec.

999 ps A6 R279 (W7)
128 ns A6 R291 (W3)

Table 5-1 summarizes the adjustments that are to be performed on the Clock Board.
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Clock Board 08182-66506 (8182A/B)
Table 5-1. Clock Board Adjustments

Adjustment Adjust Adjust for: Measured at:
Clock Out Offset R616 OV +/-0.05v Clock Out
Clock Amplifier LF R341 best pulse response TP2 TP3
Clock Amplifier HF €360 best pulse response TP2 TP3
Clock Amplifier Offset R353 (A) both traces symm.to 0V Clock Out
Clock Qual. Freq. Resp. C304 best pulse response TP1 TP4
Clock Qualifier Offset R319 Less intens. pt. symm.to OV| Clock Out
Fixed Clock Delay R215 zero delay of both signals TP13 GND
Timing IC Supply R4T74 -5.2V +/-0.05V TP5 TP6
Clock Delay R213 5.90 ns Clock Out
Clock Delay R228 6.00 ns Clock Out
Clock Delay R227 21.9 ns Clock Out
Clock Delay R266 22.0 ns Clock Out
Clock Delay R276 117 ns Clock Out
Clock Delay R268 10.0 us Clock Out
Clock Delay R277 99.9 us Clock Out
Clock Delay R290 118 ns Clock Out
Clock Width R244 10.0 ns Clock Out
Clock Width R242 16.9 ns Clock Out
Clock Width R254 17.0 ns Clock Out
Clock Width R253 31.9 ns Clock Out
Clock Width R272 32.0 ns Clock Out
Clock Width R278 127 ns Clock oOut
Clock Width R273 10.0 us Clock Qut
Clock Width R279 99.9 us Clock Out
Clock Width R291 128 ns Clock Out
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Data Board 08182-66505 (8182A) 08182-66565 (8182B)

5-9 Data Board 08182-66505 (8182A) 08182-66565 (8182B)

Input Amplifier Adjustment

Equipment:

Scope HP 54100D
Active Probe HP 54001 A
Pulse Generator

Extender Board 08180-66552
50 Ohm Feedthrough HP 10100C
BNC Adapter HP 15409A
DATA Probe HP 15407A

NOTE

(Fmin=10Hz, Fmax=10MHz;, tr<3ns)

The following procedure describes the low and high frequency
adjustment for Data Board 0 Channel 0. Adjustments for the other
boards and channels are listed in the adjustment summary.

If you wish to do adjustments for one connector at a time use
adjustment summary at the end of this section.

If you wish to do adjustments for one board at a time use
adjustment summary at the end of this section.

Measurement setup:

AS ON EXTENDER

TO TP1+GND
8182A/B 15407A TO CONNECTOR @
——Cc 1
e v I
—

DATA PROBE @

DATA GENERATOR
OUTPUT
Q

1ateac

15403A

Figure 5-32. Input Amplifier Adjustment

Low Frequency Response Adjustment

L.
2.
3.

5-38

54106D

Program 8182A/B Standard Set (Pages > Miscellaneous > Recall > Standard Set > Execute)

Set Pulse Generator to 10Hz squarewave and 2.5V amplitude into 50 Ohm

Connect equipment as shown in measurement set up.
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Data Board 08182-66505 (8182A) 08182-66565 (8182B)

4.  Connect scope probe to TP1 and GND TP without using a ground lead. (Remove insulating sleeve
from probe.)

5.  Set scope to (Autoscale > Chan 1 > Volts/Div > 100mV)

6. Adjust A5 (A65) R2 for the best pulse response.

High Frequency Response Adjustment

7.  Set Pulse Generator to 10MHz squarewa\./e and 2.5V amplitude into 50 Ohm, risetime <3ns)
8. . Connect equipment as shown in measurement set up.

9.  Connect scope probe to TPl and GND TP without using a ground lead.

10. Set scope to: (Autoscale > Chan | > Volts/Div > 100mYV)

11. Adjust A5 (A65) C1 for the best pulse response.

Data Input Amplifier Offset Adjustment

Equipment:

Scope HP 54100D
Active Pods HP 54001 A
Pulse Generator

BNC Tee Connector 1250-0781
BNC scope probe adapter 1250-1454
50 Ohm Feedthrough HP 10100C
Clock Probe HP 15406A
DATA Probe HP 15407A
Grabber HP 5408A

Measurement setup:

CLOCK PROBE
15408A 34 12aD
PULSE GENER.
A/
8182R/B OUTPUT 12
Q &E
18100C
50-1454 dj 13467R
12 2
1250-1454
15409A |
1250-0781
TO CLOCK OUT

Figure 5-33. Data Input Amplifier Offset Adjustment
1. Set Pulse Generator to:

Period I ms
Pulse Width 0.5 ms
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Data Board 08182-66505 (8182A) 08182-66565 (8182B)

Amplitude 200 mV
Offset On
Transition Time 5-250 ps

Adjust Leading Edge and Trailing Edge for a triangular waveform. Using the offset vernier, set the
triangular signal to be symmetrical about the center graticule line.

1.00C00 ms

wm

-1.00000 ms g.eeeee

/ NIV N

th. 1 = 50.00 mvolts/div Offset = 0.000 voits
Timebase = 200 us/div Delay = 0.00000 s
ymarkeri = -104.0 mvolts Vmarker2 = 102.0 mvolts Deits V = 206.0 mvolits

Figure 5-34. Data Input Amplifier Offset Adjustment - Scope Display | -
Program 8182A/B Standard Set: (Pages > Miscellaneous > Recall > Standard Set > Execute)

Clock Slope Both; Clock Threshold -1.3 V: (Pages > Control > Clock > Clock Slope > Both Slps >
Exit > Clock Thres > -1.3V)

Label A Single Threshold 0V: (Pages > Input > Threshold > 0 > Volt)
Connect equipment as shown in measurement set up.

Connect Clock Probe to A5 (A65) TPS.
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10.

Data Board 08182-66505 (8182A) 08182-66565 (8182B)

Set scope to: (Autoscale > Trigger > Trigger source to Chan 2 > Chan 2 > Chan 2 Display to Off >
Display > Split Screen to Off > Number of Averages to 2 > Timebase > 100ns > Chan | > Chan |
Mode to Magnify > Magnify to On > Volts/Div > 10mV

Adjust A5 (A65) R1 until the displayed band of dots is symmetrical to the center graticule iine.

Adjustments for all other data channels are listed in the Adjustment Summary.

=500, 000 ns 0.C0CC0 s 500.000 ns

Ch, 1 = 40.00 mvolts/div Cffset = 0.000 volts
Timebase = 100 ns/div Delay = 0.00000 s

Figure 5-35 Data Input Amplifier Offset Adjustment - Scope Display 2

Dual Threshold Adjustment

Equipment:

BNC Adapter (15409A) with 50 Ohm Feedthrough (10100C)
Solder in receptacles wired to short probe inputs
15407 Data Probe Assembly

L.
2.

Program 8182A/B Standard Set: (Pages > Miscellaneous > Recall > Standard Set > Execute)

Clock Source Internal; Clock Period Ims: (Pages > Control > Clock > Clock Source > Internal > Exit
> Clock Period > Fast Increase [Ims])

Auto Arming Delay 0s: (Pages > Control > Autoarming > Delay 0s)

Stop Delay 40: (Pages > Control > Stop > Stop Delay > 40 > Enter Number)
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8.
9.

N /

Data Board 08182-66505 (8182A) 08182-66565 (8182B)
Glitch Detect On: (Pages > Control > Glitch Detect > On)

Lower Level -0.10V; Upper Level 0.00V: (for Label A) (Pages > Input > Threshold > Sing/upp/low
[to lower] > 0.1 > Volt > Sing/upp/low [to upper] > 0 > Volt)

Dual Threshold for all available connectors: (Pages > Input > Connector > 0 and 1 > Dual Thres >
Execute > Exit > [2 and 3] > Dual Threshold > Execute > Exit)

Timing Diagram: (Pages > Timing Diagr)

Press RUN.

Adjustment Channels 0 to 3 Connector 0

10.
I

12,

13.
14.

15.

5-42

Connect 15407A Data Probe Assembly to Connector 0.

Terminate probe of channel to be adjusted (0) with 50 Ohm or short all probe inputs by using
wired 15426A solder in receptacles.

Adjust A5 (A65) R9 for channel 0 on Data Board 0 until the timing display for Connector 0
Channel 0 toggles and maximum glitches are displayed.

Adjust R10 for channel | connector 0 on Data Board 0.
Adjust R9 for channel 2 connector 0 on Data Board 1.
Adjust R10 for channel 3 connector 0 on Data Board 1.

Adjustments for all channels are listed in the Adjustment Summary at the end of this section.

NOTE

When adjusting data channels on connector 6, move the Timing
Diagrams Page display upwards until the required channel is
displayed. With Timing Diagram selected press: (Select Displ >
Vert Window).

Revision 1.0, Dec. 1987



Data Board 08182-66505 (8182A) 08182-66565 (8182B)
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Figure 5-36. A65 Data Board
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Data Board 08182-66505 (8182A) 08182-66565 (8182B)
5-10 Sampling Point Adjustment

Equipment:

Pulse Generator

Delay Line 3 ns 08182-61621
BNC Adapter 15409A
BNC Adapter (female/female) 1250-0080
BNC Tee Adapter 1250-0781
Clock Probe 15406A
Data Probe 15407A
NOTE

The offset adjustment for line drivers A65 U108, A65 U208, A65
U308 and A65 U408 on the Data Board 08182-66565 can only be
performed at the factory. Therefore never try to adjust A65 R11,
A65 R12, A65 R13 and A65 R14.

Measurement setup:

TA P
8182R/B Rt
__{ PULSE GENERATOR
|5489A OUTPUT
P Q
SBO0HM
DELAY LINE
3ns
e8182-6121 |
1250-0080 1250-0781
CLOCK PROBE 15406R

T

154@39A

JAR)

Figure 5-37. Sampling Point Adjustment

1. Set Pulse generator to:

~ Period 1 Us
Pulse Width 0.5 ps
Leading Edge <3 ns
Trailing Edge <3 ns
HIL 2V
LOL 0 V into 50 Ohm

2. Program 8182A/B Standard Set: (Pages > Miscellaneous > Recall > Standard Set > Execute)
3. Clock Threshold to +1 V: (Pages > Control > Clock > Clock Thres > 1 > Volt)

4.  Label A Single Threshold to +1 V: ((Pages > Input > Threshold > Sing/Upp/Low[to Single Thres] > 1
> Volt)
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10.

11

12.

13.
14.

15.

16.
17.

Data Board 08182-66505 (8182A) 08182-66565 (8182B)
Stop Delay to 40: (Pages > Control > Stop > Stop Delay > 40 > Enter Number)

Autoarming Delay 0s: (Pages > Control > Autoarming > Delay 0s)

Select Timing Diagrams: (Pages > Timing Diagram > Select Displ > Vert Window > <- or -> [until
the required channel is displayed])

Using a mixed display, set Clock Delay to 3 ns: (Softkeys > Control > Clock > Clock Delay > 3 >
Nanosec) ‘

Connect equipment as shown in measurement set up and press RUN,

Using the Increment Softkey check first for a toggling action from low to high and note reading.
If the signal does not toggle between 2 ns and 4 ns, perform Sampling Point Pre-adjustment.

Program Clock Slope Neg and select the Clock Delay softkey again: (Exit > Clock > Clock Slope >
Neg Slope > Exit > Clock Delay)

Vary clock delay between 1 ns and 5 ns by pressing decrement and increment softkeys and note the
delay when signal toggles from high to low.

Calculate delta between delay noted in step 10 (Clock Pos) and delay noted in step 12 (Clock Neg).

With negative Clock Slope selected set Clock Delay to 3 ns plus half of the delta delay calculated
in step 13.

Example:

With Clock Slope Pos, signal switches from low to high at 1.8 ns. With Clock slope Neg, signal
switches from high to low at 2.4 ns, Delta is 600 ps. Set Clock Delay to 3 ns plus 300ps = 3.3 ns.

Adjust A5 (A65) C5 until the signal toggles from high to low.
Reselect Clock Slope Pos: (Exit > Clock Slope > Pos Slope > Exit > Clock Delay)

Check that signal toggles between 2 ns and 4 ns. If signal does not toggle repeat the procedure
from step 10.

NOTE

If the sampling point specifications cannot be reached by adjusting
C5 it might be necessary to readjust the internal clock delay on the
A6 clock board or to change the taps of delay line DLI07 to
DL407 on the Data Board.

Sampling Point Pre-adjustment (DL107, DL207, DL.307 and DL407)

1.

First check the sampling point of channels on the boards that have not been exchanged. If these
channels are not in specifications refer to A6 Fixed Delay Adjustment.

If the other channels meet specifications, delayline DL107 [DL207, DL307, DL407] on the Data
Board must be pre-adjusted.

Use the test set up and equipment settings as described under sampling point adjustment with the
addition of a scope (54100D).

Trigger the scope with the pulse generator and connect the channel 1 probe to TP 5 on the DATA
Board 0 (connector 0, channel 0)
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Data Board 08182-66505 (8182A) 08182-66565 (8182B)
Adjust A5 (A65) C5 for minimum delay as observed on scope.

Increment the clock delay from 0 ns onwards in 0.1 ns steps until the timing signal toggles, and note
the delay difference to 3 ns.

7. The time difference between 3 ns and the noted delay setting is the required change in the setting
of delayline DL107. Delay between two taps of the delay line is | ns; the delay range of A5 (A65)

C5 is 0-1 ns.

Examples:

1. Minimum clock delay setting where the timing display can be forced to toggle is 1.3 ns.
Time difference between 1.3 ns and 3 ns is 1.7 ns
Required action: Add 1 ns delay (1 tap) at DL107 and adjust A5 (A65) C5 to 0.7 ns.

2. Minimum clock delay setting where the timing display can be forced to toggle is 5.3 ns.
Time difference between 53 ns and 3 ns is 2.3 ns. '
A5 (A65).
Required action: Advance data by 3 ns (- 3 taps) at DL107 and adjust C5 to +0.7 ns.

5-46 . Revision 1.0, Dec. 1987



Data Board 08182-66505 (8182A) 08182-66565 (8182B)

Table 5-2. 8182A/B Adjustments necessary after Board Change/Repair

BOARD EXCH. P/N ADJUSTMENT (CHECK) PAGE
Display Display Adjustment 5-1
A1 MPU Board * 08182-69501 | Restart Circuit 5-6
A2 Interface Bd. 08182-69502 D-A Converter

Internal Clock Generator 5-8
A3 Address Bd. 08182-69503 Trigger Arm Amplifier

Freq. Response/Offset 5-10

Stop Amplifier

Freq. Response/Offset 5-11
A4 Control Board 08182-69504 Trigger Qualifier Amp.

Freq. Response/Offset 5-13

Control Outputs 5-13
A5 Data Board 08182-69506 Input Amplifier Adjustment

LF Response/HF Response/Offset 5-38

Dual Threshold 5-41

Sampling Point 5-44

Delay Line Preadjustment

(Check Fixed Delay) 5-45

Adjustments Summary 5-47
A6 Clock Board 08182-69506 | Offset of Clock Output Circuit 5-16

Timing IC Supply 5-16

Clock Amplifier

LF Response/HF Response 5-16

Clock Amp. Offset Adjustment 5-18

Clock Qual. Frequency Response | 5-21

Clock Qual. Offset Adjustment 5-23

Fixed Delay 5-27

Clock Delay 5-30

Clock Width 5-32

Adjustment Summary 5-36

(*) Version A only.
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Data Board 08182-66505 (8182A) 08182-66565 (8182B)

Table 5-3. §182A/B Data Board Adjustments Summary

CONN- |CHANNEL |DATA |LF(10Hz) |ADJ. |HF(10MHz) |ADJ. [OFFSET |DUAL THR- |[DELAY DELAY
ECTOR| PROBE |BOARD|TEST PT.| LF |TEST PT. HF |ADJUST|ES. ADJUS|LINE ADJ.
0 0 0 TP1 R2 TP1 c1 R1 R® TP6 |DL107|TP5 C5
0 1 0 TP3 R6 TP3 c3 R5 R10 TP8 |DL307|TP7 C7
0 2 1 ™1 R2 TP1 c1 R1 R9 TP6 |DL107|TP5 C5
0 3 1 TP3 R6 TP3 C3 R5 R10 TP8 |DL307|TP7 C7
1 0 0 TP2 R4 TP2 ce R3 DL207|TP6 Cé6
1 1 0 TP4 R8 TP4 C4 R7 DL407|TP8 C8
1 2 1 P2 R4 TP2 c2 R3 DL207|TP6 C6
1 3 1 TP4 R8 TP4 Cé R7 DL4O7{TP8 C8
2 0 2 TP1 R2 TP1 c1 R1 R9 TP6 |DL107|TP5 C5
2 1 2 TP3 R6 TP3 c3 R5 R10 TP8 |DL307|TP7 C7
2 2 3 TP1 R2 TP1 c1 R1 R9 TP6 |DL107|TP5 C5
2 3 3 TP3 R6 TP3 c3 RS R10 TP8 |DL307|TP7 C7
3 0 2 TP2 R4 TP2 c2 R3 DL207|TP6 C6
3 1 2 TP4 R8 TP4 Cé4 R7 DL407|TP8 C8
3 2 3 TP2 R4 TP2 c2 R3 DL207|TP6 C6
3 3 3 TP4 R8 TP4 Cé4 R7 DL407|TP8 C8
4 0 4 TP1 R2 TP1 c1 R1 R9 TP6 |DL107|TP5 C5
4 1 4 TP3 R6 TP3 c3 R5 R10 TP8 |DL307|TP7 C7
4 2 5 TP1 R2 TP1 c1 R1 R9 TP6 |DL107|TP5 C5
4 3 5 TP3 R6 TP3 c3 R5 R10 TP8 |DL307|TP7 C7
5 0 4 P2 R4 TP2 ce R3 DL207|TP6 C6
5 1 4 TP4 R8 TP4 C4 R7 DL4O7|TP8 C8
5 2 5 TP2 R4 TP2 c2 R3 DL207|TP6 C6
5 3 5 TP4 R8 TP4 C4 R7 DL4O7|{TP8 C8
6 0 6 TP R2 TP1 c1 R1 R9 TP6 |DL107|TP5 C5
6 1 6 TP3 R6 TP3 c3 R5 R10 TP8 |DL307|TP7 C7
6 2 7 TP1 R2 TP1 c1 R1 R9 TP6 |DL107|TP5 C5
6 3 7 TP3 R6 TP3 c3 R5 R10 TP8 |DL307|TP7 C7
7 0 6 TP2 R4 P2 c2 R3 DL207|TP6 C6
7 1 6 TP4 R8 TP4 C4 R7 DL4O7{TP8 C8
7 2 7 TP2 R4 TP2 ce R3 DL207|TP6 C6
7 3 7 TP4 R8 TP4 Cé4 R7 DL407|TP8 C8

Note that the testpoints in column "DELAY ADIJ." are also to be used for "OFFSET ADJUST".
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Data Board 08182-66505 (8182A) 08182-66565 (8182B)

Table 5-4. 8182A/B Data Connector Adjustments Summary

DATA |[CONNEC- |PROBE, |TEST |LF ADJUST|HF ADJUST|OFFSET| DUAL THRES- DELAY

BOARD TOR CHANNEL [POINT 10 Hz 10MHz ADJUST| HOLD ADJUST ADJUST
0 0 0 TP R2 c1 R1 R? TP6 TP5 C5
0 1 TP3 R6 c3 R5 R10 TP8 TP7 C7

1 0 TP2 R4 c2 R3 TP6 C7

1 1 TP4 R8 C4 R7 P8 C8

1 0 2 TP1 R2 c1 R1 R9 TP6 TP5 C5
0 3 TP3 R6 c3 R5 R10 TP8 TP7 C7

1 2 TP2 R4 c2 R3 TP6 C6

1 3 TP4 R8 Cé4 R7 TP8 C8

2 2 0 TP1 R2 c1 R1 R9 TP6 TP5 C5
2 1 TP3 R6 c3 R5 R10 TP8 TP7 C7

3 0 TP2 R4 c2 R3 TP6 C6

3 1 TP4 R8 Cé4 R7 TP8 C8

3 2 2 TP1 R2 c1 R1 R9 TP6 TP5 C5
3 3 TP3 R6 c3 R5 R10 TP8 TP7 C7

2 2 TP2 R4 c2 R3 TP6 C6

3 3 TP4 R8 C4 R7 TP8 C8

4 4 0 TP1 R2 C1 R1 R9 TP6 TP5 C5
5 1 TP3 R6 c3 R5 R10 TP8 TP7 C7

4 0 P2 R4 c2 R3 TP6 C6

5 1 TP&4 R8 Cé4 R7 TP8 C8

5 4 2 TP1 R2 c1 R1 R® TP6 TP5 C5
5 3 TP3 R6 c3 R5 R10 TP8 TP7 C7

4 2 P2 R& c2 R3 TP6 C6

5 3 TP4 R8 Cé4 R7 TP8 C8

6 6 0 TP1 R2 c1 R1 R TP6 TP5 C5
7 1 TP3 R6 c3 R5 R10 TP8 TP7 C7

6 0 TP2 R4 c2 R3 TP6 C6

7 1 TP4 R8 Cé4 R7 TP8 C8

7 b 2 TP1 R2 c1 R1 R9 TP6 TP5 C5
7 3 TP3 R6 C3 R5 R10 TP8 TP7 C7

6 2 TP2 R4 c2 R3 TP6 C6

7 3 TP4 R8 Cé4 R7 TP8 C8

Note that the testpoints in column "DELAY ADJ." are also to be used for "OFFSET ADJUST".

Revision 1.0, Dec. 1987
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8182A Board Layouts

5-11 Locating components in the 8182A Data Analyzer

The following diagrams should be used when locating components/testpoints in the HP 8182A Data
Generator.
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8182A Board Layouts
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Cycle Modes / Run / Stop / Break / Forward / Back Test

Chapter 6
HP 8180A/B Performance Verification

6-1 Introduction

The test procedures described in this chapter are designed to verify the published performance
specifications for the HP 8180A/B Data Generator and the HP 8§181A/B Data Generator Extender given

in Chapter 1| of this manual.
NOTE

The tested instrument must be given a 30 minute warm-up time
before starting any of the performance tests, During any perfor-
mance test, all shields, covers and connecting hardware must be in
place. The tests must be performed in the order given.

Equipment Required

The equipment necessary to perform each performance test is listed at the beginning of each test.
Alternative test equipment may be substituted for the recommended models, provided that it satisfies the
critical specifications given.

Test Record

When carrying out the performance tests, you should keep a tabulated test record, listing the test results
and the acceptable performance limits. The results recorded at incoming inspection will provide a
reference for periodic calibration, troubleshooting and after-repair testing.

6-2 Cycle Modes / Run / Stop / Break / Forward / Back Tests

For testing the different cycle modes, a low frequency (10Hz) is used in order to be able to follow the
address changes on the 8180A/B display. The external gate signal is simulated by changing the threshold
level of the RUN/GATED input. First and last address detection at maximum speed is tested separately.

I.  Program 8180A/B Standald Set

2. Clock Frequency 10 Hz

3. Last Address 100
(PAGES, BB IR s

Auto Cycle Test

4.  Press RUN and check that the 8180A/B starts with address 00000 (upper right hand corner of the
display), counts up to address 00100 and continues with address 00000.

Break; Forward; Back; Stop Test
5. Press BREAK. The 8180A/B should switch to BREAK.

6. Increment and decrement addresses by pressing FWD and BACK. Note that addresses can be
decremented down to the First Address.
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Cycle Modes / Run / Stop / Break / Forward / Back Test
7. Press RUN. The 8180A/B should start one address after the Break Address.

8.  Press STOP and RUN. The 8180A/B should start with the First Address.
Single Cycle Test

9. Program the 8180A/B to Smgle Cycle
HINCISN - CONTROL B CyCle Mode

10. Press RUN and check that the 8180A/B starts at address 00000 and stops at address 00100.

Gated Cycle Test

1L Program the f ollowmg Gated Cycle Run (Gate) Input ON Threshold +5V.

12. Set threshold voltage to -5V (-, 5, il ). The 8180A/B should run between address

00000 and 00100 as in Auto Cycle.

13. Set the threshold voltage back to +5V. The 8180A/B should complete the last cycle and stop at
address 00100.

Init+Gated Cycle Test

14. Program Imt+Gated
(PAGES, SIS

15. First Address 30.
(PAGES, && RO

16. Input Threshold +5V
(PAGES, BRI

17. Program the threshold voltage to -5V (-, 5, & G ) and check that the 8180A/B starts
with address 00000, runs up to address 00100 and continues cycling between address 00030 and
00100.

18. Set the t'hf,eshold voltage back to +5V. The 8180A/B should complete the last cycle and stop at
address 00100.

Init+Auto Cycle Test

19. Program lmt+Auto

(PAGES, N Initrauto -
20. Run Input OFF.
INEISN  CONTROL - Trputs::: - Runilnput Q. B )

21. Press RUN and check that the 8180A/B starts at address 00000, runs up to address 00100 and
continues cycling between address 00030 and 00100.

To repeat the whole sequence press STOP and RUN again.
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Last Address (Address Difference Counter) Test

6-3 Last Address (Address Difference Counter) Test

This test ensures correct programmability of the address difference counters and proper operation up to
50 MHz.

1.~ Program 8l80A/ B Standard Set.
(PAGES’ :' " HE 3 # '.. St T

2. Clock 2 Delay to Ons Clock 1 Width to 10ns.

6. Press RUN and check that the 8180A/B stops at address 00001.

7. Change Last Address to 2 (2, EMEEILEESS ) press RUN and check cycle length.

8.  Repeat Single Cycle test with the following Last Address settings:
8; 16; 32; 128; 256; 512; 1024; 2048; 4096; 8192. On the 8180A go up to 512.
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Strobe Break (Strobe Difference Counter) Test

6-4 Strobe Break (Strobe Difference Counter) Test
\

Correct programmability and proper strobe difference counter function at 50 MHz is verified with this
test. After setting the Strobe Breaks, the instrument is stepped from Break to Break.

1.  Program 8180A/B Standard Set
[ FN€I N STORE/RECALL J Rcl Std:

2. Clock 2 Delay to Ons Clock l Wldth to 10ns,

(PAGES,

8.  Using the Cursor softkey move cursor to address 00001 and set strobe bit high by pressing the 1 key
on the data entry key pad.

9.  Set strobe bits to high in following addresses as described in step 8:
I; 2; 4; 8; 16; 32; 64; 128; 256; 512; 1024; 2048; 4096; 8192. On the 8180A go up to 512.

10. Press STOP and RUN. The 8180A/B should be in BREAK at address 00000.
11. Press RUN again and the §180A/B should break at address 00001.

12. Check that the 8180A/B breaks at addresses 2; 4; 8; 16; 32; 64; 128; 256, 512, 1024, 2048, 4096, 8192
and 0 each time after pressing RUN again. On the §180A check up to 512.

6-4 Revision 1.0, Dec. 1987



Internal Clock Frequency Test

6-5 Internal Clock Frequency Test
Specification
Accuracy: £5% of programmed value.

Description

The Strobe output signal programmed as clock is used to measure the internal clock generator accuracy.
Clock timing errors flagged up on the screen with Standard Set and 50 MHz programmed have no

influence on the Strobe output.

8180A/B COUNTER

STOP INPUT

15422A 15409A
FROM STROBE OUT CD

Figure 6-1. Test Setup for the Internal Clock Frequency Test

Equipment

Universal Counter HP 5370B
Plug-on BNC Adapter HP [5409A
Clock and Strobe Cable Set HP 15422A
Procedure

1. Set counter as follows.

Trig Level: +1.2V
FUNCTION: FREQUENCY
GATE: 001s

STOP IMP: 50 Ohm

START COM switch: SEParate

2. Program 8I80A/B St'mdzud Set
(PAGES, & LU RE L

3.  Strobe Level TTL

5.  Frequency 50 MHz
(PAGES, GB35

6. Connect equipment as shown in Figure 6-1 and press RUN.
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7.

6-6

" Internal Clock Frequency Test

Check 8180A/B internal clock generator at the set frequencies as detailed in Table 6;l.

Table 6-1. Internal Clock Frequency Test Values - Tested Frequencies

Set Frequency

Min. Frequency

Max. Frequency

50.00 MHz
25.00 MHz
10.00 MHz
9.99 MHz
3.00 MHz
1.00 MHz
1.05 Hz

47.50 MHz
23.75 MHz
9.50 MHz
9.49 MHz
2.85 MHz
0.95 MHz
1.00 Hz

52.50 MHz
26.25 MHz
10.50 MHz
10.49 MHz
3.15 MHz
1.05 MHz
1.10 Hz
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Clock and Data Skew Test

6-6 Clock and Data Skew Test

Specification

Skew: € 1.6 ns for Clock and Data channels.

Description

A Square Wave pattern is used to test the Clock channels and all installed Data channels. The Strobe
clock signal is used as a reference, the maximum deviation from positive going Strobe transition should
be € 108 ns. TTL levels are used for all outputs, the test is valid also for the 8181 A/B NRZ Data

channels.
8180A/B 541000
STROBE OQUT 12
B T]
1250-0080 TN sac01A
18100C I 1258-1454 | |7
CLK1,CLK2 OR 15463A 1250-0080@
DATA 19108C I 125@-1454
15403R
Figure 6-2. Test Setup for the Clock and Data Skew Test
Equipment
Scope HP 54100D
Active Pods HP 54001 A
Scope Probe Adapter 1250-1454
BNC Adapter female/female 1250-0080
BNC Adapter HP 15409A
50 Ohm Feedthrough HP 10100C
Strobe/Clock Cable Assy HP 15422A
Data Cable HP 15423A
Procedure

1.  Program 8I8OA/B Standard Set.
(PAGES , BigFIEIE 348

2. Label A TTL, St«robe TTL, Strobe to Clock

Revision 1.0, Dec. 1987
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10.

6-8

Clock and Data Skew Test

Set Data.
(PAGES,
address with 0s])

@ [fill Data pattern at first address with I’s, and Data pattern at last

Connect the equlpment as shown in Flgure 6 2 Switch outputs ON and start the generator
(PAGES , R i
Press RUN.

Cancel out interchannel delay between scope channel 1 and scope channel 2.

Set scope as follows:

(Autoscale > Display > Split Screen to OFF > [>Trigger >TRG Mode [to Time-Dly} > After [Neg
Edge] > On [Chan 2] > Delay [40 ns] > Then > Trig On [Pos] Edge > On [Ch 1]} > Timebase > Sec/Div
> 500ps > More > Wfmsave > Memory 1 to ON > Clear Memory | > Store to Memory 1).

Connect in turn all Clock and Data channels to scope input 2 and store each displayed transition to
Memory 1.

Set Start Marker to the 50% point of the displayed strobe transition and measure with the Stop
Marker the maximum * deviation of the stored channel transitions (Delta t > T Markers to ON >
Start Marker > Knob > Stop Marker > Knob)

The maximum deviation should be € 0.8 ns. (B-version); < *1ns (A-version).
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Clock 1, Clock 2 Delay Test

6-7 Clock 1, Clock 2 Delay Test
Specification

Accuracy: 5% of programmed value 1 ns
Description

The clock delays are referenced to the Strobe clock output signal. Delays longer than 300ns are
measured with a time interval counter.

8180RA/B

I:':l STROBE OUT START STOP l l 12

Q
1
'
1
]
]
'

]
1250-0080

18180C 1250-1454
CLOCK 1 OR

CLOCK 2 OUT
~ 13903\ 250-0ms0
12100C | 1250-1454

1540@9A

Figure 6-3. Test Setup for the Clock 1 and Clock 2 Delay Test

Equipment

Scope HP 54100D
Active Pods HP 54001A
Clock, Strobe Cable Assembly HP 15422A
BNC Adapter HP 15409A
50 Ohm Feedthrough HP 10100C
BNC Adapter female/female 1250-0080
Scope Probe Adapter 1250-1454
Counter HP 5370B

1.  Program 8180A/B Standard SeL
(PAGES , SREZEETIE | AW

2. Period I ls.
(PAGES , &

3. Label A TTL; Strobe TTL Strobe output to Clock

i — mam;&m) |
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10.

11

13.

6-10

Clock 1, Clock 2 Delay Test

Outputs ON.
(PAGES , '

)

& [N
i y W

Clock 1 (2) Delay in Softkey Area and start the generator.
(PAGES . @ g fy L ( LT )
Connect the equipment as shown in Figure 6-3 and start the generator (press RUN).

i

Cancel out scope trigger delay of channel 2 and interchannel delay between scope channel 1 and
channel 2.

Connect equipment as shown in the measurement setup and set the scope as follows:

(Autoscale > Trigger > Trig Src to Chan2 > Slope to pos > Timebase > Ins > Display > Split Screen
to OFF > Delta > T Markers to ON > Start Marker to 0.00ns (50% point of the positive going
transition of the Strobe clock signal))

Note: The position of the start marker is used as reference for this test and should therefore not be
moved during the measurement.

Set clock delay to 30 ns (30, &

Set the scope as follows:
(Timebase > Delay > 30ns > Delta t > Stop Marker > 30ns > Knob)

Position the Stop Marker at the 50% point of the displayed transition and read Delta t. Delta t
must be in the following range:

Delta t minimum = 27.5 ns

Delta t maximum = 32.5 ns

Check also the clock delay for the settings detailed in Table 6-2.

Table 6-2. Clock 1, Clock 2 Delay Test Values - Clock Delay at | ls Period

Set Delay Min. Delay Max. Delay
89.9 ns 84 .4 ns 95.4 ns
90.0 ns 84.5 ns 95.5 ns
300 ns 284 ns 316 ns

Disconnect the Strobe and Clock connections from the scope (between 15409A and 10100C) and
connect Strobe cable to Start Input of the counter and the Clock | (2) cable to the Stop Input of
the counter.

Set the counter as follows:

Function: Time Interval

Sample Size: |

Start/Stop input: Both Channels to 12 V
Start/Stop slopes: I

Start/Stop input impedance: 50 Ohm

AC/DC switches to: AC

Start COM/SEP switch: SEP
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Clock 1, Clock 2 Delay Test

- 14.  Change 8180A/B Clock Period to 200 ms and check delay at Clock | and 2 at settings given in
Table 6-3:

Table 6-3. Clock 1, Clock 2 Delay Test Values - Clock Delay at 200 ms Period

Set Delay Min. Delay Max. Delay
989 ns 938.5 ns 1039.5 ns
100 ms 95.0 ms 105.0 ms
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Clock 1, Clock 2 Width Test

6-8 Clock 1, Clock 2 Width Test
Specification
Accuracy: 5% of programmed value f1 ns

Description

The clock width is measured at 50% amplitude. Width ranges greater than 300 ns are measured with the
counter.

COUNTER 541080

8180R/B

START STOP 1
ﬂ o)

18108C

-

1
I _4 }__ S
15409
/ 1250-0080

CLK1 OR 1910aC 1250-1454
CLK2 ouT l

15409A

Figure 6-4. Test Setup for the Clock 1 and Clock 2 Width Test

Equipment

Scope HP 54100D
Active Pods HP 54001A
Clock, Strobe Cable Assembly HP 15422A
BNC Adapter HP 15409A
50 Ohm Feedthrough HP 10100C
Scope Probe Adapter 1250-1454
Counter HP 5370B
BNC Adapter female/female 1250-0080
Procedure

1. Program 8180A/B Standard Set

5. Connect the equipment as shown in Figure 6-4 and press RUN.

6.  Set the scope as follows:
(Autoscale > Timebase > Sec/DIV > 500 ps)
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10.

L1

13.

14.

15.

Clock 1, Clock 2 Width Test

Set the Start Marker to the 50% point of the displayed positive going transition.
(Delta t > T Markers to ON > Start Marker > Knob)

Set Clock 1 Wldth to 10 ns.

Set the scope as follows:
(Timebase > Delay > 10 ns > Delta t > Stop Marker > Knob)

Adjust the Stop Marker to the 50% point of the negative going transition of the Clock 1 signal and
read Delta t.

Delta t minimum = 8.5 ns

Delta t maximum = 11.5 ns

Note: The position of the Start Marker is used as reference for the following measurements and
should therefore not be moved.

Check step linearity when incrementing the width in 100 ps steps up to 20 ns.

" Check clock width using the procedure described in steps 8 to 10 for the width settings given in

Table 6-4.

Table 6-4. Clock 1, Clock 2 Width Test Values - Clock Width at 1 s Period

Set Width Min. Width Max. Width
30.0 ns 27.5 ns 32.5 ns
99.0 ns 93.0 ns 105.0 ns
100.0 ns 94.0 ns 106.0 ns
300.0 ns 284.0 ns 316.0 ns

Disconnect the clock connection between the 10100C and 1250-0080 and connect the 10100C to
the Start Input of the counter.

Set the counter as follows:

Function: Time Interval
Sample Size: 1

Start/Stop Input Levels: Preset

Start slope to: I

Stop slope to: 1

Start & Stop Input Imp. 1 MQ
AC/DC switches to: AC

START COM/SEP switch: START COM
Divider: divide by 10

Change 8180A/B Clock Period to 200 ms and check Clock 1 width at the settings given in Table
6-5.
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Clock 1, Clock 2 Width Test

Table 6-5. Clock 1, Clock 2 Width Test Values - Clock Width at 200 ms Period

Set Width Min. Width Max. Width
999 ns 948 ns 1050 ns
100 ms 95.0 ms 105 ms

16. Perform the above procedures for Clock 2.

6-14
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Timing Channel Delay Test

6-9 Option 002 Timing Channel Delay Test

Specification

Accuracy: 5% of programmed value 1 ns

Description

Data channel delays are referenced to the Strobe Clock output 51gnal Delays greater than 300 ns are
measured with a time interval counter.

8180A/B

3

I:l STROBE OUT START §
¥
1
[

= [ ———

1250-0080

18108C 1250-1454
RZ DATA CHANNELS
~N

159898 550-0080

10100C i 1250-1454
I

154@9A

Figure 6-5. Test Setup for the Timing Channel Delay Test

Equipment

Scope HP 54100D
Active Pads HP 54001 A
Counter HP 5370B
Clock, Strobe Cable Assembly HP 15422A
Data Cable set HP 15423A
BNC Adapter HP 15409A
50 Ohm Feedthrough HP 10100C
BNC Adapter female/female 1250-0080
Scope Probe Adapter 1250-1454

Procedure

1. Program 8180A/B Standard Set

(GINCI NS TORE/RECALL

2. Set Clock Period to 1 ps.

(PAGES,

4.  Outputs ON.
(PAGES, =
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6.

Timing Channel Delay Test

Set Data.
(PAGES,

Connect the equipment as shown in Figure 6-5 and press RUN.

NRZ Function Test

7. Check all installed RZ channels listed on the Timing Page for a static TTL high level (greater than
+2V).

8. Set All Channel Format to RZ
(PAGES , 5588 3 HanneliTi & )

Cancel out interchannel skew between scope channel 1 and channel 2 and the trigger delay of
channel 2,

9.  Set the scape as follows:

(Autoscale > Timebase > Sec/DIV > 500 ps > Trigger > Trg Src to Channel 2 > slope to Pos > Delta
t > T Markers to ON > Start Marker > Knob)

10. Position the Start Marker to the 50% point of the positive going Strobe transition (0.00 ns).

Note: The position of the Start Marker is used as reference for this test and should therefore not
be moved during the measurement.

Delay Test

11.  Set All Channel Delay to 10 ns.

(PAGES il it u

12. Set the scope as follows:

(Chan 2 > Chan 2 Display to OFF > Display > Split Screen to OFF > Timebase > Delay > 10 ns >
Delta t > Stop Marker > 10ns > Knob)

13. Place the Stop Marker at the 50% point of the displayed positive going transition and read Delta t.
Delta t minimum = 8.5 ns ~
Delta t maximum = 11.5 ns

14. Check in turn all RZ Data channels.

15. Repeat steps 11 to 14 for the settings given in Table 6-6.

Table 6-6. Timing Channel Delay Test Values - Clock Period at 1 Us
Set Delay Min. Delay Max. Delay
10.0 ns 8.5 ns 11.5 ns
30.0 ns 27.5 ns 32.5 ns
89.9 ns 84.4 ns 95.4 ns
90.0 ns 84.5 ns 95.5 ns
300 ns 284 ns 316 ns

16. Change the Clock Period to 200 ms
(PAGES = =t , 200,

17. Disconnect the Strobe and Data cable from the scope (between 15409A and 10100C) and connect

6-16

the cables to the counter inputs as shown in the measurement setup.
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Timing Channel Delay Test

18. Set the counter as follows:

Function: Time Interval

Sample size: |

Start/Stop levels: Both Channels to 1.2 V
Start/Stop slope: I

Input impedances: 50 Q

AC/DC switches: AC

Start CAM/SEP switch: SEP

Input Divider: divide by 1

19. Check in turn all RZ Data channels for the delay settings given in Table 6-7.

Table 6-7. Timing Channel Delay Test Values - Clock Period at 200 ms

Set Delay Min. Delay Max. Delay
989.0 ns 938.5 ns 1039.5 ns
100.0 ms 95.0 ms 105.0 ms

Revision 1.0, Dec. 1987



Option 002 Timing Channel Width Test
6-10 Option 002 Timing Channel Width Test
Specification
Accuracy: 5% of progammed value 11 ns

Description

The Data channel width is measured at 50% of amplitude. Width ranges greater than 300 ns are checked

with the counter.

COUNTER 541000

8180A/B

l:l START STOP l I L
A O

ITT}

[g 1810aC

154@3AR

1
1
1
| S

DATA CHANNEL
10102C 12508-1454

iy

154@9A l
1250-0080

Figure 6-6. Test Setup for the Timing Channel Width Test

Equipment

Scope HP 54100D
Active Pods HP 54001A
Counter HP 5370B
Data cable set HP 15423A
BNC Adapter HP 15409A
50 Q Feedthrough HP 10100C
BNC Adapter temale/female 1250-0080
Scope Probe Adapter 1250-1454
Procedure

1. Program 8180A/B Standard Set.
(PAGES , SIS clEstd

2. Period | ps (PAGES , FREEIIEEEES

3.  Label A TTL; Outputs ON.

4.  Set Data.
(PAGES
2 ".‘;‘i

6-18
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Option 002 Timing Channel Width Test
5.  All Channel Wldth 10 ns.

6. Connect the equipment as shown in Figure 6-6 and press RUN.
Cancel out the trigger delay of scope channel 1.

7.  Set the scope as follows:
(Autoscale > Timebase > Sec/Div > 500 ps > Trigger > Trigger Src to Chan | > Slope to Pos > Delta
" t > T Markers to ON > Start Marker > Knob)

8.  Position the Start Marker at the 50% point of the positive going Data transition.

Note: The position of the Start Marker is used as reference and should therefore not be moved
during the measurements.

9. Set the scope as follows:
(Timebase > Delay >10 ns > Delta t > Stop Marker > 10 ns > Knob)

10. Position the Stop Maker at the 50% point of the negative going transition of the Data pulse and
read Delta t.
Delta t min. = 8.5 ns
Delta t max. = 11.5 ns

11. Check in turn all RZ Data channels for the width settings given in Table 6-8.

Table 6-8. Timing Channel Width Test Values - Clock Period at 1 s

Set Width Min. Width Max. Width
10.0 ns 8.5 ns 11.5 ns
30.0 ns 27.5 ns 32.5 ns
99.0 ns 93.0 ns 105.0 ns

100.0 ns 94.0 ns 106.0 ns

300.0 ns 284.0 ns 316.0 ns

12. Change 8180A/B clock perlod to 200 ms.

13. Disconnect the Data probe from the scope (between 10100C and 1250-0080) and connect the open
end of the 10100C to the counter Start input.

14. Set the counter as follows:

Function: Time Interval
Sample size: I

Start/Stop input levels: Preset

Start slope: I

Stop slope: 1

Input impedances: 1 MQ
AC/DC switches: AC

Start COM/SEP switch: Start COM
Input Divider: divide by 10
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Option 002 Timing Channel Width Test

15. Check in turn all RZ Data channels for the delay settings given in Table 6-9.

Table 6-9. Timing Channel Width Test Values - Clock Period at 200 ms

Set Width Min. Width Max. Width
999.0 ns 948.0 ns 1050.0 ns
100.0 ms 95.0 ms 105.0 ms
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Data High / Low Level Accuracy Test

6-11 Data High / Low Level Accuracy Test

Specification

Level accuracy: 10.5% of level £60mV (add £60mV for amplitudes smaller than 1.5V); only valid
with standard cable length of 1.5m.

Description

High and low level accuracy is measured with a digital voltmeter. All data channels are set to the NRZ
format. To measure the high level all data is set to high. Low level is measured with data cleared (low).

8180R/B DIGITAL VOLTMETER

.

—-1251-2277
—
15423R \15403A

Figure 6-7. Test Setup for the Level Accuracy Test

Equipment

Digital Voltmeter HP 3456A
BNC (f) to dual banana Plug 1251-2277
Plug-on BNC Adapter HP 15409A
Data Cable Set HP 15423A

High Level Accuracy Test

1. Program 8180A/B Standard Set.
( PAGES, GERZSE0ER | B3

2. Set Data.
(PAGES

3.  Load Impedance to Open.
(PAGES , BBl -UAEa |

4. Outputs ON.
(PAGES , BEIEIE

5. Label A Low Level to -2V, ngh Level to -1V. ‘
(PAGES - OUIPUT . N L eve s s i Lol CRes S Bl
EXTERSHIEELD [to highl, -, 1, B

6.  Connect the equipment as shown in Figure 6-7 and press RUN.

7. Measure the output voltage at the high level settings given in Table 6-10.
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8.

Low Level Accuracy Test

9.

10.

11

12.

6-22

Repeat step 7 for all Data channels.

Clear Data.

Measure the output voltage at the low level settings given in Table 6-11.

Repeat step 11 for all data channels.

Table 6-10. Data High Level Accuracy Test Values

Data High / Low Level Accuracy Test

Set Level Min. Level Max. Level
-1.00 Vv -0.875 Vv -1.125 V
0.00 v -0.060 Vv +0.060 Vv
+1.00 Vv +0.935 v +1.065 v
+5.00 V +4.915 v +5.085 Vv
+17.00 Vv +16.860 Vv +17.150 v

Table 6-11. Data Low Level Accuracy Test Values

Set Level Min. Level Max. Level
-2.00 v -1.930 v . -2.070 v
-1.00 Vv -0.935 v +1.065 V
0.00 v +0.060 Vv +0.060 Vv
+1.00 Vv +0.935 V +1.065 V

+16.00 V +15.800 V +16.200 Vv
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20 MHz Memory Test

6-12 20 MHz Memory Test

Description

The 8180A/B memory can be tested with a Signature Multimeter up to 20 MHz. Start/Stop conditions
for the Signature Multimeter are established with a high bit in the strobe channel. A pseudo-random
binary sequence which can be generated on all channels is used as the test pattern.

8180A/B SIGNATURE MULTIMETER
STROBE OUT
CLOCK 1 OUT —1 o
DATA CHANNEL
@)
START
oS ‘ TIMING
= =04 POD
DATA PROBE
— O
Figure 6-8. Test Setup for the 20 MHz Memory Test
Equipment
Signature Multimeter HP 5005A
Data Cable Set HP 15423A
Clock Strobe Cable Set HP 15422A
Solder-in Receptacle HP 15412A

1.  Program 8180A/B Standard Set.

3.  Clock Period to 50 ns
(PAGES, :

4. Load Impedance Open Label A TTL
(PAGES = OUTP ‘N
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20 MHz Memory Test

7. PRBSon Channel O 0
(PAGES , s
[until PRBS channel 00 is dlsplayed]

8.  Copy Channel.
Press Copy Channel and using the s 3 softkey in the right hand half of the display
move the inverse video cursor until Copy Channel %l to E&l is displayed.

9. Copy Channel 0-0 to all other channels.
Press alternately ( [on the right hand half of the display] and &

until all Data channels contain the pattern in channel 0-0.

10. Set the Strobe th to ngh at address 00000.

11. Connect the equipment as shown in Figure 6-8 and press RUN.

12. Check all data channels for the following signature:
On the 8180A - 46F9
On the 8180B - H150
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Ext. Clock; RUN; BREAK; and Stop Hysteresis/Threshold Test

6-13 Ext. Clock; RUN; BREAK and STOP Hysteresis/Threshold Test
Specification
Threshold Accuracy: £3% of programmed value £50 mV

Description

A low frequency triangular wave signal is used to stimulate the 8180A/B external inputs. When the
current threshold level of the 8180A/B inputs is reached, the §180A /B starts or stops generating a signal
at its Clock 1 output. Both signals, the triangular wave signal and the Clock 1 output signal are displayed
on the scope. The level of the triangular wave signal where Clock | generation commences or stops is

the actual input threshold.

1250-0781

8188 PULSE GENERATOR 541000
CABLE A TRIG
craLE B/ | '
ARE B OUTP. OUTPUT 123
I Q PRI
1250-0080 —1010aC
BNC CHBLE 1250“@73 1
15422A / ™ BNC CABLE
CLOCK 1 OUTP
10108C 1250-1454
[ ]
|
154@09R |
1250-0080
Figure 6-9. Test Setup for the External Input Test
Equipment
Pulse/Function Generator HP 8007B/HP8116A
Scope HP 54100D
Active Pods HP 54001 A
50 Ohm Pod HP 54002A
50 Ohm Feedthrough HP 10100C
BNC Tee Adapter 1250-0781
BNC female/female 1250-0080
Scope Probe Adapter 1250-1454
BNC Adapter HP 15409A
Clock/Strobe cable set HP 15422A
BNC Cable
Procedure

1.  Program 8l8OA/B Standard Set.
(PAGES , EAiZ4053¢:

2. Clock 1 Width 20 ns; Clock 2 Delay 0 ns.
(PAGES Wﬁﬁﬁ LSk B GER AT T 0 g

Clock oM id iR . oHANGEEE ..

Lﬂmmm 0, BT |
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7.

Ext. Clock; RUN; BREAK; and Stop Hysteresis/Threshold Test
Label A TTL Outputs ON

, T |

Set the Pulse Generator as follows:

Period approx. I ms

Width 0.5 ms

Transition 5 Us to 250 s
Amplitude 250 mVpp (into open)
Offset ON

Adjust leading edge and trailing edge for a triangle waveform on the scope.

External Clock Tést

8.

10.

11.
12.
13.

Connect the equipment as shown in Figure 6-9 and press RUN. (BNC Cable A connected to
External Clock Input.)

Adjust the triangular waveform such that it is symmetrical about 0V using the pulse generator’s
offset vernier.

Set the scope as follows:

(Autoscale > Chan 2 > Volts/Div > 1 Volt > Trigger > Trig Src to Chan 2 >Trigger Level > 1 Volt >
Chan 1 > Chan 1 Mode to Magnify > Magnify to ON > Volts/Div > 20mV/Div > Offset > 0V >
Timebase > Sec/Div > 50 Us)

The displayed transition should cross the vertical graticule line between + 50 mV.

)

The displayed transition should cross the vertical graticule line between * 50 mV,

Change External Clock Slope (active edge) to negative. ( EERSIEILTNE

External RUN and BREAK Test

14.
15.

16.

6-26

Connect cable A to the Break Input (cable B to the Run Input).

Set the 8180A/B to Clock Source INTERNAL; RUN Input to ON, active edge positive; BREAK
Input to ON, actlve edge negatlve

Set the scope as follows:

(Autoscale > Timebase > Sec/Div > 200 microsec/Div > Trigger > Trigger Source to Channel 3 >
Trigger Level > 1 Volt > Delta t > T Markers to ON > Start Marker > Knob > Stop Marker > Knob)
Set the Start Marker to the positive going edge of displayed pulse on channel 2. Set the Stop
Marker to the negative going edge of displayed pulse on channel 2.
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I8.

22.

Ext. Clock; RUN; BREAK; and Stop Hysteresis/Threshold Test

Set the scope as follows:

- (Timebase > Delay > Knob)

Adjust Start Marker to the vertical center graticule line.

Set the scope as follows:

Timebase to 50 Us; Chan 2 to OFF; Split Screen to OFF

(Sec/Div > 50 Us > Chan 2 > Chan 2 Display to OFF > Display > Split Screen to OFF > Channel
Channel |1 Mode to Magnify > Magnify ON > Volts/Div > 20 mV/Div.

. The displayed transition should cross the vertical graticule line within the limits of £50mV.

Repeat the measurement at the position where the Stop Marker is located. The displayed transi
should cross the vertical graticule line within the limits of £50mV.

Set the Run Input to ON, active edge negative, Break lnput to ON, active edge positive.
B ; T | M | Bl

Repeat step 15 through 20 with reversed slopes for Run and Break Inputs. Threshold Limit is
+50mV.

External STOP Test

23,
24.

25.

Connect cable A to the Stop Input (cable B to the Run Input).

1>

tion

Check threshold levels of the Stop Input for both slopes as described above for the Break Input.

Check Clock, Run, Break and Stop inputs at +2 Volt and -2 Volt threshold settings.
(PAGES , & o PRERNEEE | 2 [-2) BEEREREE ),

0

For this test set the pulse generator to triangular waveform with an amplitude of 8V pp
symmetrical about 0V,

Limits: Voltage Threshold minimum = 185 V
Voltage Threshold maximum = 2.15 V

Check inputs only at one slope setting.
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Transition Time / Overshoot Test

6-14 Transition Time / Overshoot Test

Specification

Transition Time: less than 3.0 ns + [amplitude| x 0.2 ns.
Preshoot, Overshoot, Ringing: less than * 10% of amplitude.
Specifications are valid for a cable length of 1.5 m,

54108D

8180A/B

10106C 1250-1454

| 15423

15409AR 1250-0080

Figure 6-10. Test Setup for the Transition Time / Overshoot Test

Equipment
Scope HP 54100D
Active Pod HP 54001A
Data Cable HP 15423A
BNC Adapter HP 15409A
50 Ohm Feedthrough HP 10100C
BNC female/female 1250-0080
BINC scope probe adapter 1250-1454
Procedure
1. Program 8§180A/B Standard Set
(PAGES , BEdE - Rel st
2. Set all bits at addless 00000 ngh Set all bltS at address 00001 Low
(PAGES , EEEL g AddressE e R EXT
Press | until the strobe channel and all data channels at address 00000 are set to high.
Press 0 until the strobe channel and all data channels at address 00001 are set to low.
3. Last Address 00001
(PAGES , BRIk
4.  Outputs ON.
(PAGES , B2l
5. Set Label A ngh Level to - 1V; Low Level -2 V.
[to High), -1,
6.  Connect the equipment as shown in Figure 0-10 and press RUN.
7.  Set the scope as follows:

(Autoscale > Delta V > Vmarkers to ON > Marker 1 Position > Knob [set Marker 1 to 0% of pulse]
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Transition Time / Overshoot Test

> Marker 2 Position > Knob [set Marker 2 to 100% of pulse] > 10-90% > Timebase > Sec/Div > 500
ps > Delta t > T Markers to ON > Start Marker > Knob [set the Start Marker to the crossing point
at the 10% Level and displayed transition] > Stop Marker > Knob [Set the Stop Marker to the
crossing point at the 90% Level and displayed transition]).

8.  Measure the transition time (Delta t) from 10 % to 90 % of amplitude for all data channels.
Specification: Transition Time = less than 3 ns.

9. Change Label A ngh Level to+2V,; Low Level to0 V.

10. Measure preshoot, overshoot and ringing at all data channels.

Specification: less than £10% of amplitude.
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Trigger Word and Operating Modes Tests

Chapter 7
HP 8182A/B Performance Verification

7-1 Introduction

The test procedures described in this chapter are designed to verify the published performance
specifications of the HP 8182A/B Data Analyzer given in Chapter 1 of this manual.

NOTE

The tested instrument must be given a 30 minute warm-up time
before starting any of the performance tests. During any perfor-
mance test, all shields, covers and connecting hardware must be in
place.

Equipment Required

The equipment necessary to perform each performance test is listed at the beginning of each test.
Alternative test equipment may be substituted for the recommended models, provided that it satisfies the
critical specifications given.

Test Record

When carrying out the performance tests, you should keep a tabulated test record, listing the test results
and the acceptable performance limits. The results recorded at incoming inspection will provide a
reference for periodic calibration, troubleshooting and after-repair testing.

7-2 Trigger Word and Operating Modes Tests
Description

The Data Generator HP-Model 8018A is used to generate the Trigger Word (bit) for two 8182A/B data
channels. The error display indicates the Trigger Word position. Because of the cleared memory, the
Trigger Word appears as an error. When selecting Trigger Event Start Compare Mode, the Trigger Delay
is set to 00001. This causes the Trigger Word to be displayed in address 1023/16383.

8182R/B CLOCK PROEE DATA GENERATOR
CLK A
O 000
—i— 15409A

B

@)

=
8

15406A 15409A
DATA PROBE 154070
DATA PROBE 154078

Figure 7-1. Test Setup for the Trigger Word and Operating Mode Test
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Trigger Word and Operating Modes Tests

Equipment Required

Data generator HP 8018A
Plug-on BNC Adapter (3 off) HP 15409A
Clock Probe Assembly HP 15406A
Data Probe Assembly HP 15407A
Procedure

Set the 8018A as follows:

8.

Bit Rate 50 MHz Data Stream Length 1024
Clock Mode Int.Clock Amplitude 25V
Cycle Mode Auto Serializer 2x 1024
Row Address 1-16 Format NRZ
Data Mode ‘ Zs 50 Ohm

Clcar both 8018A Data Channels by selecting the channel and pressing the toggle switch to Channel
Clear.

Select Word Address 01 and load bit | to high in channel A and channel B.

Program 8182A/B SLandard Set
(PAGES, WEEEERIEEE

Clear Word Mask Clear Data

Set Stop Delay to 1023
(PAGES, B [

Error Map; Trigger Word in Softkey Area.
(PAGES, SUEF J2 SHRE

Connect the equipment as shown in Figure 7-1 and press RUN.

Trigger Start Analysis Test

10.

11

12.

With Trigger Word set to X (don’t care) a single sporadic error should be displayed on the Error
Map.

Set the Trigger Word for both connected data channels to 1.
The Error Map should display only the Trigger Word in address 00000 as an error.

Set Trigger Word for one data channel to 0.
The 8182A/B should switch to ARMED (no trigger recognition).

Set the Trigger Word back to 1 and the 8182A/B should trigger again.

Set the Trigger Word for the second channel to 0 and 1 and check Trigger Word recognition as
described in steps 8 to 10.
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Trigger Word and Operating Modes Tests

Trigger Stop Analysis Test

13.

14.

I5.

16.

17.

Program 8182A/B to Tngger Stop Analysns
(PAGES, &l )

Error Map; Trigger Word in the Softkey Area.
(PAGES, SNGRERGEN , SOFTKEYS, RECEIEITSN

With Trigger Word 1 for both connected data channels, the error display should stop always at
address -00000 (the Trigger Word at address -00000 is indicated as error).

Set the Trigger Word for one connected channel to 0.
The 8182A/B should stay in ACTIVE (no trigger).

Set the Trigger Word back to 1.
The 8182A/B should trigger again.

Set the Trigger Word for the second connected data channel to 0 and 1 and check Trigger Word
recognition as described in steps 14 to 16.

Trigger Event Start Compare Test

18.

19.

20.

21.

Program 81 82A/B to Tngger Event Start Compare.
(PAGES, &&ld T g Strts Conp

Select Error Map.
(PAGES, BT RE

)

The error display should show the Trigger Word indicated as error at address 1023 (caused by
Trigger Delay 00001) and errors in the channel marking display for both connected data channels.

Program Tngger Start Analysxs and Tngger Delay ()
& , 0, 3 i )

Repeat the procedure starting with step 5 for the remaining data channel pairs.
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Trigger Delay and Stop Delay Tests

7-3 Trigger Delay and Stop Delay Tests
Description

This test is to be performed with any one of the available channels to check the Trigger Delay and Stop
Delay Functions. A data generator is used to generate the Trigger Word. The Trigger Word for unused
data channels must be set to don’t care (X).

8182R/B DATA GENERATOR

CLK B A
0O 00O

15406A ﬂj 15409AR

15407AR8

Figure 7-2. Test Setup for the Trigger Delay and Stop Delay Test

Equipment

Data Generator HP 8018A
Plug-on BNC Adapter (2 off) HP 15409A
Clock Probe Assembly HP 15406A
Data Probe Assembly HP 15407A
Procedure

Set the 8018A as follows:

Bit Rate 50 MHz Data Stream Length 1024
Clock Mode Int. Clock Amplitude (A) 25V
Cycle Mode Auto Serializer 2x 1024
Row Address 1-16 Format NRZ
Data Mode Zs 50 Ohm

1.  Clear 8018A channel A data by selecting channel A and pressing the toggle switch to Channel Clear
position.

2. Select Word Address 01 and load bit 1 to high.

3. Program 8182A/B Standard Set.
(PAGES, & :

4, Clear Word Mask; Clear Data.
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Trigger Delay and Stop Delay Tests
6. Set Autoalmmg Delay to Is; Set Stop Delay to 1073

7.  Connect the equipment as shown in Figure 7-2 and press RUN.

8.  Set the Trigger Word to l for the connected data probe (all other channels to X, don’t care)
(PAGES, BEHI cn E T

9.  Error Map; Trigger Delay in Softkey Area.
" (PAGES, FEHEELETES , SOFTKEYS, EECCIRETTEES | SRS - i --Trig-Delay |

Trigger Delay Test

10. Increase Trigger Delay by pressing RMEREIEILEES , and check that the displayed error moves
backwards from address 1023 (for Trg Delay 1) with increasing delay setting.

11. Set Trigger Delay back to 00000.
Stop Delay Test

12. Select Stop Delay in the Sof tkey Area and set Stop Delay to 1023/ 16383.
(SOFTKEYS, sl anines i | BTSRRI | 16383, B )

13. Check that the Stored Words displayed in the upper right hand corner of the 8§182A/B display
indicates 1024/16384. Vary the Stop Delay and check that the Stop Delay setting + 1 is displayed as
Stored Words in the upper right hand corner of the 8§182A/B display.
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Sampling Point Accuracy and Skew Tests

7-4 Sampling Point Accuracy and Skew Tests

Specification

Sampling point accuracy: 1 5% of set Clock Delay * | ns.
Channel skew: < 2ns.

Description

The test setup uses a pulse generator as clock and data source for the §182A/B Data Analyzer. The data
is delayed by a fixed 3 ns delay line. Setting the 8§182A/B Clock Delay to 3 ns then corresponds to zero

delay between clock and data. The clock can now be advanced by 3 ns and delayed with respect to the
data to check when the incoming data signal is recognized as a high or a low level.

8182R/B

15407R PULSE GENERATOR
ouT
Q
' |
@8182-61621 1250-8781
15406A
Figure 7-3. Test Setup for the Sampling Point Accuracy and Skew Test

Equipment
Pulse Generator HP 8007B
BNC Tee 1250-0781
Plug-on BNC Adapter (2 off) HP 15409A
Clock Probe Assembly HP 15406A
Data Probe Assembly HP 15407A
Delay Line (including 50 Q) 3 ns 08182-61621
Procedure

1. Set Pulse Generator as follows:

Period: 1 ps

Pulse Width: 0.5 Us
Leading Edge: <3 ns
Trailing Edge: <3 ns
Amplitude High Level: +2V into 50 Q
Low Level: oV

2. Program 8182A/B Standard Set.
(PAGES, B8 B Ca

3. Set Clock Threshold to +1V.
(PAGES, CONTRE -

4. Set Threshold Label A to +1 V
(PAGES, & ,
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12,

13.

Sampling Point Accuracy and Skew Tests

Set Stop Delay to 40.
(PAGES, EEIHNESS

Set Autoarmmg Delay to 0 s.
(PAGES, BRI E

Select the Timing Diagrams Page.

Using BREIMIIEESN | check that the displayed timing signal switches from low to high within
2 to 4 ns of the Clock Delay setting.

Set the Clock Slope to Negatlve

Increment the Clock Delay starting from 2 ns and check that the timing signal switches from high
to low within 2 to 4 ns of the Clock Delay setting.

Repeat the Skew Test ,f or Positive Clock Slope and Negative Clock Slope for the remaining
channels as described in steps 10 to 12.

When checking skew from connectox 3 channel 0 upwards, move the vertical display window.
(PAGES, U EEEIE Quertical Windoufll - <= " FARTIINN
required channels are dlsplayed])
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Clock Delay Test

7-5 Clock Delay Test
Specification

+5% of set Clock Delay t1ns.
Description

The test setup uses a pulse generator as an external clock source. The Clock Delay is measured at the
8182A/B clock output referenced to 0.00ns programmed Clock Delay.

8182A/B PULSE GENERATOR 54100D
OUTPUT 12
Q (ool
18100c—| |
-10100C
1250-1454
TO CLOCK ouT 15406A 15409A N250-1454
1250-0781

Figure 7-4. Test Setup for the Clock Delay Test

Equipment

Pulse Generator HP 8007B
Scope HP 54100D
Active scope Pods HP 54001 A
BNC Tee Adapter 1250-0781
50 Ohm Feedthrough HP 10100C
BNC scope Probe Adapter 1250-1454
BNC Adapter HP 15409A
Clock Probe HP 15406A
Procedure

1.  Cancel out channel to channel skew and the Trigger Delay of channel 2.
Set the Pulse Generator as follows:

Period: 110 ps
Pulse Width: 1,5 ys
Transition Time: 2 ns
Amplitude LOL: ov
(into 50 Ohm) HIL: 25V
Offset: OFF

2. Program 8182A/B St'indard Set
(PAGES, SEEEEUETD ‘Reca

3. Set Clock Threshold to +l 2V, Set Clock Delay to 000ns
(PAGES, &8 : €k THre:

78 ..
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Clock Delay Test

Connect the equipment as shown in Figure 7-4.

Set the scope as follows:
(Autoscale > Trigger > Trigger Src to Chan 1 > Chan 1 > Chan 1 Display to OFF > Display > Split
Screen to OFF) :

Center the 50% point of the positive going transition of the displayed clock pulse on the center
graticule.
(Timebase > Sec/Div > Ins > Delay > Knob)

" Set the Start Marker to the 50% point of the displayed transition.
(Delta > Tmarkers to ON > Start Marker > Knob)

d@ | step through the delay range of 0.00ns to 10.00 ns in 100 ps steps and

check the accuracy.

The position of the Start Marker is the reference for the following measurements and must
therefore not be moved.

Program 8182A/B Clock Delay as listed in Table 7-1 and check that accuracy is in the range 5%
+1 ns.

Example: Zero delay between scope input Channel 1 and Channel 2 = 38 ns
Programmed Clock Delay =219 ns

Set scope Timebase delay to 60 ns and position the Stop Marker to the 50% point of the displayed
transition. Perform a delta t reading; the reading should be in the following range:

Delta t min = 198 ns

Delta t max = 240 ns

Table 7-1. Clock Delay Test Values

Set Delay Delta t min. Delta t max.
21.9 ns 19.8 ns 24.0 ns
22.0 ns 19.9 ns 24.1 ns
70.0 ns 65.5 ns 74.5 ns

117.0 ns 110.2 ns 123.9 ns

118.0 ns 111.1 ns 124.9 ns

500.0 ns 474.0 ns 526.0 ns

1.01 us 0.96 us 1.06 us
1.02 us 0.97 us 1.07 us
5.00 us 4.75 us 5.25 us
9.99 us 9.49 us 10.49 us
10.0 us 9.50 us 10.5 us
50.0 us 47.5 us 52.5 us
99.9 us 94.9 us 104.9 us
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Compare Window Width Test

7-6 Compare Window Width Test

Specification

Compare window width accuracy 5% of set value t1ns.
Description |

The test setup uses a pulse generator as an external clock source, Analyzer Clock Delay is measured at
the 8182A/B Clock Output referenced to 0.00 ns programmed Clock Delay. Ranges up to 10 ns are
measured with an oscilloscope. A time interval counter is used for higher ranges. A time offset is
programmed on the counter in order to compensate for internal and cable delays, instead of adding
these delays manually.

154086A 15409AR

8182A/B PULSE GENERATOR 54 100D COUNTER  5370B
OUTPUT | A B
l I 0 =N (')O
—10100C
. | STEP
1250~1454 -10100C | NUMBER
TO CLOCK d |13
~OUTPUT 1250-1454 —T—1) T :
|
I
1

Figure 7-5. Test Setup for the Compare Window Width Test

Equipment

Scope HP 54100D
Active scope Pods HP 54001A
Pulse Generator HP 8007B
Counter HP 5370B
Clock Probe Assy HP 15406A
BNC Adapter HP 15409A
50 Ohm Feedthrough HP 10100C
Scope Probe Adapter 1250-1454

Procedure

Before performing this measurement cancel out the Trigger Delay of scope channel 1.

1.  Set the Pulse Generator as follows:

Period:
Pulse Width:

Transition Time:

HIL:
LOL:

I ys
0.5 ps
2 ns
25V
00V

2. Program 8182A/B Standard Set.

(PAGES, HR485ENEE

3.  Select Trigger Event Start Compare.

(PAGES, Fedgulasein

7-10
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Compare Window Width Test

4.,  Set the Clock Width to 10ns.
(PAGES, EEIUETIEER BTy

5. Connect the equipment as shown in Figure 7-5.

6.  Set the scope as follows:
(Autoscale > Timebase > Sec/Div > 500ps > Trigger > Trigger Src to Chan 1 > slope to pos)

7. Adjust the 50% point of the positive going transition to lie on the center horizontal graticule line.
(Chan 1 > Offset > Knob)

8. Move the Start Marker to the 50% point of the displayed transition.
(Delta t > Tmarkers to ON > Start Marker > Knob

Note: The Start Marker is the reference for the following measurements and must therefore not
be moved.

9.  Set the scope timebase delay to 10ns.
(Timebase > Delay > 10ns)

10. Set the Stop Marker to the 50% point of the negative going transition and read delta t (Delta t >
Stop Marker > Knob) :

Delta t must be in the following range:
Delta t min: 8.5 ns
Delta t max: 11.5 ns

11. Check linearity by incrementing the clock width in 100 ps steps up to 20 ns.
12. Check the Clock Width at the settings given in Table 7-2.

Table 7-2. Clock Width Test Values - Clock Period at 1 [s

Set Width Min. Width Max. Width
29.9 ns 27.4 ns 32.4 ns
30.0 ns 27.5 ns 32.5 ns
99.0 ns 93.0 ns 105.0 ns
100.0 ns 94.0 ns 106.0 ns

13. Connect 8§182A/B Clock Output to counter channel A instead of scope.

Counter settings:

Function: Time Interval
Sample Size: 1

Start/Stop slopes: b/n
Start/Stop inp. imp: 500

AC/DC switch to: AC

Start COM/SEP switch: CcCOM

Change pulse generator period to 120 ms and repeat step 12 using the values in Table 7-3.
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- . Compare Window Width Test
Table 7-3. Clock Width Test Values - Clock Period at 120 ms

Set Width Min. Width Max. Width
300.0 ns 284 .0 ns 316.0 ns
999.0 ns 948.0 ns 1050.0 ns
100.0 ms 95.0 ms 105.0 ms
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Clock Threshold and Hysteresis Tests

7-7 Clock Threshold and Hysteresis Tests

Specification

Threshold accuracy: +2% of set value £10mV.
Hysteresis: < 150mV,
Description

The pulse generator is ad justed to generate a triangular waveform with a period of 1 ms. This signal is
fed into the CLOCK input of the 8182A/B. When the 8182A/B clock threshold is reached the §182A/B
generates a clock pulse, which is available at its Clock Output. This clock pulse triggers a trace on the
oscilloscope. The vertical offset from zero volts corresponds exactly to the level where the §182A/B

recognises a clock signal.

8182A/B PULSE GENERATOR 54 100D
OUTPUT 12
Q (ol
19100Cc—| |
-18100C

1250-1454
TO CLOCK ouT 15406A 15409A l 1250~ 1454
1250-0781

Figure 7-6. Test Setup for the Clock Threshold Hysteresis Test

Equipment

Scope HP 54100D
Active scope Pods HP 54001A
Pulse Generator HP 8007B
BNC Tee Adapter 1250-0781
Scope Probe Adapter 1250-1454
50 Ohm Feedthrough HP 10100C
Clock Probe HP 15406A
BNC Adapter HP 15409A
Procedure

1.  Set the pulse generator as follows:

Period: 1 ms

Width: 0.5 ms
Transition Time: S5Us to 250 Us
Amplitude: 4V pp into 500
Offset: ON

2. Adjust the leading and trailing edges for a triangle waveform on the scope.

3.  Using the pulse generator offset vernier, set the wavetorm symmetrical to OV graticule line.
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Clock Threshold and Hysteresis Tests -

Hysteresis Test

4.

Program 8182A/B to Standald Set

" (PAGES, 0B

Clock Slope Posmve Threshold 0.00V.

Connect the equipment as shown in Figure 7-6.

Set the scope as follows:

(Autoscale > Trigger> Trig Src to Chan 2 > Display > Split Screen to OFF > Chan 2 > Chan 2
Display to OFF > Timebase > Sec/Div > 500ns > Chan 1 > Volts/DIV > 100mV > Chan 1 Mode to
Magnify > Magnify to ON > Volts/DIV > 20mV > Delta V > V Markers to ON > Marker 1 Position
> Knob)

Position the Marker to the point where the transition crosses the vertical graticule line and read
V(1).
V(1) € +50mV.

Change to negatnve Clock Slope

Move V Marker 1 to the crossing point and read V(1)
V(1) € -50mV

-

Threshold Test

10.

11.

12.

13.

14.

15.

16.

7-14

Set the threshold to -1.4V.
g Exit W Clock Thres RPN

Set the scope as follows.

(Chan 1 > Chan 1 Mode to NORMAL > Volts/DIV > 100mV > Offset > -1.2 V > Chan 1 Mode to
Magnify > Magnify to ON > Volts/DIV > 20mV/DIV > Offset > -1.400V > Delta V > V markers to
ON > Marker I Position > Knob)

Move Marker 1 to the crossing point where the displayed transition meets the vertical graticule line
and read V(1)

V(1) min: -149 V

V(1) max:-131V

Set Clock Slope to posmve Set Clock Threshold to +1 4V

Set the scope as follows:
(Chan 1 > Chan 1 Mode to NORMAL > Volts/DIV > 100mV > Offset > 1.200 V > Chan 1 Mode to
Magnify > Magnify to ON > Volts/DIV > 20mV > Offset > 1.400V)

Move V Marker 1 to the point where the transition crosses the vertical graticule line
(Delta V > Vmarker to ON > Marker 1 Position > Knob)

Read V(1). V(1) must be in the range of:
V(1) min: 1.31V
V(1) max: 149V
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Data Threshold Level Accuracy and Linearity Tests

7-8 Data Threshold Level Accuracy and Linearity Tests

Specification

Single threshold accuracy: +2% of set value £10 mV.
Level detection accuracy 50 ms

after input signal transition: actual threshold = £15 mV.
Description

This test is used to measure the high and low level detection voltage to determine the actual threshold
voltage. The check-sequence is selected to ensure that all data lines used for level programming are
working properly. To get a better resolution when adjusting the power supply, two 20 dB attenuators
are used to reduce the output voltage. 20 W attenuators are recommended to avoid damage to the rest
of the equipment. The capacitor across the DVM input suppresses spikes generated by the DVM.

POWER SUPPLY DIGITAL VOLTMETER
8182A/B - @.22uf
—C3 3
f——c2
—-a3a

1251-2277

20dB 20K 1251-2277

28dB 20N

18108C

BNC CARBLE

15407A CI] 15403A

1258-8781

Figure 7-7. Test Setup for the Data Threshold Level Accuracy and Linearity Test

Equipment
DC Power Supply HP 6002A

" Digital Voltmeter HP 3456A
Plug-on BNC Adapter HP 15409A
Data Probe Assy. HP 15407A
BNC - Tee 1250-0781
BNC (f) to dual banana Plug (2 off) 1251-2277
50 Ohm Feedthrough HP 10100C
Capacitor 022 uF
2 x Attenuator 20 dB (20W) (e.g. Texscan HFP 50/20)
Cable Assembly BNC to BNC HP 11170C
Procedure

1.  Program 8182A/B Standald Set.
((N€) WIS LELLANEOLSI. . Reca

2. Clock Source Internal.
(PAGES, # FROL 2

3.  Select Autoarming Delay of 0s.
(PAGES, Hggunirmes  MarRines

o -DELAYCDS )
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10.

13.

7-16

Data Threshold Level Accuracy and Linearity Tests

Set Stop Delav to 40
(PAGES, #23E] Sustbpoc eStopaDelayst

Set Channel Conh nzmon to Connector 0 Channel 0.
is dxsplayed])

Select Timing Diagrams; Sclect Single Thleshold Label A in the Softkey Ale'l
(PAGES, ELIITHEALES | SOFTKEYS, nput.= gy Threshol CNERT L
necessaryl)

Set Sm le Threshold of Label A to +0.01 V.

Set power supply voltage to minimum. Do not overload
attenuators.

Connect the equipment as shown in Figure 7-7 and press RUN.

Increase power supply voltage slowly until the timing display just switches to high and note DVM
reading (Voltage a).

Decrease power supply voltage slowly until the timing display just switches back to low and note
DVM reading (Voltage b).

Level Detection Accuracy (Va - Vb) must be better than 30 mV,

Actual Threshold (Va + Vb)/2 must be within 2% of the set value £10 mV.

Example:  Programmed Threshold = +0.01 V
High Level Voltage (measured in step 9) = +0.012 V
Low Level Voltage (measured in step 10) = +0.009 V
Level detection accuracy =( 0.012 V - 0.009 V) = 0003 V
Limit = <003 V
Single threshold accuracy = (0.012V + 0.009 V)/2 =0011 V
Limit =000 V t0 002 V

Program the thresholds given in Tables 7-5, 7-6 and 7-7, and check for specifications as described in
step 10.

Table 7-5. Threshold Level Accuracy and Linearity Test - All Attenuators in Place

Set Thres. Hi Level Va Lo Level Vb Delta V Threshold Accuracy
Min. Actual Max.
0.01 VvV | ........ | |20 vV | 0.000V ...... 0.020v
0.02 V | .......n V | eeeaae. 20 v | 0.010V ...... 0.030v
0.06V | ........ V | e ‘V ........ v | 0.020v ...... 0.050v
0.08V | ........ v | el 20 I V| 0.068v ...... 0.092v
0.16 V. | ...vvn.. |2 | V| 0,147V ...... 0.173v
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Table 7-6. Threshold Level Accuracy and Linearity Test - One 20 dB Attenuator Removed

Data Threshold Level Accuracy and Linearity Tests

Set Thres. Hi Level Va Lo Level Vb Delta V Threshold Accuracy
Min. Actual Max.
0.32V | ........ V | eeeenenn V | ceeennns V | 0.304v ...... 0.336V
0.64 V | ........ V| eeeeeeen Vol eeveaans V| 0.617v ...... 0.663V
1.28 Vv | ...l V | eeveaaen Vo[ eeeenenn V| 1.244v ..., 1.316V
2.56 V. | ... |2 L V| 2.499v ...... 2.621v

Table 7-7. Threshold Level Accuracy and Linearity Test - Both Attenuators and 50 () Feedthrough

Removed
Set Thres. Hi Level Va Lo Level Vb Delta V Threshold Accuracy
Min. Actual Max.
5.12 V| ..eae... V | eeeeennn |2 vV | 5.008v ...... 5.232v

Revision 1.0, Dec. 1987
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Data Offset and Gain Tests

7-9 Data Offset and Gain Tests

Specification

Single threshold accuracy: 1/2% of set value £10 mV.
Level detection accuracy 50 ms

after input signal transition: actual threshold =15 mV.
Description

To determine the actual threshold and to check the threshold accuracy, the hysteresis between high and
low level detection voltages must be measured first. The actual threshold is midway between high and
low level detection voltages. This value must be within the specifications for single threshold.

POWER SUPPLY DIGITAL VOLTMETER
8182A/B . @.22uF

—-C3
f—--=~C23 2
—C2 1

1251-2277

20dB/20W

oraec BNC CABLE

154978 @ 154@9A L

1250-0781

Figure 7-8. Test Setup for the Data Offset and Gain Test

Equipment

DC Power Supply HP 6002A
Digital Voltmeter HP 3456A
Plug-on BNC Adapter HP 15409A
Data Probe Assy. HP 15407A
BNC - Tee 1250-0781
BNC (f) to dual banana Plug (2 off) 1251-2277
50 Ohm Feedthrough HP 10100C
Capacitor 0.22 uF

2 x Attenuator 20 dB (20W) (e.g. Texscan HFP 50/20)
Cable Assembly BNC to BNC HP 11170C

Positive Offset Test

1. Program 8182A/B Standard Set
(PAGES, \FEEENENERE | W

2. Set Clock Source to Internal.
(PAGES, &=

3. Set Autoarming Delay to Os.
(PAGES, &

4.  Set Stop Delay to 40.
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Data Offset and Gain Tests

5.  Set Channel Configuration to Connector 0 Channel 0.
(PAGES, ST g8 [until only connector 0 channel 0

is displayed])

Set power supply voltage to minimum. Do not overload
attenuators.

6.  Set Single Threshold Label A to +0.05 V.
(PAGES, B - Threshold:: |8 [if necessary] .05, SR

7.  Select Timing Diagrams Report; Channel Configuration in Softkey Area.
(PAGES, , SOFTKEYS, , )

8. Connect the equipment as shown in Figure 7-8 and press RUN.

9. Increase power supply voltage slowly until the timing display just switches to high and note DVM
reading (Voltage a).

10. Decrease power supply voltage slowly until the timing display just switches back to low and note
DVM reading (Voltage b).

Level Detection Accuracy (Va - Vb) must be less than 30 mV.
Actual Threshold (Va + Vb)/2 must be within 2% of set value £10mYV.

Example: Programmed Threshold = 005V
High Level Voltage (measured in step 9 ) = 0.056 V
Low Level Voltage (measured in step 10) = 0.043 V
Level detection accuracy = 0.056 V - 0043 V =0013 V
Limit: <003V
Single thresh. accuracy = (0.056V + 0.043 V)/2 = 0.050 V
Limit: 0039V to 0.061V

11. Select the connector and channel to be tested by pressing first the connector number and then the
channel number on the data entry key pad. Connect in turn all data probes to the test setup and
check for +50 mV * 10 mV threshold accuracy.

Negative Offset Test
14. Change power supply polarity to negative and program the 8§182A/B as follows:

15. Set Label A Single Threshold to -0.05 V.
(SOFTKEYS, E ; BB

16. Select Channel Configuration.
(SOFT[(EYS, ~Chnb*Config" )

17. Proceed as described for the Positive Offset Test and check all channels for -50 mV 10 mV
threshold accuracy.

Gain Test (Negative)

18. Remove both 40 dB attenuators and the 50 Ohm feedthrough from the test setup and set the power
supply voltage to -9.00 V (reading on DVYM).
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Data Offset and Gain Tests

19. Program Standard Channel Configuration.
(PAGES ESSe L e MG P G O T ﬁ S AR A [

N

- ExEEU TR

20. Select Timing Diagrams, Select Single Thneshold Label A in the Sof tkey Alea
(PAGES, BBITIEHEIE  SOFTKEYS, ! HpL HEeshbld . BEEENeX b Babe b =
necessaryl)

21. Set the threshold to -8.81 V and check that the corresponding timing display is low. (-8.81,
: )

22.  Set the threshold to -9.19 and on pressing Fiaaias
high.

, the timing display should jump to

23. Repeat step 21 and 22 for all data channels.
Gain Test (Positive)
24, Change power supply voltage to +9.00 V.

25. Set the threshold to +8.81 V and check that the corresponding timing display is high. (8.81,

26. Set the threshold to +9.19 and on pressing iRl REEEE
low.

, the timing display should jump to

27. Repeat step 25 and 26 for all data channels.

Note: When testmg channels at connectors 3 to 7 move the txmmg dlagrams display up:
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Qualifier Threshold and Impedance Tests

7-10 Qualifier Threshold and Impedance Tests
Specification
Threshold accuracy: £3% of set value £50mV.

Description

This test is used to measure the high and low level detection voltage (hysteresis) to determine the actual
threshold voltage of the Qualifier Inputs (TTL setting). By measuring the voltage drop across the 20dB
attenuator when switching the input to 500, proper input impedance selection can be verified.

8182A/B POWER SUPPLY DIGITAL VOLTMETER
.22uf
gy e
L_J

Depending on the test,
connect BNC cable to: 1251-2277

Clock Qualifier Input 20dB/20W 1251-2277
Trigger Qualifier Input| BNC CABLE BNC CRBLE
i | S
Trigger Arm Input 1250-278 1
Stop Input

Figure 7-9. Test Setup for the Qualifier Threshold and Impedance Test

Equipment

DC Power Supply HP 6002A

Digital Voltmeter HP 3456A

BNC - Tee 12500781

BNC (f) to dual banana Plug (2 off) 1251-2277

Capacitor 022 uF

Attenuator 20 dB (20W) (e.g. Texscan HFP 50/20)
2x Cable Assembly BNC to BNC HP 11170C

Clock Qualifier Threshold Accuracy Test

I.  Program 8182A/B Standard Set
(PAGES, EEE=80I=T

2. Set Clock Source to Internal
(PAGES, TROL S oo

3. Set Autoarmmg Delay to Os

4. Set Clock Quahf ier to High Level Set Tlneshold to +14V.

5.  Connect the equipment as shown in Figure 7-9 and press RUN.

6. Increase power supply voltage slowly until a clock signal is just indicated in the upper left hand
" corner of the display and note the DVM reading.
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Qualifier Threshold and Impedance Tests

7.  Decrease the power supply voltage slowly until the clock indication just disappears and note the
DVM reading. _ ‘
Result: The meamn value should be between +1.31V and +1.49V.

8.  Change power supply polarity and set 8182A/B threshold to -1.40V.

9. Increase power supply voltage slowly until the clock indication just disappears and note the DVM
reading, ,

10. Decrease power supply voltage slowly until a clock signal is just indicated and note the DYM
reading.
Result: The mean: value should be between -1.31V and -1.49YV.

50 Ohm Impedance Test

11. Set the power supply v()ltage for a -1.40V reading on the DVM.,

12.  Set the Clock Qualifier Input Impedance to 50(.

The DVM should show approximately -0.7 V.
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Trigger Qualifier Threshold Accuracy Tests

7-11 Trigger Qualifier Threshold Accuracy Tests

L.

Program 8[8”A/B Standald Set
(PAGES, »idH3

Clock Source Internal.

(PAGES, Hsdelil TR |

Set Autorummg Delay to Os
(PAGES, &8 )

Trigger Qualmel ngh Level; Threshold +14V.

Connect the equipment as shown in Figure 7-9 and press RUN.

Increase power supply voltage slowly until the status display in the upper right hand corner of the
display jumps just from ARMED to IDLE (IDLE toggles) and note the DVM reading.

Decrease power supply voltage slowly until the display just jumps to ARMED and note the DVM
reading.
Result:  The mean value should be between +1.31V and +1.49V

Change power supply polarity and set §182A/B threshold to -1.40V.

Increase power supply voltage slowly until the display just jumps from IDLE to ARMED and note
the DVM reading.

Decrease power supply voltage slowly until the display just jumps back to IDLE and note the DVM
reading.
Result:  The mean value should be between -1.31V and -149V

50 Ohm Impedance Test

1.

Set the power supply voltage for a -1.4 V reading on the DVM.

Pr ogram T1 1ge1 Quahf ier lnput Impedance to 500

The DVM should show approximately - 0.7V.
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Trigger Arm Threshold Accuracy Tests

7-12 Trigger Arm Threshold Accuracy Tests

I.

Program 8182A/B Standard Set.
(PAGES, M85 (e | B

Set Clock Somce to Internal; Set Clock Per lOd to Is.

Connect the equipment as shown in Figure 7-9 and press RUN.

Increase power supply voltage slowly until the 8182A/B switches from ARMED to ACTIVE (upper
right hand corner of display).

NOTE

Continuous toggling may be caused by noise when the threshold
level has just been reached.

The DVM reading should be between +1.31 V and +149 V.

Set Trlggel Arm Slope to Negatlve Set Threshold to -1.4 V.
4 209 Ao ) S Ery Ppiras i ] : -1 4 B

Change power supply polarity, press RUN and increase power supply voltage slowly again until the
8182A/B switches from ARMED to ACTIVE. (See Note above.)

The DVM reading should be between -1.31 V and -1.49 V.

50 Ohm Impedance Test

10.

11

7-24

Set power supply voltage for a -1.40 V reading on the DVM.

Set Trlgger Arm Input lmpedance to 500

The DVM should show approximately -0.7 V.
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External Stop Threshold Accuracy Tests

7-13 External Stop Threshold Accuracy Tests

I.  Program 8182A/B Standald Set
(PAGES, W& EQL

2. Set Clock Souxce to Internal; Set Clock Pernod to lOOms

6. Connect the equipment as shown in Figure 7-9 and press RUN.

7.  Increase power supply voltage slowly until the 8182A/B switches from ACTIVE to IDLE (upper
right hand corner of display).

NOTE

Continuous toggling may be caused by noise when the threshold
level has just been reached.

The DVM reading should be between +1.31V and 1.49V.

8. Program Neganve Slope' Threshold 14 V.

, B

9. Change power supply polarity, press RUN and increase power supply voltage again until the
8182A/B switches from ACTIVE to IDLE. (See the Note above.)

The DVM reading should be between -1.31V and 149 V.
50 Ohm Impedance Test
10. Set power supply voltage for a -1.40V reading on the DVM.

11. Set External Stop Input Impedance to 500).
(s )

The DVM should show approximately -0.7V.
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Retrofit Procedures

Chapter 8
Retrofit Procedures for HP Models 8180A/B, 8181A/B, 8182A/B

8-1

Introduction

This chapter describes the procedures when retrofitting (upgrading) the HP 8181 A/B generator, the HP
8181A/B extender and the HP 8182A/B analyzer.

8-2

1.

8-3

81801A/B Retrofit Procedure for 8180A/B (4 additional NRZ channels)
Remove top and bottom cover.

When removing the holding screw, avoid damaging the threaded hole in the mainframe by inserting
a second screwdriver in the corner cutout of the top cover, and gently levering the cover off the
rear frame as the holding screw is removed.

Remove the blank connector of the next available connector (e.g. connector 3 if 0, 1 and 2 are
already fitted).

Remove board spacer.
Ensure that the PC-edge connectors of the Module Board are clean.

Insert the Module Board A6 (A66) in the next available slot (eg. Module 3 if Module 0, 1 and 2 are
already installed).

Install data connector on the rear panel.
Install board spacer and readjust the Power Supply.
Perform Output Amplifier High/Low Level Adjustment for the retrofitted NRZ channels.

With top and bottom cover fitted, allow instrument to warm up for 30 minutes and check the skew
of all NRZ channels for t1ns (A-version) and 10.8ns (B-version), referenced to the strobe clock
signal (Performance test). If the skew of the NRZ channels is out of specification, readjust Strobe
Reference Delay.

81801 A/B Retrofit Procedure for 8181 A/B (4 additional NRZ channels)

Remove top and bottom cover. When removing the holding screw, avoid damaging the threaded
hole in the mainframe by inserting a second screwdriver in the corner cutout of the top cover, and
gently levering the cover off the rearframe as the holding screw is removed.

Remove the blank connector of the next available connector (e.g. connector 7 if connectors 4, 5
and 6 are already occupied).

Remove board spacer.
Ensure that the PC-edge connectors of the Module Board are clean.

Insert the Module Board A6 (A66) in the next available slot (e.g. Module 7 if Module 4, 5 and 6 are
already installed).

Install data connector on the rear panel.

Install board spacer and read just the Power Supply.
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Retrofit Procedures
8.  Perform Output Amplifier High/Low Level Adjustment for the retrofitted NRZ channels.

9.  With top and bottom cover fitted, allow instrument to warm up for 30 minutes and check skew of
all NRZ channels for t1ns (A-version) and 10.8ns (B-version), referenced to the strobe clock signal
(Performance test), of the 8180 A/B. If the skew of the NRZ channels is out of specification,
readjust Extender 0 Delay slightly.

8-4 81802A/B Retrofit Procedure for 8180A/B (4 additional Timing channels)

1. Remove top and bottom cover. When removing the retaining screw, avoid damaging the threaded
hole in the mainframe by inserting a second screwdriver in the corner cutout of the top cover, and
gently levering the cover off the rear frame as the retaining screw is removed.

2.  Remove the blank connector of the next available connector (e.g. connector3 if 0, 1 and 2 are
already fitted).

3. Remove the board spacer.
4.  Ensure that the PC-edge connectors of the Module Board and timing board are clean.

5.  Insert the Module Board A6 (A66) in the next available location (e.g. Module 3 if Module 0, 1 and 2
are already installed).

6. Install data connector on the rear panel.

7.  Insert the timing board A5 (A65) in location Timing 0 or Timing 1 if Timing 0 is already fitted.
8.  Install board spacer.

9. Install bottom cover and continue with Power Supply Adjustment.

Module Board A6 (A66) Adjustment

10. Allow instrument to warm up and perform Output Amplifier High/Low Level Adjustment for
retrofitted NRZ channels.

11. Check skew of all NRZ channels for tIns (A-version) and +0.8ns (B-version) referred to the strobe
clock signal.

NOTE

Readjust the Strobe Reference Delay only when the skew of the
NRZ channels is out of specifications.

12. Check Date Flatness And Overshoot. Read just only if necessary.
Timing Board A5 (A65) Adjustment
NOTE

Use Adjustment Cover and allow instrument to warm up for 30
minutes.

13. If this is the first time a timing board is being installed, then the Preadjustment For Timing
Channels must be carried out. ‘
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Retrofit Procedures

14. Readjust Zero Delay for retrofitted Timing Channels and check Delay and Width ranges as
described in Delay and Width Adjustment.

15. Check Zero Delay for both Clock Channels.

8-5 81821 A/B Retrofit Procedure for 8182 A/B (8 additional Data channels)

1.  Remove top cover. When removing the holding screw, avoid damaging the threaded hole in the
mainframe by inserting a second screwdriver in the corner cutout of the topcover, and gently
* levering the cover off the rear frame as the holding screw is removed.

2. Remover the cable cover from the rear frame.

3.  Remove the blank cover from the next available connector (e.g. 4 and 5 if 0, 1, 2 and 3 are already
fitted).

4.  Remove the 4 screws from the connectors on the 08182-66530 board.

5. Install 08182-66530 board and fasten it with the additional 4 connector screws. (Discard the
supplied washers.)

6.  Ensure that the PC-edge connectors of the A5 (A65) Data boards are clean.

7.  Insert the Data boards (08182-66505/66565) in the next two Data board locations (e.g. Data 4 and
Data 5 if Data 0, 1, 2 and 3 are already installed).

NOTE

If more than 16 channels are installed, the -52V load must be
removed. Disconnect the brown wire from the -52V connector
and connect it to the GND connector (both located on the right
hand side of the motherboard).

8. Connect the cables coming from the connector board 08182-66530 (installed in step 5 of this
procedure) so that the connector marked with the blue dot is connected to the Data board with the
even numbers (2, 4 or 6).

9.  Fasten the connectors firmly to their corresponding Data boards using the supplied screws.
10. Perform adjustment as described for the A5 (A65) board in the adjustment procedure.
11. Ensure that all cables are correctly connected to their respective board.

12. Re-fit cable cover, board spacer and top cover.
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20 MHz Memory Test 6-23
50 Ohm Impedance Test,
Clock Qualifier Threshold 7-22
Trigger Qualifier Threshold 7-23
Trigger Arm Threshold 7-24
External Stop Threshold 7-25 : -
81801A/B Retrofit Procedure (for -
8180A/B) 8-1
81801A/B Retrofit Procedure (for
8181A/B) 8-1
81802A/B Retrofit Procedure (for
8180A/B) 8-2
81821A/B Retrofit Procedure (for
8182A/B) 8-3

A

Address Board 08182-66503 (8182A);
08182-66563 (8182B) 5-10
Address Control
1 Board 08180-66503 (8180A)
08180-66563 (8180B) 3-13
2 Board 08180-66508 (8180A)
08180-66568 (8180B) 3-18
2 Board 08180-66508 (8180A)
08180-66568 (8180B) 3-58
3 Board 08180-66508 (8181A)
08180-66568 (8181B) 4-1
Adjustments to be made after Board
Replacement 3-66
Auto Cycle Test 6-1

B

BREAK Hysteresis/Threshold Test 6-26
Back Test 6-1

Board Replacement Adjustments 3-66
Break Test 6-1

c

Clock 1, Clock 2,
Delay Test 6-9
Width Test 6-12

Clock,
Amplifier Adjustment 5-16
Amplifier Offset Adjustment 5-18
Board 08182-66506 (8182A);

08182-66566 (8182B)5-16

Channels Pre-adjustment 3-58
Delay Adjustment 5-30
Delay Test 7-8
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INDEX

Hysteresis Test 7-14
Output Amplifier High/Low Level
Adjustment 3-51
Output Amplifier Offset Adjustment
5-16
Qualifier Adjustment 5-21
Qualifier Offset Adjustment 5-23
Qualifier Threshold Accuracy Test
7-21
Threshold Test 7-14
Width Adjustment 5-32
- and Data Skew Test 6-7
Compare Window Width Test 7-10
Component Locating in the 8180A Data
Generator 3-67
Control Board 08182-66504 (8182A);
08182-66564 (8182B) 5-13
Control Qutput Adjustment 5-14
Cycle Modes Test 6-1

D

D-A Converter Adjustment,
08180-66502 3-10
08180-66562 3-10
External Inputs 3-15
Data Board 08182-66505 (8182A)
08182-66565 (8182B) 5-38
Data,
Flatness and Overshoot Adjustment
3-33
High/Low Level Accuracy Test 6-21
Input Amplifier Offset Adjustment
5-39
Offset and Gain Tests 7-18
Overshoot and Flatness Adjustment
3-33
Threshold Tests 7-15
Delay Test 6-16
Delay Test, Clock 1, Clock 2 6-9
Delay and Width Adjustment,
Timing Board 3-42
Sync Board 3-60
Digital Analog Converter Adjustment
5-8
Display Adjustment 3-6, 5-1
Display Control Board,
08180-66530 3-6
08182-66530 5-1
Dual Threshold Adjustment 5-41

E

Equipment Required 6-1, 7-1
Equipment, Recommended Test -1

Index-1



Exchange Boards Parts Lists 2-37
Extender Delay Adjustment 4-1
External,
Break Amplifier Adjustment 3-18
Clock Amplifier Adjustment 3-16
Clock Hysteresis/Threshold Test
6-25
Clock Test 6-26
Inputs, D-A Converter Adjustment
3-15
RUN and BREAK Tests 6-26
Run Amplifier Adjustment 3-51
STOP Test 6-27
Stop Amplifier Adjustment 3-18,
5-11
Stop Amplifier Offset Adjustment
5-11
Stop Threshold Accuracy Tests 7-25
Trigger Arm Amplifier Adjustment
5-10

F

Fixed Delay Adjustment 5-27
Flatness and Overshoot Adjustment 3-53
Forward Test 6-1
Frequency Error Adjustment 3-16
Frequency Response Adjustment 5-10,
' 5-11, 5-13 ‘

Frequency Response Adjustment,

Low 5-16,5-38

High 5-16, 5-39

G

GEM Interface Board 08180-66502
(8180A), 08180-66562 (8180B)
3-10
GEM Interface Board 08182-66502
(8182A); 08182-66562 (8182B) 5-8
Gain Test,
Negative 7-19
Positive 7-20
Gain and Data Offset Tests 7-18
Gated Cycle Test 6-2

H

HP 8180B Parts Lists 2-1

HP 8181B Parts Lists 2-15

HP 8182B Parts Lists 2-24

High Frequency Response Adjustment
5-17, 5-39

High Level Accuracy Test 6-21

Index-2

INDEX

High/Low Level Adjustment, Clock
Output Amplifier 3-51

Impedance and Qualifier Threshold
Tests 7-21
Init+Auto Cycle Test 6-2
Init+Gated Cycle Test 6-2
Input Amplifier Adjustment 5-38
Intensity and Focus Adjustment 3-7,
5-1
Internal, :
Clock Frequency Test 6-5
Clock Generator Adjustment 3-13
Clock Generator Adjustment 5-8

L

Last Address (Address Difference
Counter) Test 6-3
Level Accuracy Tests 7-15
Linearity Tests 7-15
Locating Components in the,
8180A Data Generator 3-67
8181 A Extender 4-8
8182A Data Analyzer 5-50
Low Frequency Response Adjustment
5-17, 5-38
Low Level Accuracy Test 6-22

Microprocessor Board 08182-66501 5-6

Module Board 08180-66506 (8180A);
08180-66566 (8180B) 3-33

Multiplexer Board 08181-66501 (8181A)
4-6

Negative Offset Test 7-19
NRZ Function Test 6-16

o)

Offset Adjustment,

Clock Output Amplifier 5-16

Clock Amplifier 5-18

Clock Qualifier 5-23

Data Input Amplifier 5-39°
Operating Modes and Trigger Word Tests

7-1

Option 002,

Timing Channel Delay Test 6-15
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Timing Channel Width Test 6-18
Output Amplifier,

High/Low Level Adjustment 3-33

Overshoot Adjustment (8180A) 3-35

Overshoot Adjustment (8180B) 3-37
Overshoot Adjustment (§180A) 3-55

Overshoot Adjustment (8180B) 3-57
Overshoot and Flatness Adjustment 3-53

P

Parts Lists,
Exchange Boards 2-37
HP 8180B 2-1
HP 8181B 2-15
HP 8182B 2-24
PHI 2 Adjustment 4-6
Post Board Replacement Adjustments
3-66
Power Supply Adjustment 3-1

Q

Qualifier Threshold and Impedance
Tests 7-21

R
Recommended Equipment 1-1
Restart Circuit Adjustment 08180-66502
3-10
Restart Circuit Adjustment 5-6
Retrofit Procedure,
81801A/B (For 8180A/B) 8-1
81801A/B (For 8181A/B) 8-1
81802A/B (For 8180A/B) 8-2
81821A/B (For 8182A/B) 8-3
RUN Hysteresis/Threshold Test 6-26
Run Test 6-1

S

Safe. Working Practices 1-1
Sampling Point,
Accuracy and Skew Tests 7-6
Adjustment 5-44
Pre-ad justment (DL107, DL207,
DL307 & DL407) 5-45
Single Cycle Test 6-2
Skew Test, Clock and Data 6-7
Skew and Sampling Point Accuracy Tests
7-6
Stop Delay Test 7-5
STOP Hysteresis/Threshold Test 6-25
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INDEX

Stop Test 6-1

Strobe Break (Strobe Difference
Counter) Test 6-4

Strobe Reference Delay Adjustment

3-19
Sync Board 08180-66504 (8180A);
08180-66564 (8180B) 3-51, 3-60

T

Test Equipment, recommended 1-1
Test Record 6-1, 7-1
Test procedures, Using 1-3
Timing,
Board 08180-66505 (8180A);
08180-66565 (8180B) 3-39
Channel Delay Test, Option 002
6-15
Channel Width Test, Option 002
6-18
Channels Pre-adjustment 3-39
IC Supply Voltage Adjustment 5-16
Transition Time / Overshoot Test 6-28
Transition Time Adjustment 3-37, 3-57
Trigger,
Arm Amp. Offset Adjustment 5-10
Arm Threshold Accuracy Tests 7-24
Delay Test 7-5
Event Start Compare Test 7-3
Qualifier Adjustment 5-13
Qualifier Offset Adjustment 5-14
Qualifier Threshold Accuracy Tests
7-23
Start Analysis Test 7-2
Stop Analysis Test 7-3
Word and Operating Modes Tests 7-1

)
Using the Test Procedures 1-3

\'}

Voltage Adjustment, Timing IC Supply
5-16

w

Width Test, Clock 1, Clock 2 6-12
Width and Delay Adjustment,
Timing Board 3-42
Sync Board 3-60
Working practices, safe 1-1
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y4

Zero Delay of Clock I and Clock 2
Adjustment -4
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